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Introduction
Welcome
Welcome   to Bose® Modeler® software version 6.8. Modeler is a powerful software   tool for designing sound 
systems and predicting their performance. 
Modeler   6.8 software is available in a Standard and Plus version and includes the following updated func-
tions: 
Standard - The standard version of Modeler offers all major   features and functions for creating room mod-
els, creating a sound system   design and simulating the system’s performance. Mapping of key system   met-
rics such as coverage, loudness and speech intelligibility are available. 
Plus - Modeler Plus incorporates proprietary prediction and signal processing   algorithms that allow aur-
alization of multiple room models and listener   positions. Playback is accomplished using the Bose Audi-
tioner® playback   system.
For simplicity, the features and functions of both the   Standard and Plus applications are covered in this help 
system. Note   that the auralization features, Playlist Tab, Playback Tab and enable   listeners tools are not 
available within the Standard version of the Modeler   software.
Click  here to  get started with the Modeler software help system.

New In This Release
Modeler software version 6.8 includes the following new features and functional improvements.
 l RoomMatch array properties improvements
 l Improvements to RoomMatch Array Auto Layout function
 l Auto Layout of horizontally asymmetric RoomMatch arrays
 l The RoomMatch rigging calculator
 l Modeler Data Exchange file format

RoomMatch Array Properties Improvements
RoomMatch array properties improvements include addition of all flown bass configurations, user selectable 
crossover point, and addition of rigging components in CAD views.
The new RoomMatch array properties control panel includes Aiming, Rigging Data, Configuration, Auto Lay-
out, Crossover and RoomMatch Array. See RoomMatch Array Properties for a description of each control.

 

RoomMatch Array Auto Layout Improvements
The auto layout function for RoomMatch systems is significantly improved, as compared to the 6.7 release of 
Modeler software.  Auto Layout improvements have been made in the following areas:
 l Target coverage area within the Projection View can be dragged/adjusted from within the Projection View 
directly.

 l Auto Layout has been extended to include asymmetric RoomMatch modules.
 l Auto Layout algorithm horizontal coverage definition has changed to use the -6 dB point of the module’s 
horizontal coverage pattern resulting in improved module selection.

See Adjusting the Target Coverage Area.
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Auto Layout of Horizontally Asymmetric RoomMatch Arrays
Auto Layout of horizontally asymmetric RoomMatch arrays is supported using the RoomMatch auto layout 
function. 
When designing a RoomMatch array it is now possible to easily switch between a symmetric and asymmetric 
design, by selecting the Type item within the Auto Layout area of the RoomMatch array properties.  When 
working with an asymmetric array, the target coverage area is divided into two parts separated by the mech-
anical center line of the modules. See the Auto Layout description in RoomMatch Array Properties.

RoomMatch Rigging Data
The RoomMatch rigging data report displays the recommended rigging information for a selected 
RoomMatch array including cluster weight, grid frame type, and grid frame pick up points. See RoomMatch 
Rigging Data.htm.

 

Additions to the Bose® Loudspeaker Database

RoomMatch Loudspeaker Data
The Bose loudspeaker database has been re-organized to accommodate new RoomMatch modules, new 
RoomMatch subwoofer configurations, and to facilitate designs created both with the RoomMatch array prop-
erties and with manual placement of loudspeakers within a room model.
The RoomMatch section of the Bose loudspeaker database is now organized as follows:

Directory Path Contents

Bose\RoomMatch  RoomMatch loudspeaker data

Bose\RoomMatch\50 Hz HP Data files used by the RoomMatch array properties when 50 Hz is 
selected as the crossover point for the array.

Bose\RoomMatch\80 Hz HP Data files used by the RoomMatch array properties when 80 Hz is 
selected as the crossover point for the array.

Bose\RoomMatch\Bass Contains all RoomMatch bass data for RMS 215 and RMS 218. Data 
files are named based on the low pass crossover applied to the 
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Directory Path Contents

data.
 
Two new loudspeakers have been added to the Bose loudspeaker database for this release – the RoomMatch 
RMS218 subwoofer, and the RMU208 loudspeaker.
RMS218 data is included in the RoomMatch directories so that it can be used in RoomMatch arrays designed 
with the array properties, and in a separate directory for designs where the subwoofer is not part of the 
RoomMatch array.

Modeler Data Exchange File Format
Accessed from the Export Menu item within the File Menu, the Modeler Data Exchange exports the full con-
tents of the room model and system in an XML file format. The Modeler Data Exchange will be used with 
future versions of ControlSpace® Designer software, and will appear as a data import function. It will be 
available  within ControlSpace Designer software version 4.1.

Training, Application, and Support
Additional information on the Modeler software, and   other Bose Professional products can be found at 
pro.Bose.com.
A number of tutorials are included with the Modeler   software help system.
 l Modeling    Workshop
 l Working    With Projects
 l D2R∆STIc    Design Process
 l Using    Extrusion Tools

 
The most recent application notes are always available   at pro.Bose.com.
The Modeler software User’s Forum is a private forum   for Modeler users to share with other users, request 
new product features   and functions, report any problems or issues with the software, and interact   with the 
product development team. 
To join the Modeler User’s   forum go to proforum.Bose.com.
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Getting Started

System requirements 
It is highly recommended that you use a scroll-wheel   mouse with either Modeler Standard or Modeler Plus 
software.

Modeler Standard Minimum System Requirements
 l Microsoft Windows XP Professional, Service Pack    2 (or later)
 l Microsoft Windows 7, (Professional or Ultimate)
 l 1GHz 32-bit (x86) or 64-bit (x64 processor)    or better
 l 512MB of RAM available (1GB recommended)
 l 512MB of disk space available (1GB recommended)
 l 1024 x 768 32-bit XGA color video display adapter,    open GL (or better)
 l A USB copy protection hardware key (supplied    with the software)
 l 1 open USB port for Modeler hardware key
 l A scroll-wheel mouse (highly recommended)

Modeler Plus
 l Requires an additional USB port    for the Auditioner® Playback System

 
Note: You must have administrative rights on your computer      to install Bose Modeler software. 

Administrative rights are      not required to run Modeler software after installation.

 

Software registration
Before you install Modeler software, you must register   with Bose Professional Systems. Navigate your web 
browser to http://pro.Bose.com/modeler.   Click on Software Registration and fill out the necessary inform-
ation.
 
 

Installing Modeler Software
1. Launch the Modeler software setup wizard that was downloaded during the registration process.

The welcome window is displayed:
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Installer Welcome   window
2. Click Next    to begin the installation process.

The window displays the software License Agreement:

Software License   Agreement
3. Please read the License Agreement    and then click I Agree to accept the terms of the agreement.

The user information window is displayed:
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User information   entry
 

4. Enter user information and    click Next when you are finished.
The window displays the Destination Folder for the software to be installed:

Software installation   folder
 
5. Choose where you would like    to install the software. Click Next.

The software component selections are displayed:
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Available application components
6. Select the application components    you wish to install. Click Next.

The installation utility is ready to install the software:

Confirming installation
 
 

7. Click Next to start the application installation>
The installation progress bar is displayed while the Modeler software and its    application components are 
installed in the selected location:
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Installation Progress
8. When you see the message, "Operation successfully completed," click OK.

Installation complete message
 
9. Click Finish    to close the installation wizard.
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Software License Hardware Key
The Modeler software, both standard and plus versions,   require the use of a USB software protection key. 
Before launching the   application you must insert the supplied USB hardware key into an active   USB port on 
your computer. Attempting to run the software without the   hardware key inserted causes the following error 
dialog to be presented:

Missing hardware   key error
If you see this error message you must insert a valid   hardware key and click Retry, or quit the   application.
Two hardware keys are shipped with Modeler software.      If you wish to order more keys, please contact your 
local      Bose sales representative

Modeler Plus Hardware Key
The Modeler Plus hardware key enables specific features   and functions within the software to enable the play-
back of audio on the   Auditioner playback system.  In addition, the Modeler Plus software   keys are configured 
to expire on a specific date. 
If you have a project open and do not see the Playlist      and Playback tabs, you may not be using a Modeler 
Plus software      enabled hardware key. Please contact your Bose representative      for assistance.
Two hardware keys are provided for each licensed user      of Modeler Plus Software. These keys have an expir-
ation date,      which is printed on the sticker attached to the hardware key.      If you wish to order more keys, or if 
your key has expired      (the software will provide warnings starting from 30 days      prior to key expiration), 
please contact your local Bose sales      representative.
 

Auditioner®   Playback System Connection
The Auditioner Playback System III lets you use your   ears to judge the sound quality of your design, and is 
used in conjunction   with the Modeler Plus software.  The Modeler Plus software predicts   and generates a spe-
cial binaural impulse response for the selected room   model and listener position which is convolved with a 
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dry audio signal.  The   resulting audio signal, when played back on the Auditioner Playback System,   is an 
accurate representation of the sound system’s performance in the   room.
To enable the filter playback functions within the Modeler   Plus software, the Auditioner Playback System 
must be connected to your   PC through an active USB port, and the unit must be ON.
 

Auditioner Playback   System III Connection to PC
 
Note: For more   information on using the Auditioner Playback System III, see the Auditioner   

Playback System III user's Guide.

 
When the Auditioner®   Playback System III is connected to your computer it is recognized as   a USB audio 
device, and system sounds, such as the Windows startup sound,   will be played back through the system.  To 
prevent your computer   system sounds from being played through the Auditioner Playback System   III, follow 
these steps:
 
1. Go to Start>Control Panel and click Hardware and Sound.
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2. Click Sound.

 
3. Click the Sounds tab.
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4. In the Sound Scheme drop-down menu, select No Sounds.

 
5. Click OK    to save this setting and close the window.
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Modeler Software Interface
Interface Overview
The Modeler software interface comprises four main sections: 
 l Project View [1]
 l Model View [2]
 l Detail View [3]
 l Data View [4]

 

Modeler Software   Primary Interface Components

All of the views, with the exception of the Model View,   are enabled using the View controls section of the 
View Toolbar.  The   Project, Detail and Data Views may be undocked from the main application   window, and 
placed anywhere on the screen.
 
[1] - Project View   tabs provide directory tree views of the Project File and the   active room model. From 
within the room model directory views you may   select individual model elements and quickly navigate sur-
faces, listeners   and loudspeakers. From within the project directory view you may add and   remove models 
from a project, as well as open and close models.
[2] - Model View serves   as the primary workspace for the creation of the room model and sound   system 
design. From within the Room View you can construct the room model,   implement the sound system design, 
view target coverage areas, view and   edit cluster and arrays, and view coverage maps describing sound sys-
tem   performance, and access help functions.
[3] - Detail View tabs   are used to modify the calculation settings, properties of various model   com-
ponents, system equalization and provide access to general acoustic   properties used in various 
calculations.  Within the Data view   there are three types of tabs available:
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 l Calculation Parameters – control over items    used in various calculations and acoustic parameters such as 
background    noise levels.

 l Object Properties – displays the properties    of model objects as either list views of all model objects of a 
specific    type, or the complete properties for an individual object selected    within the model.

 l Design Aids – design aids assist with the    process of creating arrays and matching reverberation 
times.  The    Detail View area is used to access these functions

[4] - Data View tabs   provide information on the predicted performance of your sound system   design. Data 
from the predictions within the Modeler software are displayed   in a graphical format that can be used to ana-
lyze system performance in   more detail than is provided in the standard map views.
Within the Data view, Modeler software displays the   following data types:
 l Location-dependent data - displayed in the Time    Response, Frequency Response, and MTF tabs.  Location 
dependent    data is unique to a single location in the room. This location is    defined by the placement of the 
Sample tool in the coverage map. The    data that is shown in these tabs is specific to the location of the    
Sample tool and will change as the tool is moved around the coverage    map.

 l Room response data - displayed in the Statistics    and SPL tabs.  Room response data pertains to the sum of
    the energy in the entire coverage map, and is not location dependent.    The data in these tabs will be dif-
ferent for each coverage map.

 l Room acoustics data -displayed in the RT60 tab.  Room    acoustics data is determined by a room’s geo-
metry and acoustic properties    as a whole. This includes variables like the reflective or absorptive    prop-
erties of the materials used in the room construction, the temperature    and humidity of the air in the room, 
and the number of people in the    audience.

Project View
The tabs within the Project View provide a convenient   way to view and navigate the files within the Modeler 
project file or   the active room model.  Each tab includes an extensive right-click   context menu with addi-
tional functionality specific to the tab being displayed.

Project View
 

Project Tab
The Project Tab displays all the room models within   the project and their current state.
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Project View – Project Tab
 
You can use the appearance model icon in the Project   window to determine the state of the model:

Model closed

Model open, D2R∆STIc     
Engine off

Model open, D2R∆STIc     
Engine on

 
To open a model, double-click on the model icon in the   Project window. The model opens in the Modeling win-
dow.

Model Tab
The Model Tab displays all the components within   the currently active room model, and their current state.
 

Project View – Model Tab
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You can use the appearance icons in the Model   Tab to determine the state of the various room model com-
ponents:
 

 
Camera (visible /     not visible) in the 
room model

 
Center of Rotation     (visible / not visible) 
in the room model

  RT60 Source (visible     / not visible) in the 
room model

 
Surface  (visible     / not visible) in the 
room model

 
Cluster (visible     / not visible) in the room 
model

 
Array (visible /     not visible) in the room 
model

 
Loudspeaker (visible     / not visible) in the 
room model

 
Listener (visible     / not visible) in the 
room model

 

Model View
The tabs in the Model View serve as the primary workspace   for the creation of the room model and sound 
system design.  From   within the Model View you can construct the room model, implement the   sound system 
design, view target coverage areas, view and edit cluster   and arrays, view coverage maps describing sound 
system performance, and   access help functions.
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Model View - Model Tab
 
Within the Model View the following Tabs are provided:
 l Web    – includes links to the built-in help system, keyboard shortcuts and    on-line help.
 l Model    – use this tab for constructing and editing the room model and system    design.
 l Coverage Map    tabs – display the results of selected mapping functions, and    these tabs are active only 
when the coverage maps are calculated.  Map    tabs include the Direct Field Coverage, Direct+Reverberant 
Field Coverage,    and the Speech Intelligibility maps.

In addition to the tab views at the bottom of the Model   View it is possible to create a split view within the 
Room View area.  The   Split View function allows you to view the target coverage area for a   loudspeaker 
cluster or array while simultaneously viewing the room model   or coverage map.

Web Tab
The Web Tab includes links to the keyboard shortcuts,   the Modeler User’s Forum, and information related to 
Bose Modeler software   and Bose Professional Systems at pro.Bose.com. You must be connected to   the inter-
net for these links to be active.
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Web tab selected
 

Model Tab
The Model tab is used to create and view a model.  Modeling   tools are only active when the Model tab is act-
ive.

Model Tab
 

Direct Field Coverage   Tab
When Direct Field Coverage is enabled the Direct Field   Coverage Tab is active.
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Direct Field Coverage Tab
 

Direct+Reverberant   Field Coverage Tab
When Direct+Reverberant Field Coverage calculation is   enabled the Direct+Reverberant Field Coverage Tab 
is active.

Direct+Reverberant Field   Coverage Tab
 

Speech Intelligibility   Coverage Tab
When The STI calculation is enabled the Speech Map is   active.
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Speech Intelligibility Coverage   Tab
 

Split View
When active, the Split View   pane is capable of presenting a number of graphic or table displays adjacent   to 
the room model view. The default display within the Split View is a   projection view of the room model from 
the selected loudspeaker cluster’s   perspective. 
Additional views are available   for a cluster view for the selected cluster, as well as the option to   display the 
complete Properties, Listeners, Loudspeakers, Doors/Windows,   or Surfaces list views.
 

Split View Active – Cluster   Display Shown
 
From within the Split View   the following controls and views are available:
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Rulers   along the top and side display Yaw and Pitch angles, with the center of   the display representing the 
hit point of the selected loudspeaker.
The Show/Hide   Control will cause the Split View to either expand or collapse, based   on its current state.
View   Control selects the item to display within the Split View.  Available   selections are:

Cluster   displays wireframe of the selected cluster.  Cluster selection   is controlled using the Cluster 
Selection drop down item.
Projection (default) displays the model in a projection view from the perspective of the selected   
cluster, or loudspeaker. Cluster selection is controlled from the Cluster   Selection drop down item.
Properties    displays the list of item properties for the item currently selected   within the Model Tab.
Listeners   displays the contents of the Listeners Tab.
Loudspeakers   displays the contents of the Loudspeakers Tab.
Doors/Windows   displays the contents of the Doors/Windows Tab.
Surfaces   displays the contents of the Surfaces Tab.

Cluster   Selection selects the cluster to be displayed within the Split View   Pane.
Synchronize   Views orients the cluster view and the model view to the same rotational   angle.
 

Detail View

Simulation Tab

Default View
The default view for the updated Simulation tab is displayed   when the Model tab is active in the Model View, 
and only displays those   items which are common to all map views:

Default   Simulation Tab
Display   – contains selections that control the way the coverage map is displayed.   Many of the items in 
this section are disabled when the Model is active.
Frequency – selects the frequency   that will be used for the display of Isobar data, when the Isobar dis-
play   is active.
Surfaces   – contains selections the surface types that will be mapped and the   map height parameter for 
Floor and Seating surface types.

Direct Field Coverage Map
When a Direct Field or Direct+Reverberant Field Coverage   Map is active the Simulation tab displays selec-
tions which control the   mapping parameters, and define the methods used to display the calculation.

Direct   and Direct+Reverberant Simulation Tab
Display   – contains selections that control the way the coverage map is displayed.   These items are disabled 
when the Model is active.
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Frequency – selects the frequency   that will be displayed within the coverage map.  Options include   1/3 
octave-band center frequencies, 1-4 kHz average and 31 Hz – 16 kHz   Average.
Bandwidth – sets the bandwidth for   the frequency display of the coverage map.  Options include   1/3 
Octave and Octave.
Scale –   sets the mapping scale to either absolute or relative dB values. Absolute   displays the map 
legend in actual dB SPL values while Relative   displays the SPL values relative to the highest reading.
Offset – shifts the maximum value   of the mapping scale by +/- 20 dB.  In the case of an SPL “hot spot”   
in front of a loudspeaker that is preventing the display of lower SPLs   in other areas of the map, use the 
offset feature to more clearly display   coverage in the areas of lower SPL.
Data –   is disabled in this view.

Surfaces   – contains selections the surface types that will be mapped and the   map height parameter for 
Floor and Seating surface types.  Normally,   coverage is viewed on surfaces that are occupied by listeners 
(seating   and floor surfaces).
Mapping   – contains the various parameters which define how the coverage map   will be generated.

Map Areas– select this item to map   the coverage using either the Standard Mapping (surfaces), or Cus-
tom Areas.
Listeners– select this item to include   the listeners on active surfaces in the calculation.
Resolution   – defines the sample grid size for the coverage map.  This item   is disabled if only Listeners 
are selected.  Lower values   provide finer resolution but longer computation times. Higher values provide
   coarser resolution with faster computation times. Increasing resolution   by one step roughly doubles the 
number of samples and the calculation   time.
Algorithm– defines the algorithm that   will be used in the calculation of the coverage map; options 
include Power   Sum or Cross-Power Sum.  Power Sum calculates sound pressure   without regard to 
phase interactions between sound sources. Cross-Power   Sum takes into account the interference 
effects between sound sources.

Note: To display a Map created using     the Draw Custom Areas tool, check the surface types you 
are mapping (Floor, Seating, etc.), the     Maps checkbox, and the custom Areas radio but-
ton.

Note: The Draw Custom Areas tool works on all     mapping functions in Direct, Direct plus Rever-
berant, and Speech.

 

Speech Intelligibility Coverage Map
When a Speech Intelligibility Coverage Map is active   the Simulation tab displays selections which control the 
mapping parameters,   and define the methods used to display the Speech Transmission Index calculation.

Speech   Intelligibility Simulation Tab
Display   – contains selections that control the way the coverage map is displayed.   These items are disabled 
when the Model is active.
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Frequency – selects the frequency   that will be displayed within the coverage map.  Options include   1/3 
octave-band center frequencies, 1-4 kHz average and 31 Hz – 16 kHz   Average. This has no effect on the 
speech display.
Bandwidth – sets the bandwidth for   the frequency display of the coverage map.  Options include   1/3 
Octave and Octave. This has no effect on the speech display.
Scale –   Disabled in this view. The map scale is automatically scaled between the   minimum and max-
imum STI values for the mapped area.
Offset – Disabled in this view.
Data –   selects the data that will be displayed within the Map.  Available   selections are STI, %ALcons, 
and %PB.

Surfaces   – contains selections of the surface types that will be mapped, and   the map height parameter for 
Floor and Seating surface types.  Normally,   coverage is viewed on surfaces that are occupied by listeners 
(seating   and floor surfaces). Mapping height for other surface types is zero meters.
Mapping   – contains the various parameters which define how the coverage map   will be generated.

Map Areas– select this item to map   the coverage using either the Standard Mapping (surfaces), or Cus-
tom Areas.
Listeners– select this item to include   the listeners on active surfaces in the calculation.
Resolution   – defines the sample grid size for the coverage map.  This item   is disabled if only Listeners 
are selected.  Lower values   provide finer resolution but longer computation times. Higher values provide
   coarser resolution with faster computation times.
Algorithm– defines the algorithm that   will be used in the calculation of the coverage map; options 
include 1988,   1998, 2003 and 2011 versions of the STI standard, (IEC 60268-16), and   STI-PA according 
to the 2003 standard.
Source – active when the STI (1998),   STI (2003), or STI (2011) algorithms are selected.  Select 
between   Male or Female speech spectrum.

Cluster Mapping
When mapping the anechoic performance of a loudspeaker,   loudspeaker cluster or array.  When the cluster 
mapping function   is active the Simulation tab displays selections which control the mapping   parameters, and 
define the methods used for the display of the cluster   map.

Cluster   Mapping Simulation Tab
Display   – contains selections that control the way the coverage map is displayed.

Frequency – selects the frequency   that will be displayed within the coverage map.  Options include   1/3 
octave-band center frequencies, 1-4 kHz average and 31 Hz – 16 kHz   Average.
Bandwidth – sets the bandwidth for   the frequency display of the coverage map.  Options include   1/3 
Octave and Octave.
Scale –   Disabled in this view. The map scale is automatically scaled between the   minimum and max-
imum STI values for the mapped area.
Offset – Disabled in this view.
Data –   disabled within Cluster Mapping.

Surfaces   – disabled when Cluster Mapping is active.
Mapping   – contains the various parameters which define how the coverage map   will be generated.

Type–   defines the type of mapping surface that will be used.  Selections   include Hemisphere, Full 
Sphere and Plane.
Radius–   defines the distance between the cluster origin and the mapping surface.
Angle   Resolution – defines the angular resolution used for the coverage   map.  Available selections are 
2, 5, 10 and 20 degrees.
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Pitch–   defines the pitch of the surface being mapped, relative to the loudspeaker.  This   function may be 
used to pitch a planar mapping surface to approximate   the rake of a seating surface to better visualize 
the coverage provided   by the loudspeaker cluster or array.
Yaw –   defines the yaw of the surface being mapped, relative to the loudspeaker.

Surfaces Tab
The Surfaces tab is used to view and modify properties   of the surfaces within the model.  Each surface within 
the model   is represented on a single row in the Surfaces Tab, and includes information   about the surface, as 
well as its acoustic properties.

Surfaces   tab
From within the Surfaces Tab the following properties   and selections are available. 

Description   is a text field where you can add descriptive information about the surface.   For example 
“Rear wall”.
Material   specifies the type of material used to construct the surface.  The   absorption data for this mater-
ial is then used in various predictions   within the Modeler software.  The list of materials is compiled   in 
the Material Database.
Type   specifies the type of surface based on function: Floor, Wall, Seating,   Ceiling, and Misc.
Audience   allows you to indicate whether the surface is occupied by an audience   or is unoccupied. Occu-
pancy level of the model is designated in the Acoustics   tab. Only Floor, Seating, and Misc. type surfaces 
can be occupied by an   audience.
Reflection   determines how sound will reflect from this surface. Select Scattering   to indicate a surface 
that reflects sound in all directions. Select Specular   to indicate a surface that reflects like a mirror.
Area   is the total surface area of the surface in square meters or feet, depending   on the Model settings.
Color   opens (double-click) the Windows Color Picker so that you can assign a   color to this material type. 
All surfaces of the material type will display   in the selected color in Camera View.

Doors/Windows Tab
The Doors/Windows tab is used to view and modify properties   of the doors, windows and acoustic panel 
objects within the model.  Each   door/window/panel within the model is represented on a single row in the   
Doors/Windows Tab, and includes information about the surface, as well   as its acoustic properties.

Doors/Windows   tab
From within the Doors/Windows Tab the following properties   and selections are available. 

Type   defines the type of object.  This field may not be modified.
Shape   describes the shape of the window or acoustic panel.  Available   selections are Rectangular, 
Round, Arch and Roman Arch.
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X defines the distance   in the X Axis between the bottom center of the new object and the origin   of the 
room model.
Y defines the distance   in the Y Axis between the bottom center of the new object and the origin   of the 
room model.
Z defines the height   of the bottom end of the new object relative to the parent surface.
Width   defines the overall width of the object.
Height   defines the overall height of the object.
Depth   defines the depth of the object. Depth is only a visual parameter and   it does not affect acoustics.
Material   describes what material type will be applied to the object.
Reflection   describes the reflection properties of the object.
Fill   describes the transparency level that will be used for the window in rendered   views.
Field   Color describes the inside fill color of the window.
Frame   Color describes the outside frame color of the window.

Loudspeakers Tab
The Loudspeakers tab is used to view and modify properties   of the loudspeakers in your system 
design.  Each loudspeaker   or loudspeaker array is represented within the loudspeaker tab, and contains   a 
number of properties which define its position within the room model,   sorting and ordering functions, its 
status, and basic signal parameters.

Loudspeakers   tab
From within the Loudspeaker Tab the following properties    and selections are available. 

Cluster   is a number automatically assigned by Modeler software.  Individual   loudspeakers are aggreg-
ated into clusters based on their proximity to   other loudspeakers.  Cluster numbers are sequentially 
assigned   as loudspeakers are added to the model.
Zone   is a number assigned to multiple clusters of loudspeakers to create a   group.
Tier   is a number assigned to a group of loudspeakers that are in the same row.
Index   is an identification number assigned to each individual loudspeaker in   the model.
Desc.   is a text field in which you can add descriptive information on each loudspeaker   in the model. For 
example, "Center cluster fill."
Speaker   displays the current loudspeaker type placed within the model.  This   is also a drop-down menu 
that allows you to change the type of loudspeaker   in this location. If you change the loudspeaker, all 
other data for the   loudspeaker will remain the same, including loudspeaker identifier numbers   and pos-
ition data.
Status   is a drop-down menu that allows you to turn the loudspeaker on and off.   When the status is “off”, 
the information for the loudspeaker is displayed   in italics in the Loudspeakers   tab.
Solo   is a check box that, when selected with an X, mutes all other loudspeakers   in the model. This is 
used to isolate the coverage pattern of a particular   loudspeaker.
X   is the distance from the model origin along the X Axis to the position   of the loudspeaker.
Y   is the distance from the model origin along the Y Axis to the position   of the loudspeaker.
Z   is the distance from the model origin along the Z Axis to the position   of the loudspeaker.
Roll   specifies the rotation of the loudspeaker around the X axis in degrees.
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Pitch   specifies the rotation of the loudspeaker around the Y axis in degrees.

Yaw   specifies the rotation of the loudspeaker around the Z axis in degrees.

Gain is the amount   of gain, in decibels, (dB), applied to the loudspeaker.  A setting   of 0 dB gain is equi-
valent to 1 Watt of electrical input power.
Tap   is only available for high impedance loudspeakers which use a transformer   to determine the amount 
of power applied to the loudspeaker.  The   available tap settings match the capabilities of the chosen loud-
speaker   in Watts.
Pwr   In is the power applied to the loudspeaker,   limited to the actual power handling of the loudspeaker. This 
item   is a calculated field and is based upon the array gain and any impact   of the equalization of the 
speaker.
Polarity   sets the polarity of the loudspeaker to positive (+) or negative (-).
Delay   sets the signal delay of the loudspeaker or array in milliseconds.
Color   sets the color of the loudspeaker enclosure, as seen using Camera View.

 
Within the Loudspeaker Tab different types of loudspeakers   and arrays each have a unique display method.
 

Full Range Loudspeakers
Full range devices are represented   using a single row within the Loudspeaker Tab.
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Full   Range Device within the Loudspeakers Tab (Not all Columns Shown)

Multi-Way Loudspeakers
Multi-way, or biamplified,   loudspeakers are represented using multiple rows in the Loudspeakers 
Tab.  Multi-way   loudspeakers are shown, by default, using a single row.  This   row may be expanded to dis-
play individual acoustic elements within the   loudspeaker.  Each acoustic element represents a set of acoustic
   data used in the Modeler software predictions.
Multi-way loudspeakers include   element and device settings for the Gain and Delay properties.  This   allows 
you to define a gain offset between individual acoustic elements,   and still maintain an overall loudspeaker 
Gain.

Multi-way   Devices within the Loudspeakers Tab (Not all columns shown)
 

Arrays
An array is a special group   of several full range or multi-way loudspeakers.  Within the   Modeler software, 
arrays are created using one of the special Array tools   located in the Loudspeakers Toolbar.
Within the Loudspeakers Tab   arrays are indicated using a color fill in the first row of the 
array.  Loudspeakers   within the array are then listed below, and are represented according   to the loud-
speaker type, full range or multi-way.
Similar to multi-way loudspeakers   Arrays have a master Delay item for use in alignment between main and   
delay clusters in large systems.

Arrays   within the Loudspeakers Tab (Not all Columns Shown)
 

Listeners Tab
The Listeners tab contains a listing of all listener   positions placed within the model.  From within the Listen-
ers   tab you can view and modify the characteristics of the listeners within   the model.
Tip:      The Listeners tab can also be used to drive data     views within the Data tabs.  For example to step 
through     the Frequency Response display for a number of listener positions,     use the arrow up/down keys to 
select listener positions, and the     Data View will automatically update. 
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Listeners tab
From within the Loudspeaker Tab the following properties   and selections are available. 

Ident.   is a listener identifier number which is generated automatically when   you place a listener. You 
may assign your own custom identifier within   a 4 character limit.
X   is the distance of the listener location from the model origin along the   X Axis.
Y   is the distance of the listener location from the model origin along the   Y Axis.
Ear   Height is the distance above the model surface of the listener’s ears.   This number should be chosen 
based on whether the listeners are sitting   or standing. The default value is 1.0 m (3.3 ft) above the 
ground. Ear   height must be between 0 and 2.13 m (7 ft).
Yaw   is the direction that the listener is facing. The default position is   0° (positive X direction).
Notes   is a text field that can be used for notes about the listener location.   For example, you may want 
to note specific acoustic prediction characteristics   for a given listener location.
Surface   is the identifier number of the surface that the listener location is   on. Use this number to easily 
locate the surface in the Surfaces tab.
Type   indicates whether the listener location is on a Floor or Seating surface.
 

Properties Tab
View and modify characteristics for various elements   in the model. After selecting an item, click on the Prop-
erties   tab to display information for the selected item. You can view properties   for surfaces, loudspeakers, 
arrays, listeners, the camera, and the   RT60 source.  The   information available within the Properties Tab is 
greater than that which   is available in other tabs such as Loudspeakers or Surfaces.

Surface Properties
Select a surface   within the room model or within the Surfaces tab and then select   the Properties tab.

Surface   Properties within the Properties tab
Description   is a text field where you can add descriptive information on each surface   in the model. For 
example “Rear wall”.
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Material   specifies the type of material used to construct the surface.  The   absorption data for this mater-
ial is then used in various predictions   within the Modeler software.  The list of materials is compiled   in 
the Material Database.
Type   specifies the type of surface based on function: Floor, Wall, Seating,   Ceiling, and Misc.
Audience   allows you to indicate whether the surface is occupied by an audience   or is unoccupied. Occu-
pancy level of the model is designated in the Acoustics   tab. Only Floor, Seating, and Misc. type surfaces 
can be occupied by an   audience.
Reflection   determines how sound will reflect from this surface. Select Scattering   to indicate a surface 
that reflects sound in all directions. Select Specular   to indicate a surface that reflects like a mirror.
Area   is the total surface area of the surface in square meters or feet, depending   on the Preference set-
tings.
Color   opens (double-click) the Windows Color Picker so that you can assign a   color to this material type. 
All surfaces of the material type will display   in the selected color in Camera View.
Index   is the unique identifier number for the selected surface.
Size   is the total length of the surface in the given dimension.
Offset   is the distance from the room model origin to the center of the surface.   The center of the surface 
is defined by the midpoint of the total length   in each dimension. Enter new values to move the surface in 
a given dimension.
Vertex   numbers are the coordinates of each vertex on the surface, relative   to the model origin. Enter 
new values to move a vertex.
 

Loudspeaker Properties
Select a loudspeaker   within the room model or within the Loudspeakers Tab and then select   the Properties 
tab.

Loudspeaker   Properties within the Properties tab
Cluster   is a number automatically assigned by Modeler software.  Individual   loudspeakers are aggreg-
ated into clusters based on their proximity to   other loudspeakers.  Cluster numbers are sequentially 
assigned   as loudspeakers are added to the model.
Zone   is a number assigned to multiple clusters of loudspeakers to create a   group.
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Tier   is a number assigned to a group of loudspeakers that are in the same row.
Index   is an identification number assigned to each individual loudspeaker in   the model.
Desc.   is a text field in which you can add descriptive information on each loudspeaker   in the model. For 
example, "Center cluster fill."
Speaker   displays the current loudspeaker type placed within the model.  This   is also a drop-down menu 
that allows you to change the type of loudspeaker   in this location. If you change the loudspeaker, all 
other data for the   loudspeaker will remain the same, including loudspeaker identifier numbers   and pos-
ition data.
Status   is a drop-down menu that allows you to turn the loudspeaker on and off.   When the status is “off”, 
the information for the loudspeaker is displayed   in italics in the Loudspeakers   tab.
Solo   is a check box that, when selected with an X, mutes all other loudspeakers   in the model. This is 
used to isolate the coverage pattern of a particular   loudspeaker.
X   is the distance from the model origin along the X Axis to the position   of the loudspeaker.
Y   is the distance from the model origin along the Y Axis to the position   of the loudspeaker.
Z   is the distance from the model origin along the Z Axis to the position   of the loudspeaker.
Roll   specifies the rotation of the loudspeaker around the X axis in degrees.

Pitch   specifies the rotation of the loudspeaker around the Y axis in degrees.

Yaw   specifies the rotation of the loudspeaker around the Z axis in degrees.

Gain   is the amount of gain, in decibels, (dB), applied to the loudspeaker.  A   setting of 0 dB gain is equi-
valent to 1 Watt of electrical input power.
Tap   is only available for high impedance loudspeakers which use a transformer   to determine the amount 
of power applied to the loudspeaker.  The   available tap settings match the capabilities of the chosen loud-
speaker   in Watts.
Pwr   In is the power applied to the loudspeaker,   limited to the actual power handling of the loudspeaker. This 
item   is a calculated field and is based upon the gain and any impact of the   equalization of the speaker.
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Polarity   sets the polarity of the loudspeaker to positive (+) or negative (-).
Delay   sets the signal delay of the loudspeaker in milliseconds.
Color   sets the color of the loudspeaker enclosure, as seen using Camera View.
Equalization   Settings adjust the equalization of the loudspeaker at the given frequency.   Values must 
be between -15 and 15.
 

Array Properties (Standard Array)
Select an array   within the room model (making sure that the array, and not the Cluster   is selected) or within 
the Loudspeakers tab and then  select   the Properties tab.

Array   Properties within the Properties tab
Speaker   defines the speaker used in the array.
Roll   specifies the roll of the entire array.
Pitch   specifies the pitch of the entire array.
Yaw   specifies the yaw of the entire array.
Location   defines the physical position of the center of the array in the room model   in X, Y and Z, rel-
ative to the model origin.
#   Elements defines the quantity of loudspeakers within each of the three   dimensions X, Y and Z.
Spacing   defines the spacing between loudspeakers in X, Y and Z dimensions.
Loudspeakers are placed   on a regular grid using array dimension attributes.
Spreading   defines the amount of spreading of the main beam(s) in the X, Y and Z   directions.  Spreading 
is a value from 0 to +/-180°.
Steering   defines the amount of steering of the main beam(s) in the X, Y and Z directions.   Steering val-
ues range from -90° (endfire down) to +90° (endfire up).
 

RoomMatch Array Properties
Select a RoomMatch™ array within the room model (making   sure that the array, and not the Cluster is selec-
ted) or within the Loudspeakers Tab and then select the Properties   tab.
 

RoomMatch™ Array Properties   within the Properties tab
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The RoomMatch Array properties control the placement,   aiming and construction of the RoomMatch 
Array.  Use this design   interface to create unique custom Progressive Directivity Arrays for the   system 
design.  The RoomMatch array properties are organized into four groups:  Aiming, Configuration, Auto Lay-
out and RoomMatch Array.
 
Aiming   describes the placement, orientation and construction used for the entire   array.

Height   defines the height of the array within the room model. The height shown here is the midpoint of 
the topmost module within the array.
Pitch   defines the overall pitch of the array.
Yaw   defines the yaw (left/right aiming) of the array.

Configuration defines the type of array being created within the RoomMatch array tool and includes the fol-
lowing options:

Array Configuration defines the type of array. Available selections include arrays consisting of 
RoomMatch modules only, arrays with modules and integrated subwoofers, and flown subwoofer only 
configurations. 
Note that the only bass configurations that include steering are the end-fire configurations.  If a vertically 
steered array is desired, the Bass array tool should be used for these applications.
Pullback Bracket, when selected, will include a pullback bracket on the bottom module of the array.  A 
pullback bracket is recommended for use when the desired array pitch cannot be achieved with the main 
grid frame mounting points.
Crossover defines the high pass crossover point of the array. Available selections are 50 and 80 Hz.  
Based on the array crossover point the corresponding subwoofer low pass crossover settings are 
applied.

Auto   Layout contains the control necessary for generating a RoomMatch array solution based on user 
defined target coverage area.

Auto Layout Activation enables / disables the auto layout function.
Auto Layout Wing Menu displays the values which define the target coverage area.  While the target 
coverage area can be directly defined within the Projection View, values can be edited here for fine tun-
ing.
Type defines the type of modules to be used for the array – symmetric or asymmetric.
Modules defines the quantity of modules to be used in the array.  Based on the target coverage area 
definition the auto layout function will determine the best module choices based on the number of mod-
ules selected.

RoomMatch Array includes the modules within the array, and provides the ability to modify the modules to 
create a new RoomMatch array manually.

Speaker identifies each RoomMatch module within the array.  Each row in the table represents a module 
position within the array.  An array may have up to eight devices, subwoofer or speaker.  Use the drop 
down selection to choose the module type for that position in the array.
Solo activates the solo function for the selected module.
HF Gain allows adjustment of the high frequency gain for each module within the array.  All modules 
default to 0 dB of gain adjustment, but can accommodate +18.8 / -50 dB of gain adjustment.
Eff. (Efficiency) displays the calculated module efficiency for each RoomMatch module in the array. 
Efficiency is a key metric for determining if modules can be split or combined.  For example, two 20 
degree vertical modules operating at 30% efficiency can be combined to a single 40 degree vertical mod-
ule.
Match displays the quality of the match between two adjacent modules.  Modules that are well matched 
will exhibit seamless vertical coverage.  Modules that are not well matched will exhibit the presence of 
an audible seam between the two devices.

Rigging Data… displays the RoomMatch rigging data for the selected array.

Listener Properties
Select   a Listener within the room model or within the Listeners tab and then   select   the Properties   tab.
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Listener   Properties within the Properties tab
Ident.   is a listener identifier number which is generated automatically when   you place a listener. You 
may assign your own custom identifier within   a 4 character limit.
X   is the distance of the listener location from the model origin along the   X Axis.
Y   is the distance of the listener location from the model origin along the   Y Axis.
Ear   Height is the distance above the model surface of the listener’s ears.   This number should be chosen 
based on whether the listeners are sitting   or standing. The default value is 1.0 m (3.3 ft) above the 
ground. Ear   height must be between 0 and 2.13 m (7 ft).
Yaw   is the direction that the listener is facing. The default position is   0° (positive X direction).
Notes   is a text field that can be used for notes about the listener location.   For example, you may want 
to note specific acoustic prediction characteristics   for a given listener location.
Surface   is the identifier number of the surface that the listener location is   on. Use this number to easily 
locate the surface in the Surfaces tab.
Type   indicates whether the listener location is on a Floor or Seating surface.

Camera Properties
Select the Camera   within the room model or within the Model tab and then select   the Properties tab.

Camera   properties within the Properties tab
X   is the distance of the camera from the model origin along the X Axis.
Y   is the distance of the camera from the model origin along the Y Axis.
Height   is the height of the lens along the Z axis relative to the Surface upon   which the camera is placed.
Yaw   is the horizontal rotation of the camera in degrees. The default yaw is   90°, or the positive Y dir-
ection.
Pitch   is the vertical rotation of the camera in degrees. The default pitch is   0 degrees, or parallel to the 
XY plane. Positive pitch aims the camera   up, negative pitch aims the camera down.
Lens   is the focal length of the lens in mm. Values must be between 6 and 1200 mm.
Listeners   snaps the camera to a listener location to view the model from this specific   location.
Hidden   Line Removal allows you to remove lines that would not normally be   visible to the eye. When 
unchecked, surfaces appear transparent in camera   view.
Render   Colors displays the selected surface colors in camera view. Hidden   Line Removal must be 
checked to render colors.
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Add   Listener adds a listener location to the model at the same height   and location of the camera, facing 
in the direction that the camera is   facing.
Amb.   Light sets the amount of ambient light in the camera view. Higher   percentages add more light 
while lower percentages add less light.
Diff.   Light specifies how diffuse the light is, or how much contrast you   see in the camera view. Higher 
numbers create more contrast, while lower   numbers create less contrast.
Back   Color sets background color. The color selected will be shown for   areas that are not part of the 
model. For example, if you have a missing   wall on a building, that wall will be colored the chosen Back 
Color. This   feature may also be used to color the sky in semi-open models.
Surface   is the identifier number of the surface that the listener location is   on. Use this number to easily 
locate the surface in the Surfaces tab.

Model Center of Rotation Properties
Select the Center of   Rotation within the Model tab of either the Model or the Project view   and then select the 
Properties   tab.

Center   of Rotation within the Properties tab
X   is the distance of the Center of Rotation from the origin along the X   Axis.
Y   is the distance of the Center of Rotation from the origin along the Y   Axis.
Z   is the distance of the Center of Rotation from the origin along the Z   Axis.

Cluster Properties
Select a Loudspeaker   Cluster within the Model tab of either the Model or the Project view   and then select the 
Properties   tab.

Cluster   Properties within the Properties tab
X   is the distance of the cluster from the origin along the X Axis.
Y   is the distance of the cluster from the origin along the Y Axis.
Z   is the distance of the cluster from the origin along the Z Axis.

Group Properties
Select a Group within   the room model or within the Model tab and then select   the Properties tab.
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Group   Properties within the Properties tab
Length   (X) is the total length of the group in the X Axis.  Enter   a new value to extend the group in this 
dimension.
Width   (Y) is the total width of the group in the Y Axis.  Enter   a new value to extend the group in this 
dimension.
Height   (Z) is the total height of the group in the Z Axis.  Enter   a new value to extend the group in this 
dimension.

RT60 Source Properties
Select the RT60 source   within the Model tab of either the Model or the Project view and then   select the Prop-
erties Tab.

RT60   properties within the Properties tab
X   is the distance of the RT60   source from the origin along the X Axis.
Y   is the distance of the RT60   source from the origin along the Y Axis.
Z   is the distance of the RT60   source from the origin along the Z Axis.

Door Properties
Select a door within   the Model tab of either the Model or the Project view and then select   the Properties tab.

Door   Properties within the Properties tab
Description   provides a text field for entering descriptive information about the object.
Type   describes the type of door that was inserted.
X   defines the distance in the X Axis between the bottom center of the new   door and the origin of the 
room model.
Y   defines the distance in the Y Axis between the bottom center of the new   door and the origin of the 
room model.
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Width   describes the total width of the door. The door width will be centered   on the X/Y offset.
Height   defines the overall height of the door.
Depth   defines the depth of the door.
Hinge   defines if the door opens to the left or right.
Opening   defines if the door opens in or out.
Material   describes what material type will be applied to the door.
Reflection   describes the reflection properties of the door.
Fill   describes the transparency level that will be used for the door in rendered   views.
Field   Color describes the inside fill color of the door.
Frame   Color describes the outside frame color of the door.

Window Properties
Select a Window   within the Model tab of either the Model or the Project view and then   select the Properties   
tab.

Window   Properties within the Properties tab
Description   provides a text field where descriptive information about the object may   be entered.
Type   describes the type of window that was inserted.
Shape   describes the overall shape of the window. Available choices are Rectangular,   Round, Roman 
Arch and Gothic Arch.
X   defines the distance in the X Axis between the bottom center of the new   window and the origin of the 
room model.
Y   defines the distance in the Y Axis between the bottom center of the new   window and the origin of the 
room model.
Z   defines the height of the bottom end of the new window relative to the   parent surface.
Width   defines the overall width of the window.
Height   defines the overall height of the window.
Depth   defines the depth of the window.
Material   describes what material type will be applied to the window.
Reflection   describes the reflection properties of the window.
Fill   describes the transparency level that will be used for the window in rendered   views.
Field   Color describes the inside fill color of the window.
Frame   Color describes the outside frame color of the window.

Panel Properties
Select a Panel within   the Model tab of either the Model or the Project view and then select   the Properties 
tab.
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Panel   Properties within the Properties tab
Description   provides a text field where descriptive information about the object may   be entered.
Type   describes the type of panel that was inserted.
Shape   describes the overall shape of the panel. Available choices are Rectangular,   Round, Roman Arch 
and Gothic Arch.
X   defines the distance in the X Axis between the bottom center of the new   panel and the origin of the 
room model.
Y   defines the distance in the Y Axis between the bottom center of the new   panel and the origin of the 
room model.
Z   defines the height of the bottom end of the new panel relative to the   parent surface.
Width   defines the overall width of the panel.
Height   defines the overall height of the panel.
Depth   defines the depth of the panel.  Depth is only a visual parameter   and it does not affect acoustics.
Material   describes that material type that will be applied to the panel.
Reflection   describes the reflection properties of the panel.
Fill   describes the transparency level that will be used for the panel in rendered   views.
Field   Color describes the inside fill color of the panel.
Frame   Color describes the outside frame color of the panel.
 

EQ Tab
The EQ tab displays the equalization settings for a   given loudspeaker or loudspeakers, and allows you to 
adjust the equalization   and gain. As you make adjustments in the EQ tab, you can see the   results of your 
adjustments in the SPL tab (when viewing Direct   or Direct plus Reverberation coverage maps).
The equalization is applied to those loudspeakers selected   within the room model or loudspeaker tab.

EQ   tab with all active loudspeakers selected
 
Tip:      You select specific loudspeaker for equalization using the     right-click context menu of the EQ tab.  Right-
click     in the EQ tab and choose Select Speakers... From within the Select     dialog you can select the speakers 
for which to display and modify     EQ data. 
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Tip:  A quick way     to select all active loudspeakers is to right click in the     EQ tab and choose Select     Active 
Speakers (or press the F4     key).
 
From within the EQ Tab the following functions are available. 

Hdrm   displays the current system headroom for the selected loudspeaker.  0   dB or headroom rep-
resents the maximum power being applied to the loudspeaker.  Each   loudspeaker is represented with a 
square.  To adjust the gain   of a loudspeaker grab the loudspeaker’s headroom icon and move it up or   
down.
1/3   Octave-Band EQ each loudspeaker includes a 1/3 octave-band equalization.  The   equalization for 
the loudspeaker is adjusted by moving the EQ slider up   or down.  At total of +/- 15 dB of equalization 
may be applied   per band.
When multiple loudspeakers   are selected, dragging will change the gain while maintaining the relative   
level differences. Shift + drag will apply the same gain to all selected   loudspeakers.

Note: Boosting the EQ in a specified band adds gain to the loudspeaker, and reduces head-
room. When the loudspeaker has 0 dB of headroom, additional EQ boost may not be 
applied.

The EQ tab also includes a tabular display of the equalization   applied to the loudspeaker.  To access the table 
view of the   equalization right-click on the EQ tab and select EQ Grid.

EQ   Grid
 
From within the EQ Grid in the EQ Tab the following   functions are available: 

Gain   is the amount of gain, in decibels, (dB), applied to the loudspeaker.  A   setting of 0 dB gain is equi-
valent to 1 Watt of electrical input power.
Tap   is only available for high impedance loudspeakers which use a transformer   to determine the amount 
of power applied to the loudspeaker.  The   available tap settings match the capabilities of the chosen loud-
speaker   in Watts.
Pwr   In displays the amount of power, in Watts, applied to the loudspeaker.
EQ   (31 Hz – 16 kHz) displays the amount of EQ applied in each 1/3 octave   band.
 

For more information on using the EQ Tab, in combination   with the System SPL tab to equalize the sound sys-
tem within the Model   see how to adjust   the equalization in the D2R∆STIc design process.
 

Acoustics Tab
The Acoustics tab displays, and provides access to the   various acoustic parameters that affect calculations 
used within the Modeler   software.
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Acoustics   tab
From within the Acoustics Tab the following functions   are available. 

Temperature   is the ambient temperature in the room (affects speed of sound).
Humidity is   the relative humidity in the room (affects air absorption).
Occupancy is   the number of people in the room.  Occupancy may be specified   as either a total number 
of people within the model, or as a percentage   of occupancy.  The Modeler software distributes the 
absorption   for the audience evenly across all “occupied” surfaces.
House Curve   is a target room-response curve.  Select Open… to display the   House Curve database 
viewer.
Background Noise   is the background noise in the room. Select Open… to display the Background   Noise 
database viewer.
RT60 Select   Match… to access the Reverberation Time matching function.  This   function matches the 
room’s predicted reverberation times to a set of   measured reverberation times.

Playlist Tab
The Playlist tab is only   available within the Plus version of Modeler which includes features related   to the 
Auditioner® system technology.   In addition, the   Playlist tab is only active when a Project file is open, and 
is not available   if a room model only is open.
The Playlist tab contains a list of all Listener positions   which will be simulated using the Auditioner tech-
nology, and allows you   to group Listener positions for various models into unique Playlists for   demonstration 
purposes.

Playlist   tab
 
From within the Playlist tab the following functions   are available. 

Sets   contains a list of all unique playback sets, or playlists.  The   default set is All Listener positions.  To 
add a new playlist   set, right-click in the Sets window and select New Set.
Add Listener positions   to a playlist set by dragging them from the list of Listener Positions   to the desired 
playlist set.
Activate   Listener Position Checkboxes are in the first column. Listener positions   will not be loaded 
and played unless they are selected, which is indicated   with an X appearing in the selection box.
There are three ways to   select items: double-click on the listener row to load it into the queue,   place an 
“X” in the box next to the listener to load it into the queue,   or place an “X” in the box in the column 
header to load all listeners   into the queue at once. If an audio track is playing in the Bose Media   Player, 
you are able to listen as soon as a listener is loaded.
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The   item currently playing is indicated in the second column using a loudspeaker   icon: 
Model   displays the room model name where the Listener is located.
Position   indicates the unique Listener Position number in the model.  Listeners   appear in light gray if 
the surfaces they are on have been unchecked in   the Simulation tab. Listeners appear in italics if their 
data has not   been recalculated since a change has been made to the model.
 

Note: To make sure that     the Listener data gets calculated when the engine is turned on,     you 
must select the Listeners box in the Simulation tab, and the     Surface types that contain 
those Listeners.

 
Gain   Offset contains a value used by the level match feature described   in [Chapter 24: Using Level 
Match].
View and Window   columns for each listener allow you to assign a specific View and Window   to be dis-
played in the Modeling window when the listener is selected in   the queue.
Right-click in the View   and Window columns in the Playlist tab to assign a view   and window to each 
position. You can select multiple listeners and right-click   to change the View and Window for multiple 
listeners at   once.

Play button   Clicking this button presents:

 
 
 
 
 

Data View

Time Response Tab
Data in the Time Resp. tab is location dependent,   and therefore can only be seen when the Sample   tool is 
placed in your coverage map. The Sample tool allows you   to specify an exact location from which to gen-
erate acoustic prediction   data.
Time Response data is only displayed for a single frequency   band, and the data displayed is dependent upon 
the coverage map selected   within the Model View.  Data cannot be displayed for the 1-4   kHz and 31 Hz-16 
kHz coverage maps.
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Note: Time arrival is only displayed for a single frequency band. The Time Resp tab will be 
grayed out and a warning will be displayed in the graph, indicating to pick a single fre-
quency band from the Frequency drop-down menu.

Frequency   band warning
 
The Time Resp. tab   displays elapsed time on the horizontal axis and dB SPL on the vertical   axis. Each pin in 
the graph represents an arrival of sound at the exact   location where you placed the Sample tool. Pins are 
color coded   based on the flight path between the loudspeaker and the sample point.

Red pins direct   arrivals from the sound source.
Green pins   are first order reflections. They have reflected off of one surface.
Blue pins   are second order reflections. They are arriving at the sample point after   reflecting off of two 
surfaces.
Yellow lines are the Reverberant Field   Envelope Function (RFEF), which shows the build-up and decay 
of reverberant   energy at the particular listener or sample location.

Time   Resp. tab
Note: In the HEDC™ Time Resp window, the direct arrival from each cluster is represented by 

a single pin. Its level is calculated using x-power sum on all individual arrivals from 
that cluster. Its time is set equal to the time of arrival of the first individual arrival 
time.

 
Click on a pin in the graph to view the flight path   from the source to the listener location, which is viewed in 
the Modeling   window. You can scroll through the pins sequentially using the scroll   bar to the right of the 
Time Resp. graph.
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Time   Resp. tab, first pin highlighted

Frequency Response Tab
The Freq. Resp. tab displays dB SPL on the vertical   axis, and the frequency on the horizontal axis. The fre-
quency response   at a specific location in the coverage map can be displayed by placing   the Sample tool at 
the desired location.
The algorithm used to generate frequency response data   is based upon the coverage map being displayed 
within the Model View.  For   example, when the Direct Field coverage map is active the displayed Frequency   
Resp. is generated using direct field data.  Likewise when the   STI map is active the Frequency Resp. is gen-
erated using the HEDC-STI   data.
Because frequency response is position-dependent, the   data changes as you change the location of the 
Sample tool.  In   addition, the Sample tool snaps to the listener location when you   drag the tool near a 
listener. As you make changes to your sound system,   these listener locations allow you to return to a spe-
cific and consistent   location in the model to evaluate acoustic prediction.

Freq.   Resp. tab
 
Tip:  The data within      the Frequency Resp. tab is continuously updated as you move      the sample tool; move 
the sample tool across the coverage      map and see the response for a variety of locations. 
 
Note: You can change the smoothing      of the frequency response curve by right-clicking in the 

Freq Resp  tab and choosing a different      octave value. Lower values produce finer res-
olution.

 

MTF Tab
The MTF (Modulation Transfer Function ) tab only contains   data when an STI map is displayed.  STI is cal-
culated using   band limited noise in seven octave bands. Each band is modulated at 14   different frequencies 
between 0.63 and 12.5 Hz. Each of these curves   represents one of the seven octave bands, and is called an 
MTF curve.    Each MTF curve is color coded, and corresponds to one of the 7 octave-bands   between 125 Hz 
and 8 kHz.
The MTF is a graphic description of the Speech Transmission   Index calculation and tells us how well the 
speech signal was preserved   when it arrived at the listener after leaving the loudspeaker and traveling   
through the room. If the signal is perfect upon arrival the MTF curve   is a flat line at the top of the graph 

- 43 -



Modeler®  Sound System Software 6.8 User's Guide

representing no signal degradation   (100% integrity); if it were totally degraded it would be a flat line   at the 
bottom of the graph. By looking at the shape of the MTF curve we   can determine the probable cause of 
reduced intelligibility.

MTF   tab
 
Tip: You can copy a graph or the data into Excel by right-clicking in the graph window and selecting either 
Copy Graph or Copy Data.
 

Statistics Tab
The Statistics tab displays coverage map data   using  either a probability or cumulative distribution function 
for   further analysis of coverage map data.  Additional detailed   information is displayed directly below the 
Statistics Tab in the Status   Bar of main application frame. 
The probability distribution function plots map data   (SPL or STI score) along the X axis, and the probability 
of occurrence   along the Y axis.  In this view the mean value and standard   deviation are also displayed.

 
Statistics   Tab – Probability Distribution Function
 
The cumulative distribution function plots map data   along the X axis, and the percentage of all samples for 
each data point   along the Y axis.  This view makes interpretation of STI data   simpler, allowing you to see the 
quantity of samples greater than a given   STI score.

 
Statistics   Tab – Cumulative Distribution Function
 
Within the Status Bar additional statistical information   is available which describes the coverage map 
data.  Included   here are the Mean value, Standard Deviation, Data Range about the mean,   and the total num-
ber of samples included in the coverage map.
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Statistics   Tab – Status Bar Information
 

SPL Tab
The Sound Pressure Level (SPL) tab shows the   room frequency response, with dB SPL on the vertical axis 
and the frequency   in Hz on the horizontal axis.

SPL tab
 
The SPL tab displays the mean SPL, standard deviation,   and average total SPL in the status bar below the 
graph.
 
Note: The      shaded bandwidth region can be dragged across the frequency      spectrum to display 

Sound Pressure Levels at different frequencies      in the Direct or Direct plus Reverberant 
coverage maps.

Selecting      a certain frequency band in the Detail or Data Views will      also drive the mapping display in the 
Model View.
 

RT60 Tab
RT60 (Reverberation Time) is a measure of the amount   of time it takes for the sound pressure level in a 
room to decay by 60 dB.   Modeler software displays predicted reverberation time data for the room   across 
the entire frequency range in the RT60 tab.

- 45 -



Modeler®  Sound System Software 6.8 User's Guide

The   RT60 Tab
 
By default, reverberation time is predicted using a   proprietary ray tracing algorithm which tracks the decay 
of sound energy   generated by an omni-directional source placed within the model. 

The   RT60 source
 
The RT60 Tab can also display the reverberation time   as computed using the Norris-Erying method.  This 
selection   is available using the right-click context menu.
 
Note: If you do not see data      in the RT60 tab, the RT60 source may be located outside of      your 

room model, or it is a Model where more than 95% of the      energy from the RT60 source 
is removed within one reflection.      The source must be located inside the walls of your 
model      to provide data. Reposition the RT60 source so that it is      inside the room model.

 

Playback Tab
The Playback tab is only   available within the Plus version of Modeler which includes features related   to the 
Auditioner system technology.  In addition, the Playback   tab is only active when a Project file is open, and is 
not available if   a room model only is open.
The Playback tab controls the playback of Auditioner   filters, and is partitioned into five sections: Input, Sig-
nal, Noise,   Room, and Output.
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Playback   tab
 

Input

Launch Player   opens the Bose Media Player window.  From within the media player   window you may select 
the dry audio that will be convolved with the Auditioner   filters.
Level Match   - For a description of the level match feature, see Chapter 24: Using   Level Match.
Playback Queue   - Displayed in the lower left of the Playback   tab, it contains three columns. The first two 
are the model name and the   position label for each listener. The third column is typically the maximum   sys-
tem SPL. However, when level match is selected, this column instead   displays the gain offset.
Of the Auditioner® enabled listeners that have   been loaded into the queue, three appear in the list: The cur-
rent listener,   the previous listener, and the next listener. The playback queue is a   continuous loop regardless 
of how many listeners are loaded. When you   reach the end of the queue, the first listener will be the next 
one to   load.
 

Signal Level

Signal Level   – This is the output control to the Auditioner Playback System.  Conceptually,   the signal level 
controls the signal drive level the system in the same   way the master output of the house mixer controls the 
drive level of the   system.   As the slider is adjusted, the SPL of the room   changes accordingly.
System Clip Indicator   – It is possible to increase the signal level to a point above the level   that the 
installed system is capable of reproducing at a given listener   location. When this occurs the system clip indic-
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ator is used to indicate   this state. The system clip indicator, shown below, has three states:   No signal 
present (gray), signal present and not clipping (green), and   signal present and clipping (red).
 
Note: Only the sound system signal is used to set the     state of this System Clip indicator. In 

other words, the background     noise cannot cause system clipping.

 

Background Noise Level

The inclusion of background noise in an Auditioner   simulation can improve the evaluation of speech intel-
ligibility for a   given room, and can provide a more realistic demonstration of the system’s   performance 
when the acoustics of the room assume an audience.  The   Noise level control mixes a pre-selected back-
ground noise source into   the Auditioner simulation.
 
Note: Background noise will only be included in the     simulation when a background noise file 

containing audio data     is selected from within the Acoustics Tab.

 
Background Noise   Level - Adjust the noise level for custom noise only. Standard noise   files are locked 
and cannot be adjusted. The current offset value is shown   in the gain offset field above the slider.
When the noise level is changed, the new value   is used to calculate STI. If the map is visible, it will be 
updated automatically.
Background Noise   Meter - The noise playback level is displayed in dB SPL on the meter   next to the noise 
level slider. The noise level field above the meter   bar is updated every 1.25 seconds, while the meter bar is 
updated every   250 milliseconds.
Noise mute   - The noise can be muted and unmuted using the toggle button shown below.

 

Room Level Meter

Room level Meter   – Displays the total sound pressure level in the room.  This   level represents the com-
bined level of both the signal and the noise in   the room at the current listening location. The room level is dis-
played   in dB SPL on the meter shown below. The room level field above the meter   bar is updated every 1.25 
seconds, while the meter bar is updated every   250 milliseconds.
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Note: When noise is muted, the room level meter will only measure the processed signal. Con-
versely, to meter only noise, pause or stop the program material in the Bose Media 
Player.

 

Output

USB Detection   Indicator - The USB detection indicator is green when the Auditioner®   playback unit is 
detected. When the playback unit is not detected, or   becomes disconnected, the indicator is red and no audio 
can be processed.
 
Note: Remember, if the Auditioner® Playback System      III is unplugged or powered off, the 

Bose Media Player will      not open.

 
System Mute   - Use the System Mute button to mute the playback. When you press   the button again to 
unmute, there is a short ramp-up time before full   volume is restored. The ramp-up time cannot be adjusted.
Tip:       If you have enabled Direct keys, you can use the direct      key shortcut to mute the sound: the M key. You 
can enable      Direct keys in the General tab of the Application Preferences      dialog box. To mute the signal, 
press pause in Media Player.
 
Record Button   and Recording Time - Processed audio can be recorded and saved to   a (.wav) file for 
future playback. While recording, the elapsed time of   the recording is displayed. To stop recording, click on 
the toggle a second   time.
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Menu Reference

Modeler Application Interface

File menu

New     Pro-
ject…

Creates     a new project file (.pjt) and project 
folder and specifies its     location on the hard 
drive. You will be prompted to create a new     
model, add an existing model, or import a 
model into the project.     If a project is cur-
rently open, you will be prompted to close     it 
before creating a new project.

Open     
Project…

Opens an existing project by     locating it on 
the hard drive and choosing the .pjt file. If a     
project is currently open, you will be promp-
ted to close it before     opening a new project.

Close     
Project

Closes the project. You will     be prompted to 
save changes to models that you have mod-
ified,     with the option to save all models that 
have been modified.

Save     Pro-
ject

Saves changes to the project.     You will be 
prompted to save changes to models that 
you have modified,     with the option to save 
all models that have been modified.

Save     Pro-
ject As…

Creates a copy of the project     and saves it 
with a different name. All models within the 
project     will be copied. The new saved pro-
ject will remain open and the     original project 
will be closed.

Rename     
Project…

Changes the name of the project,     but does 
not affect project file contents.

 

New     
Model

Creates     a new model. You will be prompted to 
name the new model.
If a project is not open, a new model will be     
created without being added to a project. This 
model is named     “Untitled” by default and can 
be renamed at any time by choosing     Save 
Model.

Open     
Model…

Adds an existing model to the     project. A copy 
of the model will be added to the project 
folder.

Close     
Model

Closes the model.

Save     
Model

Saves changes to the selected     model.
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Save     
Model 
As…

Creates a copy of the model     and saves it with 
a different name. Use this option to save a     
version of the model you are currently work-
ing on. The new saved     model remains open 
and active, and is added to the project. The     
original model is closed and remains in the 
state that it was     last saved.
If no project is open, you will be prompted     to 
choose a location in which to save the model.

Import     
Model

imports a model that was not     created in Bose 
Modeler software. The model will be added to 
the     currently open project file. Choose to 
import a Macintosh Modeler     software file 
(.mac), a Modeler Transfer File (.mtf), and 
EASE     faces file (.xfc), or an EASE project file 
(.ppj). Note that the     file must have the appro-
priate file extension (.mac, .xfc, .ppj,     .dxf) to 
be imported into Bose Modeler software.
If a project is not open, the model will be     
imported without being added to any project.

Export     
Model

Exports loudspeaker data to     a text (.txt) file 
with tab delimited data for all loudspeakers     in 
the room model. Data includes loudspeaker 
properties and equalization     data for each 
device.
Export a Modeler Transfer File (.mtf) which     
contains all the room model data in a pro-
prietary text format     for use in other modeling 
applications.

 

 

Duplicate     
Model

Duplicates     the selected model in the pro-
ject. To select which model to duplicate,     
click on the model name in the Project     
window. You will be prompted to name 
the duplicate model. Modeler     software 
will copy the model and add it to the “par-
ent” project.     This option exists only when 
the model is associated with a project.

Rename     
Model

Renames the selected model     in the pro-
ject. This option exists only when the 
model is associated     with a project.

Remove     
Model

Removes the selected model     from the 
project. You will be prompted to remove 
the model from     the disk.
Choose Yes to     delete the model from 
your hard drive.
Choose No to     remove the model from the 
project but not from the hard drive.     It is 
saved in the project folder and can be 
added back to the     project or to another 
project at a later time.

Model     Prop-
erties…

Displays information on the     active model 
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file, including its location on your hard 
drive,     the date that it was created and 
updated, the size of the file,     and what 
version of software created it. You can 
also enter information     including the 
name of the sound system designer, the 
name of the     facility, and any relevant 
comments about the model.

Recent     Pro-
jects

Allows you to choose one of     the four 
most recently opened projects from the 
list. If a project     is open, you will be 
prompted to close the project that is 
open     before you open a new project.

Recent     
Models

Allows you to choose one of     the four 
most recently opened models from the 
list. If a project     is open, a copy of the 
model will be added to the project. If     a 
project is not open, the model will be 
opened without being     added to any pro-
ject.

 
Print Setup… Opens     the standard Windows Print Setup 

dialog box where you can choose     a 
printer, set printer properties and select 
paper options.

Print… opens the Modeler software     Print dialog 
box.  From within this dialog you can 
choose     which items (model views, maps, 
etc.) will be printed as part     of the Engin-
eering Report.

Exit Quits Modeler software. You     will be 
prompted to save any changes to open 
models. later time.

 
 

Edit menu

Undo Reverses     your last action or multiple 
actions up to the point at which     the 
model was opened.

Redo Re-applies your last action     (after 
undo) or multiple undo actions up to 
the most recent action.

Undo     List… Opens the list of actions available     for 
Undo and Redo. Double-click on an 
Undo or Redo action to jump     to that 
state.

Cut Deletes the selected item and     copies it 
to the clipboard (standard Windows 
editing function).

Copy Copies the item to the clipboard     (stand-
ard Windows editing function). Not 
used to copy graphics,     graphs or grids

Paste Pastes the contents of the     clipboard 
(standard Windows editing function).

Clear Deletes the selected item.
Duplicate Copies and pastes the selected     item to 
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create a duplicate of it.
Select     All Selects all items in the active     window.
Application     
Preferences…

Opens the Application Preferences     
dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

 

View menu

Toolbar Expands     to display a list of all toolbars available 
within the Modeler     application interface.  Selects a 
toolbar to toggle     between show (checkmark) and 
hide (no checkmark)

Window Displays a list of the three     main view windows within 
the Modeler application interface.  Select     a window 
to toggle between show (checkmark) and hide (no 
checkmark).

Status     Bar Toggles the Status bar between     show (checkmark) 
and hide (no checkmark).

Maps Expands to display a list of     all active coverage maps 
for the current model.  Choose     which map is dis-
played in the Modeling window.

Detail Expands to display a list of     all Detail View 
tabs.  Choose which tab is selected     in the Detail win-
dow.

Data Expands to display a list of     all Data View 
tabs.  Choose which tab is selected in     the Data win-
dow.

Rotations Expands to display a list of     all available model view 
orientations.  Select the angle     from which to view 
the model.

Constraints Expands to display a list of     available drawing 
constraints.  Select which plane your     actions are con-
strained to in the Modeling window.

Grid Toggles the grid between show     (checkmark) and 
hide (no checkmark).

Animate Turns on map animation which     automatically cycles 
the Direct Field, or Direct plus Reverberant     Field cov-
erage data through all of the frequency settings in 
the     Frequency drop-down in the Simulation     tab. Use 
the arrow keys to speed up or slow down the anim-
ation,     and press Esc to close the animation.

 

Database Menu

Loudspeaker 
Database

Opens     the Loudspeaker Database viewer.

Material     
Database

Opens the Materials Database     viewer

 

Arrange Menu
The items in the Arrange menu are used when one or more   surfaces are selected in the model.
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Flip Hori-
zontal

Mirrors     the selected surface(s) along an axis par-
allel     to the Y axis.

Flip     Ver-
tical

Mirrors the selected surface(s)     along an axis par-
allel to the X axis.

Group Joins the selected objects     together in case they 
are co-planar. Grouped surfaces will act     as one 
surface when being moved, rotated, flipped or 
scaled. The     individual sections of a Conical, Spher-
ical, and Cylindrical surface     are grouped by 
default when they are created. Grouped surfaces     
have sizing handles that can be used to resize the 
group in three     dimensions.
Listeners can be grouped together.
Loudspeakers cannot be grouped together.
Groups may be grouped.

Ungroup Separates the selected objects     that are part of a 
group. The objects will act independently after     
being ungrouped.

 

Design Menu

D2R∆STIc Expands to display a list of the D2R∆STIc     
step calculations.  When an item within the 
list is     selected the selected coverage map 
is automatically calculated     using pre-
defined default settings.
Selections include     calculate the Direct Field 
coverage map for the 1 - 4 kHz     frequency 
range, calculate the Direct plus Rever-
berant Field coverage     map for the 31 Hz -
 16 kHz frequency range,     calculate time-
arrivals at 2 kHz, and calculate the Speech 
Transmission     Index (STI) coverage map.
The D2R∆STIc Engine must be enabled     to 
generate these coverage maps.
For more information, see the DRASTIc_
Design_Process.htm.

RT60     
Data…

opens the Room Reverberation     window to 
display the RT60     times of the room model 
for the full frequency range.

EQ Expands to display the options     available for 
applying an equalization curve to the sound 
system. 
Selections include select loudspeakers to 
equalize,     apply a house curve, or zero the 
equalizer

Enable     
D2R∆STIc     
Engine

Enables the D2R∆STIc engine to auto-
matically     calculate acoustic prediction 
data.
When the D2R∆STIc engine is enabled, 
Modeler     software only calculates those 
steps in the acoustic prediction     calculation 
that are necessary, based on what changes 
have been     made to the model.

Manual     
Recalculate

This     item is only available when the 
D2R∆STIc Engine is inactive.  When     selec-
ted all acoustic predictions are recalculated 
based on current     model settings.
Manual recalculation causes Modeler soft-
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ware     to execute all steps in the acoustic 
prediction calculation. Therefore,     there 
may be a slightly longer calculation time 
compared to automatic     recalculation using 
the D2R∆STIc engine.

 

Window menu

Cascade Places     multiple models on top of each other in a cas-
cading manner, so     that all are visible in the Model View.

Tile Fits multiple models side by     side so that all are visible in 
the Model View.

Arrange     
Icons

Arranges the model icons when     all models have been min-
imized in the Model View (a standard Microsoft     Windows 
feature)

Open     
Model List

Displays a list of all open     models.  Selects a model to 
view from the list of open     models. The active window has 
a checkmark next to it.
Up to five models may be open at any one time     within the 
application.

 

Help Menu

Contents… Opens     the Modeler software help system.
System     
Info…

Opens the system information     window to view hard-
ware and software settings and specifications     for your 
computer.

About     
Modeler…

Opens the Modeler software     splash screen, which dis-
plays version number, serial number and     registration 
information.

 

Material Database Viewer

File Menu

New Material Creates     a new material type entry within the 
room model’s material database.
The new material may be named, and the 
absorption     coefficient data may be specified.
Note: This material is saved     with the 

room model file, and not with an 
absorption database.

Save     Material 
List…

Saves the current room model     materials list as 
a new absorption database.  Once saved     it will 
appear in the master Modeler Material Data-
base list.

Exit Closes the Material     Database viewer.
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Edit Menu

Duplicate 
Material

Adds     a duplicate entry for the selected mater-
ial within the room model     material list.

Delete     
Material

Removes the selected     material file from the 
room model’s material list.
Note: The material is not deleted     from 

the master material database.

Delete     
Unused 
Materials

Removes unused     materials from the room 
model’s material list

Find… Opens the Find dialog box to search for a 
material     file by name.

Find     
Next…

Jumps to the next     record that matches the 
Find... criteria

 

Loudspeaker Database Viewer

File Menu

Exit Closes     the loudspeaker database viewer.

 

Edit Menu

Find… Opens     the Find dialog box to search for     a material file by name.

Find     Next… Jumps to the next     record that matches the Find... criteria
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View Menu

Zoom In Available     when the 3D CAD view is active 
within the 3D Viewer section. 
Zooms in on the loudspeaker enclosure.

Zoom     Out Available when the 3D CAD view     is active 
within the 3D Viewer section. 
Zooms out from  the loudspeaker enclosure.

Back     View Available when the 3D CAD view     is active 
within the 3D Viewer section. 
Orients the view to the rear of the loud-
speaker     enclosure.

Front     View Available when the 3D CAD view     is active 
within the 3D Viewer section. 
Orients the view to the front of the loud-
speaker     enclosure.

3D     Balloon Displays the magnitude response     of the loud-
speaker in a balloon format within the 3D 
Viewer section.

3D     CAD Displays the wireframe of the     loudspeaker 
within the 3D Viewer section.

Isobar Maps the sound coverage of     the loudspeaker 
on a hemisphere for the selected frequency 
band     within the 3D Viewer section.

Polar     Plot Displays the horizontal and     vertical polar plot 
for the loudspeaker at the selected frequency
     band within the 2D Viewer section.

Sensitivity Displays a graph of sensitivity     versus fre-
quency (Hz) of the loudspeaker in dB-SPL 
within the     2D Viewer section.

Beamwidth Shows the angle at which the     sound pressure 
level is down by 6 dB relative to on-axis 
within     the 2D Viewer section.

Directivity Displays a graph of the loudspeaker’s     dir-
ectivity index in dB versus frequency (Hz) 
within the 2D Viewer     section.

Directivity  
[0-24] dB

Sets the vertical scale of     the Directivity Dis-
play to 0 to 24 dB.

Directivity 
 [-10-14]dB

Sets the vertical scale of     the Directivity Dis-
play to -10 to 14 dB.

Sensitivity  
[40-100]dB

Sets the vertical scale of     the Sensitivity Dis-
play to 40 to 100 dB.

Sensitivity 
[60-120]dB

Sets the vertical scale of     the Sensitivity Dis-
play to 60 to 120 dB.
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Mode Menu

Solid Available     when the 3D Balloon is displayed within the 3D Viewer sec-
tion.
Sets the display of the 3D Balloon data to a     solid, color gradient dis-
play.

Wire Available when     the 3D Balloon is displayed within the 3D Viewer sec-
tion.
Sets the display of the 3D Balloon data to a     wire mesh.

 

Background Noise Database Viewer

File Menu

New… Creates     a new background noise file.  This file is stored with     the 
master background noise database.
 
Once created, the new background noise file     may be named and 
its frequency dependent levels may be adjusted.

Exit Closes the background noise     database viewer.

 

Edit Menu

Duplicate Creates     a duplicate copy of the selected background noise 
file.
Once duplicated, the new background noise file     may be 
renamed and its frequency dependent levels may be adjus-
ted.

Delete Removes the selected     background noise file from the back-
ground noise database.

Rename… Provides a text     field from which you may rename the selec-
ted background noise     file.

 

House Curve Database Viewer
 

File Menu

New… Creates     a new house curve file.  This file is stored with the     master 
house curve database.
 
Once created, the new house curve file may     be named and its fre-
quency dependent levels may be adjusted.

Exit Closes the house curve     database viewer.
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Edit Menu

Duplicate Creates     a duplicate copy of the selected house curve file.
Once duplicated, the new house curve file may     be renamed 
and its frequency dependent levels may be adjusted.

Delete Removes the selected     house curve file from the back-
ground noise database.

Rename… Provides a text     field from which you may rename the selec-
ted house curve file.

 

Toolbar Reference

Application Interface Toolbars

Standard toolbar

New Model 
(Shft+Ctrl+N)

Create a new model. You     will be prompted to name the 
new model.
If a project is not open, a new model will     be created 
without being added to a project. This model is named     
“Untitled” by default and can be renamed at any time by 
choosing     Save Model.

Open Model 
(Shft+Ctrl+O)

Add an existing model to     the project. A copy of the 
model will be added to the project     folder.
If no project is open, the model will be     opened without 
being added to a project.

Save     Model
(Shft+Ctrl+S)

Save     changes to the selected model.

Save Wing 
menu 

When checked, coverage map data that has     been gen-
erated is saved with the model file.

Cut
(Ctrl+X)

Delete the selected item     and copy to the clipboard (stand-
ard Windows editing function).

Copy
(Ctrl+C)

Copy the item to the clipboard     (standard Windows edit-
ing function). Not used to copy graphics,     graphs or grids.

Paste
(Ctrl+V)

Paste the contents of     the clipboard (standard Windows 
editing function).

Undo
(Ctrl+Z)

Click to undo your last     action, or click multiple times to 
undo multiple actions up to     the point at which the model 
was opened.

Redo
(Ctrl+Y)

Click to redo your last     action (after undo) or click mul-
tiple times to redo multiple undo     actions up to the most 
recent action.
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Undo List Open the list of actions     available for Undo and Redo. 
Double-click on an Undo or Redo action     to jump to that 
state.

Print
(Ctrl+P)

Open the Print dialog box.

Help
(F1)

Open the help system.

 

View toolbar

Project     View Toggle     the Project View between show and hide.

Detail     View Toggle     the Detail View between show and hide.

Data View Toggle     the Data View between show and hide.

Grid Toggle the coordinate     grid in the Modeling window 
between show and hide.

Grid Wing     
menu

Room     View Grid - The Room View Grid size.
Room     Snap Grid - Enable the cursor or an object to 
snap to     the specified subdivision of the grid.
Snap     To Vertex - Enable the surface     vertices to 
snap to the nearest adjacent vertex.

XY Con-
straint     Plane  
(X)

Constrain     the movement of an object, a surface, 
and the cursor to the XY     Plane.

YZ Constraint
     Plane  
(Y)

Constrain     the movement of an object, a surface, 
and the cursor to the YZ     Plane.

XZ Constraint
     Plane  
(Z)

Constrain     the movement of an object, a surface, 
and the cursor to the XZ     Plane.

Plan View  
(H)

View     the model from above, looking straight down 
on the XY plane.

Elevation     
View  
(J)

View     the model from the side, looking straight on 
the YZ plane.

Section     View
(K)

View     the model from the side, looking straight on 
the XZ plane.

 or  Isometric     
View

View     the model in perspective, from a preset angle.
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(O)

Camera     View 
 
(P)

View the model     through a camera that can be 
placed anywhere inside or outside     of the model.

Camera     Wing 
menu

Enables     the display of the camera wireframe in the 
model.

Rotate     View  
(D)

View     the model from any angle. Click and drag in 
the modeling window     to rotate the view.

Pan  
(SPACEBAR)

Drag     the view in the modeling window to pan to a 
different area.

Zoom  
([ , ])

Zoom     in or out on an area of the model. Click to 
zoom in, hold Ctrl and click to zoom out.

Zoom to     Rect-
angle

Click     and drag to draw a rectangle around an area 
to zoom to a particular     area of the model.

Zoom to     Fit  
(HOME)

Click     on the button and the model view will be adjus-
ted accordingly.

 

Database toolbar

Material Database
(Ctrl+M)

Open the Material     Database.

Loudspeaker Database
(Ctrl+L)

Open the Loudspeaker     Database.

 

Draw toolbar

Select
(A)

Select an object in the model by clicking     on it.

Select Wing 
menu

Lists the types of objects which are selectable     using the 
Select tool.  A check indicates that     the object is select-
able within the Model View.  Items     which are 
unchecked will not be selected within the Model View.
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Sample
(S)

Click at a location in the coverage map     to place the 
Sample tool.

Sample Wing 
menu

Click to clear the sample     tool from the room model dis-
play.

Measure
(E)

Click and drag in the     model to display distance and 
angle from the point where you click.

Draw Rect-
angular Sur-
face
(R)

Create a new rectangular     surface. Click to define the 
starting point, then click again     when you have com-
pleted the shape.

Draw Poly-
gonal Surface
(Q)

Create a new polygonal     surface. Click to define the 
starting point, then click to outline     the shape. Click on 
the starting point to complete the shape.

Draw Wall 
Surface
(W)

Create a new wall surface.     Click to define the starting 
point, then click again when you     have completed the 
shape. Wall surfaces should be created in the     XY con-
straint plane.

Draw 
Cylindrical 
Surfaces
(C)

Create a new cylindrical surface. Click     to define the cen-
ter axis of the cylinder or cylinder section.     Click again 
after defining the radius of the cylinder, then rotate     the 
radius and click to define the circumference of the cyl-
inder.
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Cylindrical 
Surface Wing 
Menu

Curved surfaces are simulated by multiple     flat sur-
faces. A new flat surface is created at every angular     
increment.
Note: Smaller increments better represent     

curved surfaces, but may increase cal-
culation time.

Draw Conical 
Surfaces
(V)

Create a new conical surface. Click to     define the center 
axis of the cone, or cone section. Click again     after defin-
ing the first radius of the cone, then rotate the radius     
and click to define the circumference of the cone. Click 
again     to define the second radius of the cone.

Note: Smaller     increments better represent 
curved surfaces, but may increase     cal-
culation time.

Conical Sur-
faces Wing 
Menu

Curved surfaces are simulated by multiple     flat sur-
faces. A new flat surface is created at every angular     
increment.
Note: Smaller     increments better represent 

curved surfaces, but may increase     cal-
culation time.

Draw Spher-
ical Surfaces
(B)

Create a new spherical surface. Click     to define the cen-
ter axis of the sphere, or sphere section. Click     again 
after defining the radius of the sphere, then rotate the     
radius and click to define the circumference of the 
sphere.
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Note: Smaller     increments better represent 
curved surfaces, but may increase     cal-
culation time.

Spherical Sur-
face Wing 
Menu

Curved surfaces are simulated by multiple     flat sur-
faces. A new flat surface is created at every angular     
increment.
Note: Smaller     increments better represent 

curved surfaces, but may increase     cal-
culation time.

Place 
Listener
(L)

Click in the model to create a new listener     location. 
Listeners can only be placed on Floor     and Seating sur-
face types.

Place 
Listener Wing 
Menu

Check how listeners are to be displayed     in the model as 
a wireframe chair and/or identifier number.

Insert Door, 
Window or 
Panel
 

Click within the room     model to insert a door, window or 
acoustic panel into a surface.     Panels can only be inser-
ted into Wall surface types.

Once a panel is inserted into the room model,     a number 
of properties are available to define its appearance     and 
acoustic properties.

Insert 
Door/Window 
Wing Menu

The selection determines the offset that     will be dis-
played in the Insert Door, Window or Panel tool tip.
Minimum     will reference the object to the edge/vertex 
of the parent surface     that is closest to the click point.
Maximum     will reference the object to the edge/vertex 
of the parent surface     that is opposite to the click point.

Mirror
 

Mirror the selected surface(s)     along a line that you 
define.
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Insert Face
(I)

Insert a new surface in     an existing space by defining 
the vertices that bound the surface.     When the cursor is 
moved over a vertex, it will highlight in green.     Vertices 
will turn black after you click. The starting point is     high-
lighted in red.

Draw Custom
     Areas

Quickly map a section of a room (or multiple     sections) 
to evaluate coverage for the selected area.
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Custom Areas 
Wing Menu

Select which surface types will be used     to determine 
the vertex points when a new custom mapping area     is 
drawn within the model.

 

Extrude Toolbar

Extrude     Walls Create walls from the Floor     or Seating type surface(s) that is     
selected. The walls will be constructed around the perimeter of     
the selected surface. You will also have the option to add a ceil-
ing     surface. When multiple surfaces are extruded, walls will be 
created     around the outermost perimeter only. For example, 
you can extrude     in the negative direction, to create a raised 
floor surface.

 

Extrude     Surface The Extrude Surface tool     will extrude surfaces from a reference 
surface within the room     model. An extrusion can only be gen-
erated if the 'other' surface     intersects with the extruded ref-
erence along the currently chosen     extrusion axis.
In order for a set of surfaces to be extruded,     both a reference 
and termination surface must exist.
Select the reference surface from within     the room model:

Extrude     Rectangular 
Surface

The Extrude Rectangular     Surface tool will extrude from a 
defined rectangular surface towards     two termination surfaces.
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Extrude     Polygonal Sur-
face

The Extrude Polygonal     Surface tool will extrude from a poly-
gonal surface towards two     termination surfaces.

Extrude     Arc The Extrude Arc tool will     extrude an arc or column from a ref-
erence surface towards two     termination surfaces.
A floor and ceiling surface are used as     the minimum and max-
imum extents for the new extruded surfaces.

 
 

Map toolbar

Isobar Generate Isobar map data.  Click     to close the Isobar map.

Isobar     Wing 
Menu

Select the Isobar value to display, -3,     -6 or -9 dB.
Select the Isobar display type as either     Isobar data for the selected 
loudspeaker cluster, or for all active     loudspeakers within the model.

Direct
(F10)

Generate the Direct Field coverage map.     Click to close the Direct 
Field coverage map.

Direct + 
Reverberant
(F11)

Generate the Direct plus Reverberant Field     coverage map. Click to 
close the Direct plus Reverberant Field     coverage map.

Speech     Intel-
ligibility
(F12)

Generate the Speech Intelligibility coverage     map. Click to close the 
Speech Intelligibility coverage map.

Enable   
Listening

Enables the Auditioner processing for     the currently selected 
model.  When active you may listen     to positions within open models 
using the Auditioner Playback     system.
This function is only available within the     Modeler Plus software.

Manual     
Recalculate
(T)

If the D2R∆STIc engine is disabled,     use Manual Recalculate to recal-
culate the acoustic prediction     data after making a change to the 
model. Manual recalculation     causes Modeler software to execute all 
steps in the acoustic prediction     calculation, therefore there may be a 
slightly longer calculation     time compared to automatic recalculation 
using the D2RASTIc engine.

Enable     
D2R∆STIc     
Engine
(N)

Click to enable the D2R∆STIc engine to automatically     calculate acous-
tic prediction data. Click again to disable the     D2R∆STIc     engine. When 
the D2R∆STIc     engine is enabled, Modeler software only calculates 
those steps     in the acoustic prediction calculation that are necessary, 
based     on what changes have been made to the model. This may res-
ult in     a faster calculation time.

Animate
(Shft+Ctrl+A)

Turn on animation. Animation automatically     cycles the Direct Field 
or Direct plus Reverberant Field coverage     data through all of the fre-
quency settings in the Frequency     drop-down in the Simulation tab. 
Use     the slider to speed up or slow down the animation, and press Esc 
to close the animation.
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Web toolbar

Back Navigate back one page     in the Web tab in the Model View.

Forward Navigate forward one page     in the Web tab in the Model View.

 

Arrange toolbar

Flip Hori-
zontal
(Shft+Ctrl+H)

Click to mirror the selected     surface(s) along an axis par-
allel to the     Y axis.

Flip Vertical
(Shft+Ctrl+V)

Click to mirror the selected     surface(s) along an axis par-
allel to the     X axis.

Rotate Selec-
tion
(F)

Click and drag to rotate     the selected surface around its 
geometric center. The surface     will be rotated in the selec-
ted constraint plane.

Group
(Ctrl+G)

Group the selected objects     together. Grouped surfaces 
will act as one surface when being     moved, rotated, 
flipped or scaled. The individual sections of     a Conical, 
Spherical and Cylindrical surface are grouped by default     
when they are created. Grouped surfaces have sizing 
handles which     can be used to resize the group in three 
dimensions.
Listeners can be grouped together.
Loudspeakers cannot be grouped together.

Ungroup
(Ctrl+U)

Ungroup the selected objects     that are part of a group. 
The objects will act independently after     being 
ungrouped.

Merge Sur-
faces

Merge two surfaces that     are co-planar and intersecting

Guide Layer Displays the Guide Layer     Attributes window. 
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Guide Layer 
Wing Menu

Select to toggle the Guide     Layer on or off.

Lock Model
(Shft+Ctrl+L)
 

Click to lock or unlock the model. When     a model is 
locked (button depressed), the surfaces cannot be 
moved     independently. To move an individual surface, 
the model must be     unlocked. Vertices, listeners and loud-
speakers, the camera, and     the RT60 source     can still be 
moved when the model is locked.

 

Cluster toolbar

PlaceLoud-
speaker

Click     in the model to place a loudspeaker in the selected constraint     plane. The 
Place Loudspeaker Wing menu opens.

Loudspeaker 
Wing Menu

This drop-down menu controls     the viewing elements for loudspeakers placed 
within the room model. Select a box to activate the element.

Hitpoints - Shows the “hitpoint wand.”
Wireframes - Shows a wireframe representation of     the loudspeaker.
Identifiers - Shows the Identifier numbers for     each loudspeaker.
Cluster Origin - Shows the origin of loudspeaker clusters.

Place     Array Click in the model to place an array.     The Place Array dialog box opens.
For more information on arrays, see Working_With_Arrays.htm.

Place     
RoomMatch 
Array

Click within the model to place an array     comprised of Bose RoomMatch loud-
speakers.
The RoomMatch array properties appears,     and the view is automatically con-
figured for split view in the     Model View with the Projection View active.

Cartesian     
Coordinates
 

This function is only available from within     the Cluster View.
Adjust the position of a loudspeaker using     the Cartesian coordinates system.

Cylindrical     
Coordinates
 
 

This function is only available from within     the Cluster View.
Adjust the position of a loudspeaker using     the cylindrical coordinates system.

- 69 -



Modeler®  Sound System Software 6.8 User's Guide

Spherical     
Coordinates
 

This function is only available from within     the Cluster View.
Adjust the position of a loudspeaker using     the spherical coordinates system.

Create     Array Create an array of the selected loudspeakers.     This will allow you to steer and 
spread the sound pattern of the     array.

Unarray
 

Separate the selected array into individual     loudspeakers.  Any settings for 
steering and spreading will     get lost after un-arraying.

Map     Cluster
 

View the anechoic response of all loudspeakers     in the cluster, with the ability 
to map to a hemisphere, full     sphere, or a plane.
Automatically set for a radius of 10 meters,     hemisphere angular resolution to 
10°.

 

Model View Control Toolbar

 

Select 
Cluster

Select a cluster in the     drop-down to change to cluster view in the 
Modeling     window. Select Roomto     return to the full room view.
Note: This     is the only way to enter and exit cluster view.

Select Fre-
quency

Select a frequency to display within Map     views, and within the Time 
Response Tab within the Detail View.

 

Selected Item Toolbar
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Selected 
Item

Displays     the type and item number of the 
item currently selected within     the room 
model.

 

Material Database Viewer Toolbar

New Material Creates a new material     type entry within the room model’s mater-
ial database. The new     material may be named, and the absorption 
coefficient data may     be specified.
 
Note: This material is saved     with the room model file, 

and not with an absorption database.

Save Material Saves the current room     model materials list as a new absorption 
database. 
Once saved it will appear in the master     Modeler Material Database 
list.

Duplicate Material Adds a duplicate entry     for the selected material within the room 
model material list.

Delete Material Removes the selected material     file from the room model’s mater-
ial list.
Note: The material is not deleted     from the master mater-

ial database.

Delete Unused 
Materials

Removes unused materials     from the room model’s material list

Find Material Opens the Find     dialog box to search for a material file by name.

Find Next Material Jumps to the next record     that matches the Find... criteria

 
 

Loudspeaker Database Viewer Toolbar

Main Toolbar

Find Speaker Open the Find     dialog box to search for a loudspeaker file by name.

Find Next 
Speaker

Jump to the next record     that matches the Find Loudspeaker     criteria.

 

3D Viewer Toolbar
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Home Displays     original view.

 or  Wire or 
Solid

Displays radiation pattern without/with     
color. You can only view one at a time.

Frequency Select the frequency for viewing within     
the 2D and 3D Viewer

dB/div Change the scale (dB/div)     within the 3D 
Balloon and Isobar displays.

Driver For loudspeakers with multiple drivers, 
select a driver to display it's 3D Balloon, 
Isobar, and various specifications.

 

Background Noise Database Viewer Toolbar

New Background     
Noise Curve

Creates     a new background noise file.  This file is stored with     the 
master background noise database. Once created, the new back-
ground     noise file may be named and its frequency dependent 
levels may     be adjusted.

Duplicate     Back-
ground Noise Curve

Creates     a duplicate copy of the selected background noise file. 
Once duplicated,     the new background noise file may be renamed 
and its frequency     dependent levels may be adjusted.

Delete Background     
Noise Curve

Removes     the selected background noise file from the background 
noise database.

Rename     Background 
Noise Curve

Provides a text field from which you may     rename the selected 
background noise file.

 

House Curve Database   Viewer Toolbar

New House     Curve Creates     a new house curve file.  This file is stored with the     master 
house curve database. Once created, the new house curve file may     be 
named and its frequency dependent levels may be adjusted.

Duplicate     House 
Curve

Creates     a duplicate copy of the selected house curve file. Once duplic-
ated,     the new house curve file may be renamed and its frequency 
dependent     levels may be adjusted.

Delete House     
Curve

Removes     the selected house curve file from the background noise 
database.

Rename     House 
Curve

Provides a text field from which you may     rename the selected house 
curve file.
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Print Window Toolbar

Print Setup Opens     the Print Setup dialog.

Print Preview Opens     the Print Preview window.

Print Opens     the Print dialog.

Delete Page Removes     the selected page from the Print List.

Application     Prefer-
ences

Opens     the Application Preferences dialog from where Print/Copy preferences
     may be modified.

 
 

Window & Right-Click Menus

Modeler Application Interface

Model View Menus
The Model View displays the   Web tab, the Model tab and any coverage maps that have been generated.   
Coverage maps appear as separate display tabs in the Modeling window.
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Model View - Model Tab
 

Model View Display tabs

Display tabs change what is being displayed within the Model View.  The   following display tabs are available:
Web Tab Links   to various information related to Bose Modeler and Bose Professional Systems.   You 
must be connected to the internet for these links to be active.
Model   Tab View and create a model.
Direct   Field Tab View the Direct Field coverage map.
Direct+Reverberant   Field Tab View the Direct+Reverberant Field coverage map.
Speech   Tab View the Speech Intelligibility coverage map

Model View Right-Click Menu

Right-click anywhere within the Model View to display its   right-click menu:
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Undo Reverses     your last action or multiple actions up to the point 
at which     the model was opened.

Redo Re-applies your last action     (after undo) or multiple undo 
actions up to the most recent action.

Cut Deletes the selected item     and copies it to the clipboard 
(standard Windows editing function).

Copy Copies the item to the     clipboard (standard Windows editing 
function). Not used to copy     graphics, graphs or grids

Paste Pastes the contents of     the clipboard (standard Windows 
editing function).

Clear Deletes the selected item.

Copy     
Graphic

Copies the current image     within the Model View to the clip-
board for use in another application.

Duplicate Copies and pastes the selected     item to create a duplicate of 
it.

Aim     Selec-
tion…

Open the Aim Selection     dialog box to stack and/or aim 
multiple loudspeakers.

Constraints Expands to display the     available constraint plane 
options.  Select a constraint     plane.

Application     
Prefer-
ences…

Opens the Application     Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

D2R∆STIc Expands to display a list     of the D2R∆STIc     step 
calculations.  When an item within the list is     selected the 
selected coverage map is automatically calculated     using 
predefined default settings.
Selections include calculate the Direct     Field coverage map 
for the 1 - 4 kHz frequency     range, calculate the Direct plus 
Reverberant Field coverage map     for the 31 Hz - 16 kHz fre-
quency range, calculate     time-arrivals at 2 kHz, and cal-
culate the Speech Transmission     Index (STI) coverage map.
The D2R∆STIc Engine must be enabled     to generate these 
coverage maps.
 
For more information, see the DRASTIc_Design_Pro-
cess.htm.
 

Properties… Display the Properties     window for the object currently 
selected within the Model View.

1     dB/Step Applies a 1 dB per step     resolution to the current coverage 
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map.

2     dB/Step Applies a 2 dB per step     resolution to the current coverage 
map.

 

Project View Menus
The Project View displays the Project tab and the Model   tab, each of which changes what is displayed within 
the Project View.  Each tab displays a navigable tree view of the project   and model structure.
 

Project View

Project   Tab  

The Project   Tab displays a project in a hierarchical   format, allowing you to see all models contained within 
the project. The   appearance of the model icon in the Project tab corresponds to the state   of the model:

 Model   closed.

 Model   open, D2R∆STIc   Engine off.

 Model   open, D2R∆STIc   Engine on.
 

To   open a model, double-click on the model icon in the Project tab. The model   opens in the Model View.

Project Tab Right-Click Menu

Right-click anywhere within the Project tab of the Project   View to display its right-click menu.  The right-
click menu   contains the following options:
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New     Pro-
ject…

Creates     a new project file (.pjt) and project folder and 
specifies its     location on the hard drive. You will be promp-
ted to create a new     model, add an existing model, or 
import a model into the project.     If a project is currently 
open, you will be prompted to close     it before creating a 
new project.

Open     Pro-
ject…

Opens an existing project     by locating it on the hard drive 
and choosing the .pjt file. If     a project is currently open, 
you will be prompted to close it     before opening a new pro-
ject.

Close     
Project

Closes the project. You     will be prompted to save changes 
to models that you have modified,     with the option to save 
all models that have been modified.

Save Project Saves changes to the project.     You will be prompted to 
save changes to models that you have modified,     with the 
option to save all models that have been modified.

Save    Project 
As…

Creates a copy of the project     and saves it with a different 
name. All models within the project     will be copied. The 
new saved project will remain open and the     original pro-
ject will be closed.

Rename     Pro-
ject…

changes the name of the     project, but does not affect pro-
ject file contents.

New     Model Creates a new model. You     will be prompted to name the 
new model.
If a project is not open, a new model will     be created 
without being added to a project. This model is named     
“Untitled” by default and can be renamed at any time by 
choosing     Save Model.

Open     Model… Adds an existing model     to the project. A copy of the 
model will be added to the project     folder.

Close     Model Closes the model.

Save     Model Saves changes to the selected     model.

Save     
Model As…

Creates a copy of the model     and saves it with a different 
name. Use this option to save a     version of the model you 
are currently working on. The new saved     model remains 
open and active, and is added to the project. The     original 
model is closed and remains in the state that it was     last 
saved.
If no project is open, you will be prompted     to choose a 
location in which to save the model.

Import Model Imports a model that was     not created in Bose Modeler 
software. The model will be added     to the currently open 
project file. Choose to import a Macintosh     Modeler soft-
ware file (.mac), a Modeler Transfer File (.mtf),     an EASE 
faces file (.xfc), an EASE project file (.ppj) or an 
AutoCAD     drawing file (.dxf). Note that the file must have 
the appropriate     file extension (.mac, .mtf,.xfc, .ppj, 
.dxf) to be imported into     Bose Modeler software.
If a project is not open, the model will     be imported 
without being added to any project.

Export Model Exports loudspeaker data     to a text (.txt) file with tab 
delimited data for all loudspeakers     in the room model. 
Data includes loudspeaker properties and equalization     
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data for each device.
Export a Modeler Transfer File (.mtf) which     contains all 
the room model data in a proprietary text format     for use 
in other modeling applications.

Duplicate     
Model

Duplicates the selected     model in the project. To select 
which model to duplicate, click     on the model name in the 
Project window.     You will be prompted to name the duplic-
ate model. Modeler software     will copy the model and add 
it to the “parent” project. This option     exists only when 
the model is associated with a project.

Rename     
Model

Renames the selected model     in the project. This option 
exists only when the model is associated     with a project.

Remove     
Model

Removes the selected model     from the project. You will 
be prompted to remove the model from     the disk.
Choose Yes to     delete the model from your hard drive.
Choose No to     remove the model from the project but not 
from the hard drive.     It is saved in the project folder and 
can be added back to the     project or to another project at 
a later time.

Application     
Prefer-
ences…

Opens the Application     Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Project View.  Select     this item to toggle the 
Project view on and off.

Float Select this item to undock     the Project View from the 
main application interface.

 

Model Tab

The Model Tab displays the active room model   in a hierarchical format, allowing you to see and navigate all 
model components.
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Elements within the room model   are grouped by category.  To see individual elements you must   expand that 
section of the tree view. The appearance of each   icon within the Model tab indicates its visibility state within 
the model.

   Model element visibility set to OFF.

   Model element visibility set to ON.
 
The   following room model elements are visible within the Model tab:
Camera– Selects the Camera within   the Model Window.  When the camera visibility is set to OFF   in Room 
Model Preferences the camera may not be selected.
Center of Rotation– Selects the Center of   Rotation object within the Model Window.  When the Center of   
Rotation Object visibility is set to OFF in Room Model Preferences objects   the center of rotation may not be 
selected.
T60 Source– Selects the Reverberation   Time (RT) Source within the Model Window.  When the RT Source   
visibility is set to OFF in Room Model Preferences objects within the   RT Source may not be selected.
Surfaces– When expanded this item   displays all surfaces within the room model.  Selecting a surface   in the 
list selects the object within the Model window.  When   the visibility for a specific surface type is set to OFF in 
Room Model   Preferences surfaces of this type are shown, but may not be selected.
Clusters– When expanded this item   displays a list of all clusters contained within the room 
model.  Selecting   a cluster selects the cluster within the Model window.  When   the Cluster visibility is set to 
OFF in Room Model Preferences objects   within this group are shown, but may not be selected.

Listeners– When expanded this item   displays a list of all listeners included in the room model.  Selecting   a 
listener within the tree view highlights it within the room model.  The   selection of a listener also causes the 
Time Response, Frequency Response   and MTF Tabs to display data specific to the selected listener 
position.  When   the Listeners visibility is set to OFF in Room Model Preferences objects   within this group are 
shown, but may not be selected.
Doors/Windows– When expanded this item   displays a list of all doors, windows and panels contained 
within the   room model.  Selecting an object in the list selects the object   within the Model window.  When the 
Doors/Windows visibility   is set to OFF in Room Model Preferences objects within this group are   shown, but 
may not be selected.
Custom Areas– When expanded this item   displays a list of all custom mapping areas included in the room 
model.  Selecting   a mapping area within the tree view highlights it within the room model.  The   selection of a 
mapping area also causes the Statistics and System SPL   tab to display data specific to the selected mapping 
area.  When   the Mapping Area’s visibility is set to OFF in Room Model Preferences,   custom areas are shown. 
They may not be selected, but they will   drive Properties.
Note: The Custom Areas element   is only available if at least one Custom Area is included in 

the model.

 

Model Tab Right   Click Menu

Right-click anywhere within the Model tab of the Project   View to display its right-click menu.  The right-click 
menu   contains the following options:

Tree     Labels… Displays     the Tree Label window.  From within 
the Tree Label window     you may select what 
label attributes are displayed within the     
Model tab.

Application     
Preferences…

Opens the Application     Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Project View.  Select     this item to 
toggle the Project view on and off.

Float Select this item to undock     the Project view 
from the main application interface.
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Detail View Menus
The Detail View displays the   Simulation tab, Acoustics Tab, Properties tab Equalization tab, and tabs   which 
contain list views of various model components.

 
Display   Tabs change what is being displayed within the Detail View.  The   following display tabs are avail-
able:

Simulation   Tabcontains the mapping calculation   parameters.
Surfaces   Tab contains a table view of all room model surfaces.
Doors/Windows   Tab contains a table view of all doors, windows and panels within   the model.
Loudspeakers   Tab contains a table view of all loudspeakers and arrays within the   model.
Listeners   Tab contains a table view of all listeners within the model.
Properties   Tab displays the properties of the object selected within the model   view.
EQ   Tab displays the equalization and gain settings for the selected loudspeakers.
Acoustics   Tab displays the basic acoustic properties used in calculations for   the model.
Playlist   Tab displays the listener positions and playlists for the Auditioner   simulation.  This tab is only 
available within Modeler Plus   software, when a project file is open.
 

Detail View Right-Click Menus

Right-click anywhere within the Detail View to display   its right-click menu.  The right-click menu options 
vary based   on the tab being displayed. 

Simulation Tab Right-Click Menu

Right-click anywhere within the Simulation tab of the   Detail View to display its right-click menu.  The right-
click   menu contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

 

Surfaces Tab Right-Click Menu

Right-click anywhere within the Surfaces tab of the Detail View to display   its right-click menu.  The right-
click menu contains the following   options:
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Application     
Preferences…

Opens     the Application Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

Copy     Grid Copy the data in the Surfaces     tab to paste 
into another application.

Sort Expands to display a list     of all surface 
properties.  Select an item in the list     to sort 
by the selected item.  Available selections     
are Number, Description, Material, Type, 
Audience, or Reflection.

Cut Deletes the selected item     and copies it to the 
clipboard (standard Windows editing func-
tion).

Copy Copies the item to the     clipboard (standard 
Windows editing function). Not used to copy     
graphics, graphs or grids

Paste Pastes the contents of     the clipboard (stand-
ard Windows editing function).

Edit     Cells… Displays the Edit Cells     dialog.  Modify the 
selected property for the selected     surface.
Hold down Ctrl to select multiple separate     
items, or Shift to select a range of items.

Display     
Columns…

Opens the Column Display     dialog 
box.  Choose which columns are displayed in 
the     Surfaces tab.

 

Doors/Windows Tab Right-Click Menu

Right-click anywhere within the Doors/Windows tab of the   Detail View to display its right-click menu.  The 
right-click   menu contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail view on and off.

Float Select this item to undock     the Detail view 
from the main application interface.

Copy     Grid Copy the data in the Doors/Windows     tab to 
paste into another application.

Cut Deletes the selected item     and copies it to the 
clipboard (standard Windows editing func-
tion).

Copy Copies the item to the     clipboard (standard 
Windows editing function). Not used to copy     
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graphics, graphs or grids

Paste Pastes the contents of     the clipboard (stand-
ard Windows editing function).

Edit     Cells… Displays the Edit Cells     dialog.  Modify the 
selected property for the selected     fen-
estration.
Hold down Ctrl to select multiple separate     
items, or Shift to select a range of items.

Display     
Columns…

Opens the Column Display     dialog 
box.  Choose which columns are displayed in 
the     Doors/Windows tab.

 

Loudspeakers Tab Right-Click Menu

Right-click anywhere within the Loudspeakers tab of the   Detail View to display its right-click menu.  The 
right-click   menu contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

Copy     Grid Copy the data in the Loudspeakers     tab to 
paste into another application.

Sort Expands to display a list     of all loudspeaker 
properties.  Select an item in the     list to sort 
by the selected item.  Available selections     
are Number, Cluster, Zone, Tier, Index, 
Description, Speaker or     Status.

Cut Deletes the selected item     and copies it to the 
clipboard (standard Windows editing func-
tion).

Copy Copies the item to the     clipboard (standard 
Windows editing function). Not used to copy     
graphics, graphs or grids

Paste Pastes the contents of     the clipboard (standard 
Windows editing function).

Edit     Cells… Displays the Edit Cells     dialog.  Modify the 
selected property for the selected     loud-
speaker.
Hold down Ctrl to select multiple separate     
items, or Shift to select a range of items.

Display     
Columns…

Opens the Column Display     dialog 
box.  Choose which columns are displayed in 
the     Loudspeakers tab.
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Listeners Tab Right-Click Menu

Right-click anywhere within the Listeners tab of the Detail   View to display its right-click menu.  The right-
click menu   contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog 
box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

Copy     Grid Copy the data in the Listeners     tab to paste 
into another application.

Sort Expands to display a list     of all Listener 
properties.  Select an item in the list     to sort 
by the selected item.  Available selections     
are Number,  Ident. or Notes.

Cut Deletes the selected item     and copies it to the 
clipboard (standard Windows editing func-
tion).

Copy Copies the item to the     clipboard (standard 
Windows editing function). Not used to copy     
graphics, graphs or grids

Paste Pastes the contents of     the clipboard (stand-
ard Windows editing function).

Yaw     Listen-
ers…

Displays the Yaw Listeners     dialog.  Will auto-
matically yaw all selected listeners     at a spe-
cific cluster within the room model. 
Select the cluster for listeners to face     within 
the model within the Yaw Listeners dialog.

Edit     Cells… Displays the Edit Cells     dialog.  Modify the 
selected property for the selected     surface.
Hold down Ctrl to select multiple separate     
items, or Shift to select a range of items.

Display     
Columns…

Opens the Column Display     dialog 
box.  Choose which columns are displayed in 
the     Listeners tab.

 

Properties Tab Right-Click Menu

Right-click anywhere within the Properties tab of the Detail   View to display its right-click menu.  The right-
click menu contains the following options based on the item selected:

If a Surface is selected: Application     
Preferences…

Opens     the Application Preferences dia-
log box.
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If a Listener is selected:

If Center of Rotation, Cus-
tom Area, Door/Window, 
Grid and Ring Array, or 
RT60 is selected:

If a RoomMatch Array is 
selected:

If a non-RoomMatch Loud-
speaker is selected:

If a Vertex is selected:

If the camera is selected, no 
menu appears.
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Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

Copy     Grid Copies the current properties     for use in 
another application.

Export Array Exports the array to a specified location.
Center <ref> Uses the selected item     as a reference point 

to shift the room model such that this point     
becomes the origin of the model.

 

Equalization (EQ) Tab Right-Click Menu

Right-click   anywhere within the Equalization tab of the Detail View to display its   right-click menu.  The right-
click menu contains the following   options:

Application     
Prefer-
ences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the 
main application interface.

Copy     Graph Copies the contents of     the Equalization tab to the clip-
board for use in another application.

EQ     Graph Select this item to display     the EQ settings for the sys-
tem in a graph format.  This     is the default view.

EQ     Grid Select this item to display     the EQ settings in a table 
format.

Zero     Equal-
izer

Clears all equalization     settings for the selected loud-
speakers.

Apply     House 
Curve

Applies the current house     curve to the selected loud-
speakers.

Max     Gain Applies maximum gain to     the system.  The gain of all 
system devices is increased     until the first device 
reaches its maximum.

Select     Speak-
ers…

Open the Select Speakers     dialog box to choose a loud-
speaker or loudspeakers by Cluster,     Zone, Tier and 
Index. The EQ curve is displayed for the selected     loud-
speaker or loudspeakers

Select     Active 
Speakers…

Automatically select all     loudspeakers that have a Status 
of “On”.

Select     Incre-
ment

Expands to display a list     of available increment 
selections. 
Specify the increment by which the EQ curve     sliders can 
be moved, in dB.
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Acoustics Tab Right-Click Menu

Right-click anywhere within the Acoustics tab of the Detail   View to display its right-click menu.  The right-
click menu   contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle 
the Detail view on and off.

Float Select this item to undock     the Detail View from the 
main application interface.

 

Playlist Tab Right-Click Menu

The Playlist tab is only   available in the Modeler Plus software when a Project file is open.
 l Right-clicking over the Sets area presents:

Selecting New Set adds an Untitled Playlist set that can be renamed.
 l Right-clicking over any Model name presents:

 l Selecting Edit Options presents the following dialog:

 l Right-clicking over any Gain Offset value presents:

Selecting Gain Offset presents the following dialog:

 l Right-clicking over any View value presents:
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 l Right-clicking over any Window value presents:

As the active listener is changed during Auditioner playback, the selected window value for that listener 
will appear to help with presentations to potential customers.

 

Data View Menus
The Data View displays tabs   that provide statistical information on the quality of the coverage map,   or pre-
dicted performance data for a listener or sample position within   the model.
 

 
Display   tabs change what is being displayed within the Data View.  The   following Display tabs are available:

Time   Response tab displays   direct, reflected, and reverberant arrivals at the selected listener position
   or sample.
Frequency   Response tab displays the frequency response at the selected listener   position.
MTF   tab displays the modulation transfer function for the STI calculation   at the selected listener pos-
ition or sample.
Statistics   tab displays coverage map data using  either a probability   or cumulative distribution function.
SPL   tab displays the average frequency response for the mapped area   and/or all listeners.
RT60   tab displays the third-octave-band reverberation times for the   room model.
 

Data View Right-Click Menus

Right-click anywhere within the Data View to display its   right-click menu.  The right-click menu options vary 
based on   the tab being displayed.

Time Response Tab Right-Click Menu

Right-click   anywhere within the Time Resp. tab of the Detail View to display its right-click   menu.  The right-
click menu contains the following options:
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Application     
Prefer-
ences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the main 
application interface.

Copy     Graph Copy the figure in the     Time Response tab to paste into 
another application.

25,     50 dB Sets the vertical scale     of the graph to the selected range.

20,     50, 100, 
200, 500, 
1000, 2000 
ms

When selected, the horizontal     scale is set to this time 
range, in milliseconds.

Display     
Propagation

When selected, the graph     will include the time between 
when the sound is first created     to the first direct arrival at 
the Sample tool, or the “propagation”     time. When 
unchecked, the graph will exclude propagation time,     and 
will set 0 ms to the arrival of the first direct sound to     reach 
this listener position or sample.

Display     All 
Paths

Only available when Full     STI is calculated. Displays all of 
the direct and reflected paths     between the active loud-
speakers and the selected listener position     or sample.

 

Frequency Response Tab Right-Click Menu

Right-click   anywhere within the Freq. Resp. tab of the Data View to display its right-click   menu.  The right-
click menu contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the main 
application interface.

Copy     Graph Copy the figure in the     Frequency Response tab to paste 
into another application.

Export     Listen-
ers…

Exports frequency response     data for all listener positions 
within the room model.  Data     is exported in a .txt format 
using 1/3 Octave-band smoothing.

25,     50 dB Sets the vertical scale     of the graph to the selected range.

Smoothing Select the desired smoothing     function to apply to the Fre-
quency Response data.
A smoothing function is applied to the frequency     response 
curve at the selected bandwidth. Wider bandwidths result     
in more smoothing.
Select 0 Octave to turn smoothing off.
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MTF Tab Right-Click Menu

Right-click   anywhere within the MTF tab of the Data View to display its right-click   menu.  The right-click 
menu contains the following options:

Application     
Prefer-
ences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the main 
application interface.

Copy     Graph Copy the data in the Frequency     Response tab to paste into 
another application.

Copy     Data Copy the data in the MTF     tab to paste as a table into 
another application.

Export     Listen-
ers…

Exports STI and MTF data     together with noise and speech 
levels for all listener positions     within the room model.  Data 
is exported in a .txt format.

 

Statistics Tab Right-Click Menu

Right-click   anywhere within the Statistics tab of the Data View to display its right-click   menu.  The right-click 
menu contains the following options:

Application     
Preferences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the main 
application interface.

Copy     Graph Copy the figure in the     Statistics tab to paste into another 
application.

Data… Displays the bin data for     the histogram (Probability Dis-
tribution). Data may be copied for     use in another applic-
ation.

Probability     
Distribution

When selected, displays     the probability distribution for 
the current coverage map.

Cumulative     
Distribution

When selected, displays     the cumulative distribution for 
the current coverage map.

Normalized Normalizes the vertical     axis to the maximum value for 
the data being graphed.

Percentage Modifies the scale of the     vertical axis to represent a per-
centage of occurrence.

Color     Fill Enables/disables the color     fill option of the histogram.

Auto     Scale When selected the horizontal     axis is automatically 
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scaled to only show values that are present     within the 
coverage map.
When this option is turned off the scale     represents the 
full value range for the mapped option.

Standard     
Deviation

Enables/disables the display     of the Standard Deviation 
within the Statistics Tab

Front When selected places the     standard deviation in front of 
the histogram.

 

SPL Tab Right-Click Menu

Right-click   anywhere within the SPL tab of the Data View to display its right-click   menu.  The right-click 
menu contains the following options:

Application     Preferences… Opens     the Application Preferences dialog 
box.

Model     Settings… Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to 
toggle the Detail View on and off.

Float Select this item to undock     the Detail View 
from the main application interface.

Copy     Graph Copy the figure in the     System SPL tab to 
paste into another application.

25,     50 dB Sets the vertical scale     of the graph to the 
selected range.

Background     Noise When selected the current     background noise 
setting is graphed within the SPL tab.

House     Curve When selected the current     House Curve set-
ting is graphed within the SPL tab.

Weighting     Function:  Flat, 
A-Weighted, B-Weighted or 
C-Weighted

Apply an A, B or C weighting     function to the 
SPL data. Choose Flat to remove any weight-
ing.      Weighting is only applied to the level 
readout in the status     bar, not to the graph.

Program     SPL Displays the maximum system     SPL that can 
be achieved with the frequency spectrum of 
typical     program material.

 

RT60 Tab Right-Click Menu

Right-click   anywhere within the RT60 tab of the Data View to display its right-click   menu.  The right-click 
menu contains the following options:
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Application     
Prefer-
ences…

Opens     the Application Preferences dialog box.

Model     Set-
tings…

Opens the Model Settings     dialog box.

Show Display the Detail View.  Select     this item to toggle the 
Detail View on and off.

Float Select this item to undock     the Detail View from the main 
application interface.

Copy     Graph Copy the figure in the     RT60 tab to paste into another 
application.

Data… Displays the data for each     1/3 or 1/1 octave-band.  Data 
may be copied for use     in another application.

Draw     Rays Shows the ray distribution     and propagation used in the 
RT60 calculation.

Rever-
beration     
Time

When selected graphs the     1/3 octave-band reverberation 
times.

Average     
Absorption

When selected graphs the     average absorption of the 
room model for each 1/3 octave-band.

Decay Graphs the reverberant     decay for a single 1/3 or 1/1 
octave-band.
Not available if Norris-Eyring is selected.

Path     Stat-
istics

Shows the normalized histogram     of free path lengths (dis-
tance traveled between two subsequent     surface bounces) 
from the RT60 algorithm.

Measured     
Rever-
beration 
Time

Shows the actual reverberation     time measured in the 
room (entered in the RT60 section of the     Acoustics tab).

Reverberant     
Decay

Calculate RT60 using Modeler's     proprietary ray tracing 
method.

Norris     Eyring Calculate the RT60 using     the Norris-Eyring method.

1-20     seconds, 
Auto Scale

Set the scale of the vertical     axis to display the selected 
range. Auto Scale will automatically     select the best 
scale to fit the RT60 curve in the window.

 

Model Settings
The Model Settings dialog   contains the settings which define the display of objects and drawing   preferences 
for the room model.  Model Settings are accessed   from the Edit menu by selecting Edit > Model Settings, or 
from any   of the right-click menus within the application interface.

Drawing/Saving Tab
The Drawing/Saving tab contains   those settings which define how room objects are drawn, the drawing 
scale,   object selection preferences, and the preferences for saving predicted   data with the model. Options 
within tab include:
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Units determines the   drawing units that will be used for the room model.  Available   selections are:

Metric   – Display all units of measure using the Metric system.
English   – Display all units of measure using the English system.

Selection place a   check next to the items that will be selectable within the room model.  Remove   a check to 
make objects of that type not selectable within the room model.
File Contents select   the items that will be saved as part of the room model file.  Note   that including addi-
tional items increases the room model’s file size.  Available   selections are:

Map   Data – When checked, coverage map data that has been generated is   saved with the model file. 
When unchecked, the coverage map/s must be   regenerated when you open the model. When only 
listener location data   (no coverage maps) are generated, this data is saved with the model file.   When 
saving map data with the model file, turn off the D2R∆STIc engine before saving to   prevent Modeler soft-
ware from recalculating the coverage maps when you   open the file.
Guide   Layer – Includes the 2D DXF guide layer in the room model file.
Auditioner®   Filters – Stores the calculated Auditioner Filters for each listener   position of the room 
model.

Note: This   item is only available in the Modeler Plus software. 

Room Attributes select   the drawing aids that will be enabled within the Model View, and define   their 
default settings.  Available drawing aids are:

Room   View Grid – The Room View Grid is   displayed as a visual aid in the Modeling window. The grid is 
set to 5 m   by default, but can be changed to show a another distance.
Enable: Place   a checkmark to turn on the Room View Grid.
Distance: Enter the desired distance   of the grid.
Snap   to Vertex – When enabled,   the Snap To Vertex feature causes the cursor or an object   to snap to a 
vertex. The proximity limit is set to 0.5m by default, but   can be changed to another value.

Enable: Place   a checkmark to turn on Snap to Vertex.
Distance: Enter the desired proximity.
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Room   Snap Grid – When enabled, the Room   Snap Grid feature causes the cursor or an object to snap to 
the specified   subdivision of the grid. This applies to drawing and moving surfaces,   placing and moving 
listeners and loudspeakers, moving the Camera and moving   the RT60 source.

Enable: Place   a checkmark to turn on the Room Snap Grid feature.
Distance: Enter   the desired subdivision that the cursor, or objects will snap to.

Cluster   Attributes select the drawing aids that will be enabled within the   Cluster view, and define their 
default settings.  Available cluster   view drawing aids are:
Cluster   Snap Grid – The Cluster Snap Grid   feature applies when moving loudspeakers in Cluster View. 
A loudspeaker   or loudspeakers will snap to the specified subdivision when the feature   is enabled.

Enable: Place   a checkmark to turn on the Cluster Snap Grid.
Angle Distance: Enter the   desired subdivision that a loudspeaker will snap to.

Snap   Angle – The Snap Angle features allows   you to specify an angular increment for drawing and mov-
ing surfaces. When   drawing a curved surface with Snap Angle enabled, the cursor will snap   to the angu-
lar increment that you specify. When rotating a surface using   the Rotate Selection tool, the surface will 
snap to the angular increment   that you specify.

Enable: Place   a checkmark to turn on the Snap Angle feature.
Angle: Enter   an angular increment in degrees.

 
Curved   Surface Attributes  Curved surfaces in Modeler software are approximated   as numerous flat sur-
faces joined together to form a curve:
Curved   Surface Angular Increment – Used to draw the curve. At each angular   increment, a new surface 
is created, so the angular increment dictates   how many flat surfaces are used to simulate the curved sur-
face. As the   value of the angular increment gets smaller, more surfaces are used to   simulate the curve, and 
the smoother the curve appears. It is recommended   that you use the highest angular increment that will 
accurately represent   the room construction. Using small angular increments will result in a   very high num-
ber of surfaces in the model, which will add complexity and   increase calculation times.

Display Tab
The Display tab contains those   settings which define how room model objects are displayed within the   Model 
View. Options within tab include:
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Aiming defines the   display settings related to loudspeakers, and arrays.  The following   options are avail-
able:

Hitpoints   – Show or hide the “hitpoint wand”, which is the red line (or purple when   selected) indicating 
the location at which the loudspeaker is aimed.  Click   and drag the sphere at the end of the wand to aim 
a loudspeaker in your   model.
Wireframes   – Show or hide the wireframe representation of the loudspeakers in your   model.
Identifiers   – Show or hide the identifier numbers displayed at each loudspeaker in   your model.
Format   – Select the format of the identifier from a range of different combinations   of the following num-
bers, for Cluster, Zone, Tier, and Index, separated   by a period.

Camera defines the   display settings related to camera location used to generate perspective   views of the 
model’s interior.  The following options are available:

Wireframe   – Show or hide the wireframe that represents   the camera in the Model View.
Cluster defines the   display settings related to display of loudspeaker clusters within the   model.  The fol-
lowing options are available:

Origin   – Show or hide the cluster origin.
Size   – Choose the display size of cluster origin from the drop-down list.

Door/Window defines   the display settings related to display of doors, windows and acoustic   panels within 
the model.  The following options are available:

Wireframe   – Show or hide the wireframe that represents   the door, window or panel in the Model View.
Listener defines the   display settings related to display of listener positions within the model.  The   following 
options are available:

Wireframe   – Show or hide the wireframe that represents   the listener position in the Model View.
Identifier   – Show or hide the identifier numbers displayed at each listener location   in your model.

RT60 defines the display   of the RT60 source within the model.  The following options   are available:
Location   – Show or hide the purple sphere that represents the RT60   source.
Size   – Choose the size of the RT60   source from the drop-down list.

Map defines the display   properties for map data generated by predictions within the Modeler software.  The   
following options are available:

Hide   Maps – When selected, all coverage maps are hidden and cannot be viewed.   This is useful in situ-
ations such as a client presentation, when you might   not want coverage maps to be visible.
Custom   Areas – When selected, all custom mapping areas are hidden and cannot   be viewed.
Sample   Smoothing – When selected, a gradient fill pattern is applied to between   map sample points to 
provide a more continuous looking coverage map.
Sample   Fill – When selected, the fill between sample points is removed, and   only the gradient mesh is 
visible.
Translucent   – When selected, a transparency is applied to the coverage map allowing   you to view room 
model objects below the coverage map.

Drawing Aids includes   selections for display options of items that assist in the creation of   room 
models.  The following options are available:

Rulers   – When selected, enables the drawing rulers within the Model View.  Drawing   ruler units are 
determined by the Room View Grid settings in the Drawing/Saving   tab.
The   drawing rulers appear on the top and left edges of the Model view in Plan,   Elevation, and Section 
Views. Toggle the rulers between show and hide   with this checkbox.
Axis   Indicator – The axis indicator appears   in the lower left corner of the Model View and displays the 
orientation   of the three major axes. The axis pointers are highlighted according to   the selected con-
straint plane. This is a useful tool for orienting yourself   in three-dimensional space as well as when using 
constraint planes.
Guide   Layer – When selected, a 2D DXF guide layer appears   behind the room model and is used to 
provide a visual reference, or as   a drawing aid for room model creation.
Center   of Rotation – When selected, the Center of Rotation indicator is displayed   within the Model 
View.  The center of rotation determines   the point within the room model which will serve as the center 
of rotation   for isometric views of the model.
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The Center   of Rotation is independent of room model coordinates and may be placed   anywhere in the 
model.

Surface Type check boxes   control which surface types are displayed in the model. Remove a checkmark   to 
hide the given surface type in the model. Surfaces are not removed   from the model and will still be con-
sidered in all calculations, but are   no longer visible within the Model View.
Drawing Aids includes   selections for display vertices for surfaces within the room model.  The   following 
options are available:

Vertex   – Show or hide the red markers that highlight each vertex in the model.
 

Materials Database Window
The Materials Database window   displays all of the available materials within the materials database,   and 
those materials currently stored with the room model file.

Modeler   Materials Database Window

Materials Database Pane
The materials database pane   of the Materials Database window contains all materials available for   use 
within the room model.  Materials are organized by surface   and reflection property.  To add a material to the 
list of materials   available for use within the room model, drag the desired material from   the materials data-
base pane to the room model materials pane.

Room Model Materials Pane
The room model materials pane   contains a list of all materials available for use within the room 
model. These   materials appear in the various Material drop down menu items within the   application inter-
face. Materials indicated with a   blue highlight are those materials currently in use within the room model.
The current list of room model   materials may be saved as a new, custom materials database for use in   other 
room models.  This is accomplished by selecting File>Save   Material List…
Note: To   be available for use with other room models materials database files must   be located 

in the material_data directory.  The material_data   directory is located at Program 
Files/Bose/Bose Modeler 6.8/data/material_data.

 

Room Model Materials Right-Click Menu
Right-click anywhere within the room model materials pane   to display its right-click menu.  The right-click 
menu contains   the following options:
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Application     
Preferences…

Opens     the Application Preferences dialog box.

Model Set-
tings…

Opens the Model Settings     dialog box.

Sort Expands to display a list     of all sort options. Available 
selections are By Number or By     Material.

Copy Grid Copies the current list     of room model surfaces and the 
absorption data for use in another     application.

 

Loudspeaker Database Window
The Loudspeaker Database window   displays all of the loudspeakers available within the loudspeaker data-
base,   and provides detailed technical information for the loudspeaker currently   selected within the database.

Modeler   Loudspeaker Database Window
 

Loudspeaker Database Pane
The loudspeaker database pane   of the Loudspeaker Database window contains all loudspeakers available   for 
use within the room model.  Loudspeakers are organized by   manufacturer and product line.  To view the tech-
nical data for   a loudspeaker, select that loudspeaker within the database pane.

Loudspeaker Technical Data
The loudspeaker technical   data section displays information related to loudspeaker data file, and   loud-
speaker performance data that would commonly be found on a technical   data sheet. 
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Modeler   Loudspeaker Database Window – Technical Data
 
The following information   is included in this section:

Manufacturer   describes the manufacturer of the loudspeaker. 
Model   the name/model of the loudspeaker
Weight   the weight of the loudspeaker in kilograms or pounds.
File   Version of the loudspeaker the loudspeaker data file.
Info   describes the loudspeaker and its components.
Sensitivity   of the loudspeaker across all of its operating frequencies, in dB-SPL.  Sensitivity   is ref-
erenced to a 1 Watt input at a distance of 1 meter.
Maximum   Power handling of the loudspeaker, in Watts.
Maximum   SPL output of the loudspeaker.  This value is calculated   based on the loudspeaker’s power 
handling and sensitivity.
Impedance   of the loudspeaker, (nominal), in Ohms.
Beamwidth   indicates the angle at which the sound pressure level is 6 dB less   than the on-axis sound 
pressure level. This is averaged over the   1/3 octave bands from 800 - 5 kHz, (or the   1 - 4 kHz octave 
bands).

Note: The beamwidth, as displayed here, is calculated for a single driver.    In the case of multi-
driver loudspeakers, this may not be the beamwidth   data that is published on the 
product data sheet, as it does not represent   all drivers operating simultaneously.

3D Data Viewer
The 3D data viewer contains   visualizations of the loudspeaker data in a three dimensional format.  Each   visu-
alization is available as a tab along the bottom of the 3D Data Viewer,   while a basic toolbar contains controls 
to change the visualization settings. 

Modeler   Loudspeaker Database Window – 3D Data
 
Display   Tabs change what is being displayed within the 3D Data View.  The   following display tabs are avail-
able:
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3D BalloonDisplaysthe   3D radiation characteristics of the selected loudspeaker at the selected   1/3 
octave-band center frequency.  Data displayed isthe   loudspeaker’s magnitude data contained within the 
loudspeaker data file.
3D   CAD Displays the loudspeakers wireframe data.
Isobar   Displays the loudspeakers anechoic coverage mapped on a hemisphere at   the selected 1/3 
octave-band center frequency using a 1 dB per division   color scale.

Tip: You can achieve free dynamic   rotation, by holding down the left mouse button while moving cursor in   a 
circular motion on the diagram for unrestricted rotation. To achieve   Y (left) rotation, hold down the Ctrl key, 
then left-click and drag your   mouse left/right. For X (up) rotation, hold down Shift key, then left-click   and 
drag your mouse forward / backward.

2D Data Viewer
The 2D data viewer contains   visualizations of the loudspeaker’s performance in a graph format.  Each   graph 
is calculated based on the data contained within the loudspeaker   data file. 
Each visualization type is   available as a tab along the bottom of the 2D Data Viewer, while a basic   toolbar 
contains controls to change the visualization settings.

Modeler   Loudspeaker Database Window – 2D Data
 
Display   Tabs change what is being displayed within the 2D Data View.  The   following display tabs are avail-
able:

Polar   PlotDisplayshorizontal and vertical radiation   pattern of the loudspeaker at the selected 1/3 
octave-band center frequency.  The   red line represents the horizontal polar data, while the blue line rep-
resents   the vertical data.
Dotted   lines represent the beamwidth at the selected frequency. The dotted red   lines define the hori-
zontal beamwidth (governed by the intersection of   the solid red polar plot with the green -6 dB circle). 
The dotted   blue lines define the vertical beamwidth.
Sensitivity   Graphs the sensitivity of each 1/3 octave-band (dB-SPL for 1W @ 1m) versus   frequency for 
the selected driver.
Beamwidth   Graphs the horizontal, blue, and vertical, red, beamwidth angle for each   1/3 octave-band 
versus frequency.
Directivity   Graphs the Directivity Index of each 1/3 octave-band versus frequency.

 

Print Window
The Print window contains   a list of available print selections, and a list of the items that will   be printed, and 
their print settings. To   access the print window, go to File > Print.
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Modeler   Print Window

Print Selections Pane
Create a list of documents   to be printed by dragging items from the Print Selections Pane on the   left into the 
Print List on the right. You can open folders and select   items in the Print Selections Pane as you would in Win-
dows Explorer.
You have the option to print:
 l The room model.
 l Individual clusters.
 l Surfaces, Listeners, and Loudspeakers spreadsheets.
 l Coverage maps.

The documents that are available to print are based   on the state of the room model. For example, you will 
not have the option   to print coverage maps unless they have been generated in your model.
Keep the following things in mind when you create a   print list:
 l Folders cannot be dragged into the list, only    individual items.
 l To drag more than one item at a time, hold down    Ctrl to select multiple separate items or Shift to select a 
range    of items.

 l To delete an item from the print list select    the item and click the delete button in the Print Window’s tool-
bar.

 

Print List
The Print List contains all   items that will be printed and the print settings for each item in the   list.
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Modeler   Print Window – Print List
Each item within the Print   List contains a number of properties to define how the item will be 
printed.  Available   print properties are as follows: 

Descriptiondisplays   the item to be printed.  This property may not be modified.
Title   adds a print title to the selected item.  The print title appears   in the heading with the Bose logo.
Scale   sets the scale of the drawing to be printed.  Available options   are based on the current drawing 
scale units as defined in the Model Settings   window.
Rotation   determines the model orientation to be used for the printed item.  Available   selections are the 
standard views, (plan, side, etc.), a custom orientation,   or a camera view based on a model listener loc-
ation.
Listener   this item is enabled when Camera is the selected option in the Rotation   property.  Available 
selections are the room model listener   locations.

 

Print Preview Window
The Print Preview window allows   you to view the items that will be printed.  The Print Preview   window is only 
accessible from within the Print Window. Select File>Print   Preview… in the Print Window.
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Modeler   Print Preview Window
The Print Preview window contains   basic control functions to navigate through the pages in the print list,   
print the document being previewed, and zoom controls.  Available   controls include:

Print…Open   the print dialog box..
Next   Page Preview the next page in the printout..
Prev   Page Go back one page in the printout.
Two/One   Page Switch between viewing one page at a time, and two pages at a   time.
Zoom   In Zoom in on the printout.
Zoom   Out Zoom out on the printout
Close   Close the Print Preview window and return to the Print Window.
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Modeling the Room's Acoustics
Importing Model Data

Importing AutoCAD   2D
You can either chose to open a single 2D .DXF drawing or to add it to the currently opened project.   You can-
not import a 2D .
To import a 2D .DXF file:
1. Select File>Import    Model>AutoCAD (or press CRTL-I on your    keyboard).
2. Browse the file system to    locate the 2D AutoCAD file of interest,    select it, and then click OPEN.
3. The following DXF conversion dialog will determine how the DXF file is imported  as a Guide Layer within 

the room model:

2D .DXF file conversion
 

Note: With very complex .DXF files, it may take a   while until the DXF conversion window is 
displayed. Note the status bar.

 
The DXF   conversion dialog shows all available layers in a spreadsheet that can   be sorted by clicking on the 
header of each column. All layers are selected   for import by default but can also be checked individually. 
Selecting   the checkbox in the Layer header toggles all layers on/off. For each layer,   its elevation in the 
Guide Layer and its color can be adjusted. Click OK to accept the parameters and   to begin the import pro-
cess.
 
Once Modeler® software constructs   the geometry elements from the information in the .DXF   file, the Guide 
Layer Attributes window is displayed:
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Guide   Layer Attributes
 
Often, not all layers that are listed in the DXF   conversion dialog will show up in the subsequent window for 
the Guide   Layer attributes. There are two types of layers that won’t be transferred   into the Guide Layer: 
Empty layers and layers that only contain objects   combined into blocks. If a layer contains both blocked and 
exploded elements,   only the latter will be made available in the Guide Layer.
 
The Guide Layer window can be accessed at any time,   also after the completion of the import process. This 
way, a variety of   adjustments can be made to the Guide Layer during subsequent modelling.   The Guide 

Layer can be accessed by selecting the Guide Layer icon   in the Arrange toolbar:
The Guide Layer icon also features a wing-menu that   allows toggling the display state of the Guide Layer. 
The same functionality   is available via the Display tab in the Model Settings but the fastest   way is certainly 
to utilize the direct keyboard shortcut “g”.
The Guide Layer window is organized in five main sections.   The bottom of the window shows a spreadsheet 
with all imported layers   that contained valid geometry data. Make sure that the colors set for   these layers 
are distinguishable from the background color you chose for   the Model window. As in the conversion dialog, 
the list can be sorted,   layers can be selected for display and the elevation of the displayed   layer can also be 
adjusted. The upper section of the Guide Layer window   contains four important options to adjust the appear-
ance of the Guide   Layer content within the Model window:
 l Scale    - This section defines the Units that will be used for the imported    DXF data. This selection is import-
ant since    a .

 l Offset    - This section determines where Modeler® software locates the Guide    Layer content within the 
Model Window. If the pull-down menu for “Centering”    is set to “Automatic”, the DXF data will    be centered 
in the model based on the extent of the data in the two    dimensions available. If the menu is set to 
“Manual”, offset coordinates    can be entered in the two respective fields. If the values are set    to Zero, the 
origin of the “Global Coordinate System” within the original    .

 l Rotate    - This section allows the adjustment of the basic orientation of the    imported layer(s) as well as 

- 103 -



Modeler®  Sound System Software 6.8 User's Guide

any additional    rotation around the Modeler software coordinate system origin. While    the latter may be less 
frequently applied, note that you can utilize    the “Orientation” setting to import a cross-sectional drawing 
of the    room and start modeling from there, e.g., by applying the Extrude    Surface tool. Note that once you 
change the orientation, the axis    available for “Offset” will change accordingly. The “Rotate” section    also 
allows you to invert (i.e., mirror) the Guide Layer content at    one of the two available main axis.

 l Drawing    - This section allows you to enter the width of the lines as drawn    in the Guide Layer. We recom-
mend keeping this value small in order    to avoid cluttering of the display. Also available is an option that    
allows you to display any vertices within the Guide Layer content.    This function is important with regards 
to Modeler software’s ability    to have its drawing tools snap to vertices within the Guide Layer.    With ver-
tices shown, the user is able to distinguish a valid snap    location from a simple crossing of two lines.

 
 
See also:
Centering a 2D Guide Layer   or 3D Model
Start Working With a 2D   Drawing

Importing AutoCAD   3D
You can either chose to open a single 3D .DXF model or to add it to the currently opened project.
To import a 3D .DXF file.
1. Select File>Import    Model>AutoCAD (or press CRTL-I on your    keyboard).
2. Browse the file system to    locate the 3D AutoCAD file of interest,    select it, and then click OPEN.
3. The following DXF conversion dialog will determine how the DXF file is imported  as a Guide Layer within 

the room model:
 

DXF conversion dialog
 
As with 2D import, the 3D DXF   conversion dialog shows all available layers in a spreadsheet that can   be sor-
ted by clicking on the header of each column. Again, layers can   be checked individually for import. Selecting 
the checkbox in the Layer   header toggles all layers on/off. For each layer, its material, surface   type and its 
color can be adjusted. Assign materials to each layer by   dragging the desired material from the set of mater-
ial databases on the   left side of the window onto the respective cell-entry within the spreadsheet.   You can 
now also assign Modeler® software specific surface types and color   to each layer. Select OK to accept the 
parameters and to begin the import   process.
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Once Modeler software constructs the geometry elements   from the information in the .DXF file, a window   for 
the scale of the DXF drawing is displayed.
 

3D DXF Scale
 
As with the Guide Layer window, the section Scale defines   the units and scale that will be used for the impor-
ted DXF   data. Again, select between “Metric” or “English” units or custom scaling   by choosing the “Other” 
option and entering the scale factor in the associated   text box. Model Dimensions displays the overall 
extents of the imported   .
 
See Also:
Centering_a_2D_Guide_Layer_or_3D_Model.htm
Start_Working_With_a_3D_Model.htm

Centering a 2D Guide Layer or 3D Model
As described for the Guide Layer window, it is generally   advisable to adjust the offset of the imported draw-
ing. This section describes   an easy-to-use method to exactly center the room model and, if applicable,   the 
two-dimensional Guide Layer around a user-defined location within   the room model.
Modeler® software can center the model and Guide Layer   around the location of any of the following room 
model items:
 l a vertex of any surface in the model,
 l a loudspeaker or 
 l a listener.

For the purpose described here the first option of centering   the model and Guide Layer around the vertex of 
a surface within the model   is used. The following example attempts to explain the recommended method   for 
application with a 2D Guide Layer. For simplicity, the .DXF drawing consists of just the playing field of a soc-
cer   arena, but the method also applies to much more complex models.
For this example, the offset of the model and the Guide   Layer is adjusted such that the midpoint of the soc-
cer field will coincide   with the Modeler software (0,0,0) coordinate system origin. But first,   observe how the 
drawing will be imported using “Automatic” offset:
 

- 105 -



Modeler®  Sound System Software 6.8 User's Guide

Soccer   field with “Automatic” Guide Layer offset
 
With “Automatic” centering, Modeler® software places   the Guide Layer such that the maximum extent of the 
drawing in both dimensions   (here: x and y) is centered around the Modeler software origin. In this   case, the 
model does not only contain the soccer field (the geometry of   interest) but also two other elements that 
skew the offset of the Guide   Layer. This way, the playing field is offset to negative x and also towards   pos-
itive y.
The next figure shows how the model is centered when   “Manual” offset is chosen and both the x and y offsets 
are set to zero.   This way, the Modeler software origin coincides with the origin of the   Global Coordinate Sys-
tem within the original .DXF   drawing. Using this option, the midpoint of the field is offset even further   from 
the Modeler software origin.
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Soccer   field with “manual” centering and zero offset for x and y
 
The .DXF drawing contains   a little triangle depicted in blue to facilitate the method of centering   described 
below:
 

Midpoint   of soccer field with guide object for the helper surface
 
Note that the triangle is drawn such that the tip coincides   with the midpoint of the field. Now, a helper sur-
face can be drawn which   utilizes the ability to snap to vertices of the Guide Layer, and coincides   exactly with 
the blue triangle. Look closely again on the tip of the triangle,   this time with the Guide Layer vertices dis-
played:
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Midpoint   of soccer field with tip of guide object (vertices turned on)
 
Note the many vertices that make up the small circle   at the midpoint. It would be very hard to exactly place 
a vertex of a   helper surface in this region since so many Guide Layer vertices are valid   candidates for snap-
ping. 
Thus, all layers will be temporarily turned off except   the one that contains the blue triangle:
 

Midpoint   of soccer field with field layer turned off
 
You can now use the Draw Polygonal Surface tool to create   a helper surface on top of the triangle. The fol-
lowing figure shows the   model including the new helper plane. For better clarity, the Detail Window   has been 
floated and the Properties Tab chosen showing the properties   of the newly created helper surface.
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Soccer field with helper   plane and vertex properties
 
Note that the vertex at the midpoint of the field (#0)   and also its arbitrary offset from zero has been selec-
ted. Now, right-click   into the row describing the coordinates of the desired vertex and chose   “Center Vertex” 
as depicted in the figure below:
 

Center   Vertex function
 
Both the model surface(s)   and the Guide Layer content will now be moved such that the chosen vertex   coin-
cides precisely with the Modeler® software coordinate system origin   as seen in the figure below:
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Centered   Guide Layer and model. Note precise midpoint placement.
 
Note: The “Center   Vertex” functionality is only available in the Properties Tab within the   

Detail Window, i.e., not via the Properties in the right-click-menu.

 
With 3D .DXF models, the concept   of centering around a surface’s vertex is identical to the method above.   
Nonetheless, all issues related to snapping to the Guide Layer are not   applicable, simply because there is no 
Guide Layer in use. Thus, all subsequent   centering is applied to the model only. You may either center 
around any   vertex of any surface that was imported with the 3D model or you may chose   to insert a helper 
surface in case you don’t have a vertex available in   the desired location. You may also place a listener or 
loudspeaker at   the desired location and apply the “Center Listener” or “Center Loudspeaker”   algorithm, ana-
logous to “Center Vertex”. Note that the centering function   works in all three major room dimensions, so in 
case you want to avoid   that the z-coordinates of the model are changed, make sure that your reference   ver-
tex/listener/loudspeaker for centering has an elevation of zero.
 

Start Working With a 2D Drawing

General modeling strategies
Before you import a .DXF drawing   into Modeler® software and start working with the creation of a 3D sim-
ulation   model, you should think about the best way to build your geometry. The   “best” way in this sense 
means: Minimize modeling time by utilizing as   many “semi-automatic” drawing tools as possible. The tools 
for the extrusion   of surfaces are very powerful when used in conjunction with a Guide Layer.   The two fol-
lowing examples illustrate this:
Example #1 - Imagine you have to create a model for a room that features   are complex floor shape, with 
lots of corners, recessed wall elements,   dedicated seating areas, columns that need to be cut out of the 
floor,   etc. but at the same time, with a relatively simple, i.e., uniform, ceiling   structure. In such a case, the 
recommended approach is to import a floor   plan into the Guide Layer and using the Draw Polygonal Surface 
tool to   create a polygon that follows the outline of the room. Then, use the Extrude   Walls tool to create side 
walls and a flat ceiling of continuous height.   Or use the Extrude Surface tool to clip the side wall extrusion at 
more   complicated ceiling shapes, such as a barrel vault.
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Example #2 - Should you have to model a room with a simple-shaped floor   plan but a complicated, aud-
itorium-like ceiling, it may be more efficient   to import a cross-sectional drawing of the room, rotate the 
Guide Layer   to the correct orientation and center it appropriately, e.g., such that   the floor level is at zero 
height. Now, use the Draw Polygonal Surface   tool and create a polygon that follows the outline of the room 
in this   sectional view and which will define the footprint for an extrusion. Create   two bounding surfaces at 
the desired location of the two side walls. Now,   use the Extrude Surface tool and extrude the footprint sur-
face towards   the two boundaries with the termination setting “Closed”.

How much detail ?
With a detailed architectural drawing available in the   Guide Layer, it is very tempting to follow every small 
edge available,   especially since Modeler® software allows the various drawing tools to   snap onto available 
vertices in the Guide Layer.
In general, it is not recommend to follow this approach   for two different reasons. One is that too much detail 
in the geometry   of a model for acoustic predictions slows down calculations. (More information   about this 
aspect can be found in Start   Working With a 3D Model). The other equally important aspect is that   in general, 
building and especially modifying room models becomes much   trickier when the vertices of surfaces leave 
the smallest available Room   Snap Grid in Modeler software (0.1 meter). While various snapping algorithms   
within Modeler software help overcoming the associated problems, it is   typically more time-consuming to 
build models whose major surfaces do   not coincide with the room snap grid. The following example outlines 
one   possible strategy to work with an imported 2D Guide Layer that has proven   to work quite conveniently.
The main decision you need to make while using a Guide   Layer is whether you should snap to a Guide Layer 
vertex or draw on top   of the Guide Layer by utilizing the Room Snap Grid only. The following   picture shows a 
screenshot of part of the ground floor of an indoor swimming   pool:
 

Imported   Guide Layer of a swimming pool.
 
In this example some good candidates for snapping to   vertices are depicted. The angled boundaries of the 
pools would be especially   hard to do without utilizing the snapping functions. The next screenshot   shows an 
enlarged detail of the situation:
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Model   surface created on top of one pool.
 
Note the blue indicators of available vertices in the   Guide Layer. Many vertices describe the various 
curvatures with a detail   that is not required for our purpose. Thus, the contour of the pool has   been followed 
with a reduced set of vertices.
A second example (from the same project) looks at a   part of the Guide Layer drawing where snapping to its 
vertices would be   less convenient when further proceeding with the model. There are two   elements in this 
part of the model that could be used for guidance: the   location of the upper side wall and the footprints of 
rectangular columns   that support this side wall. Again, it is possible to use the snapping   functionality and 
place model elements precisely over the Guide Layer   elements, but a detailed inspection of the side wall of 
this example would   reveal that it is not precisely parallel to the x-axis, but offset by   some millimeters at one 
edge.
Such a slightly angled surface is hard to work with;   it gets difficult to join adjacent surfaces or to add ver-
tices at exact   locations. Thus, a wall surface is created that only comes close to the   actual drawing reference 
but rests on the closest available room snap   grid. Typically, the resulting error is in the range of a couple of 
centimeters   and thus negligible. The following screenshot shows the respective part   of this model:
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Imported Guide Layer with   side walls and column locations.
 
The next issue with this particular Guide Layer is the   fact that one edge of the square column footprints does 
not coincide with   edge of the wall. This can be seen if one zooms into the boundary:
 

Misalignment   of side wall and edge of column.
 
There’s just no sense in trying to be accurate and to   model the column where it’s precisely located in the 
Guide Layer - it   makes much more sense to have it align with the side wall. The following   figure shows the 
same part of the model with a column footprint and a   side wall element added by utilizing a 0.1 m Room 
Snap Grid. Note   that the column edge is now precisely aligned to the side wall. Note also   the very small mis-
alignment of a few centimeters at the other side of   the column.
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Column   footprint and wall drawn using the Room Snap Grid.
 

Snap to vertex functionality
As mentioned before, Modeler® software allows its various   drawing tools to utilize the snapping func-
tionality with regards to available   vertices in the Guide Layer. In order to allow Modeler software to snap   to 
the Guide Layer, you need to check the appropriate box in the Drawing/Saving   tab of the Model Settings.
 

Model   settings to enable snap to vertex .
 
Since vertices in the Guide Layer may be located in   very close proximity to each other, it is recommend to 
set the sensitivity   for snapping to a small value and zoom into the drawing during surface   creation in order 
to ensure sufficient visibility of details. The Snap   To Vertex setting does not distinguish between vertices in 
the Guide Layer   or in the actual model - once activated, it applies to both. This may   be disadvantageous in 
two situations:
 l If you want to want to snap to model surfaces    alone, you either need to temporarily turn off the complete 
Guide    Layer (Keyboard shortcut ”g”) or you turn off only the layers that    contain the elements that get into 
the way (see the centering example    in Centering    a 2D Guide Layer or 3D Model).

 l If you want to snap to the Guide Layer alone,    you need to disable the display of any model surfaces that 
get into    the way of Guide Layer vertices by turning off the respective Surface    Types in the Display Tab of 
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the Model Settings. This may also require    to temporarily change the assignment of Surface Type to some 
surfaces.

The display of vertices can be toggled with a checkbox   in the Drawing section of the Guide Layer window as 
displayed in the figure   below.
 

Toggle   vertex display in Guide Layer Attributes.
 
Note: Modeler®   software snaps to the available vertices of an element in the Guide Layer   but 

not to intersections of elements. Thus, displaying the vertices of   the Guide Layer is 
recommended.

 

Surface visibility
Another interesting feature of the Guide Layer is the   ability to choose the elevation of the various layers. 
This way, layers   that describe floors and walls can be placed at zero height and layers   that describe lighting 
elements, cable trusses, or ceiling support structures,   can be placed at the actual mounting height in order 
to simplify collision   detection when placing loudspeakers.
Layers are displayed in the Model view at an elevation   as specified in the Guide Layer window. Depending on 
their z-coordinates,   surfaces created in Modeler software may appear differently if their vertices   result in 
being either above, below or at the same height as the respective   layer elevation. The following images try 
to illustrate this situation:
 

Guide   Layer only (left) and with surface above (right). Note regular (black)   surface edges.
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Guide   Layer at same height as surface (left) and above surface (right). Note   color change of surface edges 
and details to vertex indicators.
 
This artifact also appears during the creation phase   of a new surface whose edges lie exactly above lines 
from the Guide Layer,   which is normal when you utilize snapping to vertices of the Guide Layer:   These col-
linear edges disappear during surface creation as can be seen   in the example below.
 

"Disappearing”   edges of newly created surface with Guide Layer at elevation ≥ Zero.
 

Start Working With a 3D Model
Depending on the original purpose of the 3D .DXF model you received, it may not be suitable for acoustical   
modeling right away. In general, a good acoustical model requires much   less detail than an architectural 
model. Too much detail does not only   slow down calculations, it may also cause inaccurate results. It is 
therefore   good practice to simplify a 3D model should it contain too much detail.   As a general rule, don’t 
model surfaces with an extent of less then 0.5   to 1.0 m in any dimension. 
Among others, some common recommendations are:
 l Don’t build stairs by modeling all their individual   steps. Instead, model a continuous surface with scat-
tering reflection   characteristics.

 l Don’t model window or door frames that are just some   centimeters deep. Remove those elements and 
replace them by doors and   windows from the respective Modeler® software toolbar. These elements   are 
much more efficient with regards to acoustical modeling.

 l Remove any decorative elements like chairs or other   furniture. Instead, try to understand their acoustical 
behavior and assign   corresponding characteristics to the underlying surfaces. Do not remove   elements 
that do have an important acoustic property, e.g., a shelf that   obstructs parts of the room from direct 
sound arrivals.

 l Remove support structures (e.g., steel elements in the   ceiling) as long as they are small (sound will typ-
ically diffract around   them), unless they are required, for collision detection.

Coupled spaces
It is often likely that the original purpose of the   3D model that you have imported was not necessarily 
related to acoustic   predictions. Depending on the complexity of the modeled building, the   drawing may con-
tain several building blocks which may or may not be acoustically   coupled. A typical example would be a 
transportation venue that spans   over several floors that are only coupled by relatively small openings.   In 
general, coupled spaces are not recommended in Modeler software since   a “global” reverberation time is 
assumed for the acoustical predictions.   Should your 3D drawing contain such complex structures, it is recom-
mend   that you remove all building blocks except the one of interest, close   any openings and restrict the pre-
dictions to the section of interest.
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Bent surfaces
Depending on how much care was taken when the AutoCad® model was created, your model may also con-
tain   bent surfaces, i.e., surfaces where not all corner vertices are located   in the same plane. Should Modeler 
software detect such surfaces during   the import, it will correct the

Close Openings
For any reason, your imported room model may contain   openings. Check your model carefully to detect crit-
ical, unintended openings.   Modeler® software doesn’t require the simulation model to be “watertight”,   e.g., 
it is allowed to model a stadium with a large opening in the ceiling,   but certainly, it is undesirable that the 
model contains larger openings   where they don’t belong. It is often usually practical to search for any   open-
ings by utilizing Camera View and setting the “Back Color” to a very   distinctive color, e.g., pink. You can 
then maneuver through your model   and look around for any inconsistencies in the geometry. As with bent   
surfaces, the most effective way to close openings is inserting triangular   surfaces with the help of the Insert 
Face tool.

Assign surface types & descriptions
After importing to Modeler software, you should consider   assigning surface specific descriptions since these 
are not available   in .DXF files. Also, since the

Assign acoustical properties to surfaces
As described in Start   Working With a 2D Drawing, you have the option of assigning acoustical   materials to 
individual layers during the import phase of a 3D .DXF file. Nonetheless, materials are typically assigned   to 
each surface, so please make sure you verify the material assignment   for each individual surface. In order 
to properly define all acoustical   properties of a given surface, you also need to assign the correct reflection   
characteristics (scattering, specular) and, if utilized, occupancy settings   to each surface. The Surface Tab in 
the Detail View and its capabilities   for sorting allow for effective assignment of these properties.

Set Acoustical Parameters
A .DXF file does not contain   any information about the acoustical environment of the room model. Therefore,
   use the Acoustics Tab in the Detail View to set the relevant acoustical   parameters like temperature, humid-
ity, occupancy and background noise.   Also, before you start performing acoustical predictions in your room   
model, make sure that the source used for Ray Tracing predictions of reverberation   time is placed in a reas-
onable location.
 

Importing an EASE Packed Project (.ppj) File
When Modeler imports an EASE packed project file (.ppj),   many of the unique attributes of the original room 
model are leveraged.   Typical attributes include room geometry, surface characteristics (descriptions   and 
absorption coefficients), listener locations, loudspeaker locations,   temperature, and humidity.
To import an EASE packed project file:
1. Click the File    menu, Choose Import Model,    specify the EASE PPJ File (.ppj)    file option.
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2. Select the appropriate file    from the available list and click Open.    A Substitute Speaker wizard will 
appear:

 
3. Place an “X” in the box to    the left of each speaker you wish to import.
4. Click and drag substitute    speakers from the loudspeaker database (left pane) to the Substituted    Speaker 

field (right pane).
5. Click Finish    when done.

A dialog box will appear   indicating you should check model attributes for the newly imported file:

 
After clicking the OK button, your original EASE room   model is visible in the modeling window. To ensure 
the packed project   file imported correctly, a review of key model attributes is in order.   See Checking   
Model Attributes.

Importing an EASE Faces (.xfc) File
You may import EASE faces files (.xfc) from either EASE   or Google SketchUp using the SU2EASE   plug-in 
from Rahe-Kraft. When Modeler software imports an EASE faces file,   surfaces are imported and room geo-
metry is preserved.
To import an EASE faces file:
1. Click the File    menu, Choose Import Model,    and select the EASE XFC File (.xfc)    file option.

- 118 -



Modeler®  Sound System Software 6.8 User's Guide

 
2. Select the appropriate file    from the available list and click Open.    A Substitute Material wizard will 

appear:

 
3. Click and drag substitute    materials from the Material Database (left pane) to the Substituted    Material 

field (right pane).
4. Ensure Surface Types are correct    by clicking on the drop down menu and modifying values as needed.    

Click Next to proceed. The    Substitute Speaker wizard will appear:
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5. Ensure that the speakers you    wish to import have an “X” marked to the left of each imported speaker.
6. Click and drag substitute    speakers from the loudspeaker database (left pane) to the Substituted    Speaker 

field (right pane).
7. Click Finish    when done.
 
After clicking the “Finish” button, your original EASE   room model is visible in the modeling window. To 
ensure the faces file   imported correctly, a review of key model attributes is in order. See   Checking   Model 
Attributes.
 

Special Note
When you export a faces (.xfc) file from EASE, you have   the option to export double-sided planes as single 
surfaces (preferred   when both materials are identical) or as two surfaces.
It is difficult to tell which method was used during   export unless you check each surface individually, noting 
all doublets   (surfaces on surfaces). In complicated models, this is a very tedious   task.
Use single surfaces as often as possible. If front and   rear sides to a surface contain different materials, it is 
recommended   to separate the two planes by a small amount (0.33', 0.1m) and closing   the gap between sur-
faces using the insert face tool.
 

Checking Model Attributes
After importing a file, check the following to make   sure the file imported correctly:
 l Material database
 l Surfaces tab
 l Loudspeakers tab

 

Material Database

Access the Material database by clicking on the toolbar   icon   located within   the left-hand vertical tool bar. 
Verify that the appropriate material   absorption coefficients imported as anticipated. Make any adjustments   
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to absorption coefficients as needed.
 

Values for the 31 Hz and   63 Hz octaves are derived from the 125 Hz coefficient.
Values for the 8 kHz and   16 kHz octaves are derived from the 4 kHz coefficient.
 

Surfaces Tab
Access this tab within the Details pane. Here you will   find a list of a list of all imported materials and their ori-
ginal names.   Verify that surface types, Audience areas, and reflection characteristics   are appropriate for 
each surface.
 

 

Loudspeakers Tab
Access this tab within the Details pane. Here you will   see a list of all loudspeakers within the model. For 
each loudspeaker,   verify that their 3D location coordinates, aiming information, original   gain level, and sig-
nal delay.
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Room Model Construction

Basic Modeling Concepts
Modeler software includes tools for constructing three dimensional structures. The following will introduce 
the basics of modeling by guiding you through the process of creating a new project, setting preferences, 
and modeling a simple L-shaped room.

Creating a new project
Modeler software uses the project structure to organize your work environment. A project can contain mul-
tiple models. For example, a project might contain models of different rooms in the same building, or a pro-
ject might contain multiple versions of the same room, each with different sound system designs.
Before getting started, you must create a new project and a new model:
1. Launch Modeler software by choosing Start > All Programs > Bose Modeler 6.*.
2. Click on File > New Project.
3. Name the new project “Headquarters” and navigate to an appropriate folder to save the project in, or 

just choose the desktop. Click Save.
4. When prompted by the New Project window to create a new model or open an existing one, choose 

New.

Preferences
Part of creating a new model includes adjusting Preferences. There are two types of Preferences:
Application Preferences are global for the entire application and relate to all models in the project. In gen-
eral, these are preferences you set once.
Model Settings are local to and saved with the model, and typically change as you work through the 
design. Different models in a project can have different model settings.

Adjusting Model Settings
You have the ability to specify how the features will behave. Note that after you create a new project or 
model as you progress along within your design, the Model Settings window opens automatically.
Follow these steps to set the preferences for creating the L-shaped boardroom:
1. If Model Settings is not already displayed: Click Edit > Model Settings. The Model Settings dialog 

box opens with the Drawing/Saving tab selected by default.
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Drawing/Saving tab
 
2. When in the Drawing/Saving tab, make the following changes:

A.  Under Room Attributes (in the top-right corner), place a checkmark next to Snap to Vertex. The 
vertices of new surfaces may now snap to other surfaces in the room model.

B.  Under Room Attributes (in the top-right corner), place a checkmark to enable Room Snap Grid, 
enter 1.0 m in the field. The vertices of each surface will now snap to one-meter subdivisions of the 
grid.

 
The following settings are located in the Drawing/Saving tab:

Units - Selects the unit of measure.
Selection - Determines the types of objects to be selected using the Select tool.
File Contents - Allows you to control what data is saved with your model.
Room Attributes - Selects the options to snap to the nearest Vertex or grid subdivision. Set the 
Room View Grid as a visual aid.
Cluster Attributes - Selects the options to snap to the nearest grid subdivision and angular incre-
ment (for curved surfaces).
Curved Surface Attributes - Defines the angular increment used to draw the curve. At each angu-
lar increment, a new surface is created, so the angular increment dictates how many flat surfaces 
are used to simulate the curved surface.

 
3. Click the Display tab to review display settings:
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The following describes the settings in the Display tab:

Aiming (Check 
the loudspeakers)

Hitpoints - Show or hide the “hitpoint wand”,      which is the red line (or purple 
when selected) indicating      the location at which the loudspeaker is aimed.

Click and drag the sphere at the      end of the wand to aim a loudspeaker in your 
model.
Wireframes - Show or hide the wireframe representation      of the loudspeakers 
in your model.
Identifiers - Show or hide the identifier numbers      displayed at each loud-
speaker in your model.
Format - Select the format of the identifier      from a range of different com-
binations of the following numbers,      for Cluster, Zone, Tier, and Index, separated 
by a period.

Camera (Check  Wireframe - Show or hide the wireframe that represents the camera in the 
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the camera) Model View.

Cluster (Set the 
origin of a cluster)

Origin - Show or hide the cluster origin.
Size - Choose the size of cluster origin from the drop-down list.

Listener (Check 
the listeners)

The Listener check boxes control how listeners are displayed in the model.
Wireframe - Show or hide the wireframe that represent listener locations in the 
model.
Identifiers - Show or hide the identifier numbers displayed at each listener loc-
ation in your model.

RT60 (Set the ori-
gin of the RT60 
source)

The RT60 source represents the location where sound comes from when meas-
uring the reverberant decay curve for the room. The RT60 source is represented 
by a purple sphere in the model, and it should be located near the primary source 
of sound in your room model.
Location - Show or hide the purple sphere that represents the RT60 source.
Size - Choose the size of the RT60 source from the drop-down list.

Map (Check the 
coverage maps)

Hide Maps - When checked, all coverage maps are hidden and cannot be viewed. 
This is useful in situations such as a client presentation when you might not want 
coverage maps to be visible.
Custom areas - Allows you to quickly map a section of a surface ( or parts of 
multiple surfaces) to evaluate coverage for the selected area.
Sample Smoothing - When checked, the gradient between areas of a different 
coverage is smoothed to provide a more continuous looking coverage map.
Sample fill - Uncheck to show only the coverage mesh.
Translucent - Displays a softer translucent color for coverage map views.

Drawing Aids 
(Check which 
drawing aids are 
displayed)

Rulers or Axis Indicators. Axis Indicators display the orientation of the three 
major axes.
Rulers - Rulers appear on the top and left edges of the Model View in Plan View, 
Elevation View, and Section View to outline the Room View Grid. Use the check 
box to toggle the rulers between show and hide.
Axis Indicator - Appears in the lower left corner of the Model View and displays 
the orientation of the three major axes. The axis pointers are highlighted accord-
ing to the selected constraint plane. This a useful tool for orienting yourself in 
three-dimensional space as well as when using constraint planes.

Surface Type Check      which surface types are to be displayed. Surfaces are not      removed from 
the model and will still be considered in all      calculations, but are no longer visible 
in the model.

Surface Check Vertex to provide red 3D crosshairs on surface vertices.
Vertex - Show or hide the red markers that highlight each vertex in the model.

 
4. When finished, click OK.

The Name   Model window will automatically appear.
5. Name your new model, and click    OK.

Name   Model window
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Adjusting Application Preferences
Direct keys allow you to access certain tools and functions   in Modeler software with a single keystroke. Fol-
low these steps to turn   on direct keys in the Application Preferences:
1. Click Edit > Application Preferences    (or Ctrl+E). The Application Preferences    dialog box opens 

with the General    tab selected by default.
 

Application Preferences,   General tab
 
2. Under Accelerator    Keys (in the top-right corner), place a checkmark next to Direct to turn on Direct 

Keys on    the keyboard.
Note: With Direct keys on, you may not be able      to enter text in certain situations. If you find 

you are unable      to enter text into a field, turn off direct keys in the General      tab of the 
Application Preferences dialog box by removing      the checkmark next to Direct or use the 
'Edit Cells' function      to enter text.

3. Click OK to close the Application    Preferences dialog box.
Note: As soon as you click on OK, the current      Application Settings are applied to all models.

Working with the Material   Database
Before creating the room model,   it is recommended to assemble a list of materials that will be used to   build 
the room.

Opening the Material Database

Click the Material   Database button in the Database   toolbar (or press Ctrl + M):

Material Database button
 
The Material Database opens:
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You create a list of materials   that you will use to build your model in the Material Database. You can   select, 
modify, add, and delete materials, and save your own materials   list. Total   Absorption and Total Reflec-
tion simulation   materials are displayed in the default Material list. You should always   create a list of mater-
ials that match the actual room construction materials   as closely as possible.
Each material file contains   sound absorption coefficient data for 10 different octave bands, with   center fre-
quencies from 31 Hz to 16 kHz.
 

Creating a materials list

The list of folders on the left side of the window is   similar to Windows Explorer. To create a list of materials 
for your project,   drag the material from a folder on the left, to the Material list on the   right side of the win-
dow.
1. Click the plus (+) sign    next to the Floors folder to open it, then click on Carpet – heavy    on concrete and 

drag it into the right side of the window. The material    and its absorption coefficient information is added 
to the Material    list.
Tip:  Materials are listed in alphabetical order      inside each folder.

2. Add the following additional    materials to the Material list:
A.  From the Ceilings     Reflective folder, add Plaster on     Lath 1" thick.
B.  From the Walls Reflective folder, add Brick-Bare.

3. Close the Material Database    by clicking OK. The three    materials that you added will now be available 
when you build the    model.

Saving your project

Now that you have set your preferences and compiled   a Material list, you should save your project.
Click File > Save Project to save the project.

Building   the L-shaped room
To help you understand the basics of modeling, this   section will show you how to build the following L-shaped 
room.
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L-shaped room model

Modeler   Coordinate System

The coordinate system in Modeler   software is a standard Cartesian coordinate system in three dimensions:   X 
(red axis), Y (green axis) and Z (blue axis). The same colors are shown   in the axis indicator in the lower left-
hand corner of theModel View.

Axis indicator
 

Cartesian coordinate   system
 
InPlan   View, the Z axis is oriented straight   up toward your point of view, so it is not visible.
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Creating   the floor surface

The first step in building the model is to create the   floor surface.
Follow these steps to create the L-shaped floor:
1. Select the Draw Polygonal    Surface tool in the Draw toolbar.

Draw Polygonal Surface tool
 

This   is the surface you will create: 

The   floor surface
 
2. Move    the drawing crosshairs to x: - 10.0  y: 10.0     z: 0.0, then click.
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Note: Before you click to      begin drawing a surface, the coordinates at the cursor display      its loc-
ation relative to the origin.

Before   clicking
 

Once   you click to start drawing a shape, the coordinates at the cursor reset   to 0and display distances rel-
ative to your last   click. At each click, the coordinates reset to x: 0.0    y: 0.0  z: 0.0.

After   clicking
 

3. Move    the cross-hair cursor and click at the following locations to outline    the floor surface as shown in 
Step 1. Note that at each click, the    coordinates at the mouse pointer reset to x:    0.0  y: 0.0  z: 0.0.
A.  Click at x: 0.0 y:-20.0
B.  Click at x: 20.0 y: 0.0
C.  Click at x: 0.0 y: 10.0
D.  Click at x: -10.0 y: 0.0 (at the origin)
E.  Click at x: 0.0 y: 10.0
F.  Click at x: -10.0 y: 0.0 (which is the red dot indicating the starting     point)
Tip: If you make a mistake while      creating a shape, press Esc (or Shift + Esc) to cancel your      work.
 
When you complete the shape,   the Z-Coordinate bar opens at the top of the window. This is where you   
define the height for each corner vertex of your shape.
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Z-coordinates
 

4. Enter    the following properties for this shape:
A.  Leave 0 m as the surface height to establish the     floor, or ground level at Z = 0.
B.  Click Next five times, leaving the same properties for     each vertex.
C.  Click Finish to complete the shape. The Surface     Properties dialogue will open.

 
5. When you complete entering    the z-coordinates, the Surface Properties window opens at the top    of the 

Model Window. This is where you assign acoustical properties    to the shape by entering information such 
as material, surface type,    audience and reflection.
 

Shape Properties bar
 
Enter the following properties for this surface:

Note: It is recommended that      you select the appropriate material type when you enter prop-
erties      for the first vertex. Although you could assign a different      material type at each 
vertex of your shape, Modeler software      will use the material chosen at the final vertex 
as the material      for the entire surface.

A.  Select Carpet - heavy on concrete as the surface material.
B.  Select Flooras the surface type.
C.  Select Unoccupied     and Specular, with this     being a large smooth area.

 
6. Click    the Savebutton to save your work.

Save button
 

Creating   the walls

Next, you will create walls   on each side of the floor surface.
 
To create the first wall:
1. Select    theDraw    Wall Surfacetool in theDrawtoolbar.
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Draw Wall Surface tool
 

This   is the first wall you will draw:

First   wall
 
2. Move    the cross-hair    cursor tox: - 10.0  y: 10.0     z: 0.0and click.
3. Move    the cross-hair cursor tox: 10.0     y: 0.0and click. 

TheZ-coordinatebar    opens.

Z-coordinatebar
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4. Enter    the following data for this wall surface:
A.  For the first bottom corner, leave 0 m in the Bottom field because the bottom of the wall meets 

the floor at zero.
B.  For the second bottom corner, click Next and leave the same values for the second bottom 

corner.
C.  For the first top corner, click Next, leave 3 m in the Top field, and leave the other values the 

same.
D.  For the second top corner, click Next, leave the values the same and click Finish. The Surface 

Properties window will open.
 
5. In    the Surface Properties window, make the following adjustments:

A.  Select Brick - Bareas the surface material.
B.  Leave    the surface type as Wall1.
C.  Leave Unoccupied    and Specular as is.
The   first wall is created in your model.
 

6. Click    the Save button to save your work, or press Ctrl + S.
 
To create the second wall surface:
1. Make    sureDraw    Wall Surfacetool is still selected.

This   is the second wall you will draw:

Second   wall
 
2. Move    the cross-hair cursor to x: 0.0     y: 10.0  z: 0.0 and    click.
3. Move    the cross-hair cursor to x: 0.0     y: - 10.0 and    click. 

TheZ-coordinatesbar opens.
Confirm   that the following values are entered (you should not have to change any   values):

First bottom corner Leave 0 m in the Bottom field.

Second bottom corner Click Next and leave      the same values for the second bottom corner.

First top corner Click Next, leave3 m in the Top field      and leave the other values the same.

Second top corner Click Next, leave the      values the same and click Finish.  
The      Surface Properties window will open.

 
A.  Leave Brick - Bare as the surface material.
B.  Leave the surface type as Wall1.
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C.  Leave Unoccupied and Specular as is.
 
The   second wall is created in your model.
 
4. Click    theSavebutton to save your work.

You   now have created two of the six walls for the room model. To ensure that   everything lines up, look 
at the model from a different perspective.

5. Click    on theRotate    Viewtool, and then click and drag    in theModel View to view your model    from dif-
ferent perspectives.

Rotate View tool
 
At   this point, the model should look like this:

Model   with two walls in Rotate View
 

The   remaining walls will be built in the same manner as the first two, and   will have the same material 
and surface type properties.

 
To build the third wall in the L-shaped room:
1. Switch    back to Plan View by clicking the Plan    View button, or use the direct key    shortcut: press the H 

key.Plan View

Plan View button
 
2. Select    theDraw    Wall Surfacetool.

This   is the third wall you will draw:
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Third   wall
 
3. Move    the cross-hair cursor to the origin,x: 0.0     y: 0.0  z: 0.0,    and click.
4. Move    the cross-hair cursor to x: 10.0     y: 0.0  z: 0.0 and    click. 

The Z-coordinates bar opens.
 
Confirm   that the following values are entered (you should not have to change any   values):

First bottom corner Leave 0 m in the Bottom field.

Second bottom corner Click Next and leave      the same values for the second bottom corner.

First top corner Click Next, leave3 m in the Top field      and leave the other values the same.

Second top corner Click Next, leave the      values the same and click Finish.  
The      Surface Properties window will open.

 
A.  Leave Brick - Bare as the surface material.
B.  Leave    the surface type asWall1.
C.  Leave Unoccupied    and Specular as is.
 
The   third wall is created in your model.
 

 5.  Click    the Save button to save your work.
 

To build the fourth wall in the L-shaped room:
1. Make    sure Draw    Wall Surface tool is still selected.

This   is the fourth wall you will draw:
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Fourth   wall
 

2. Move the cross-hair    cursor to x: 10.0     y: 0.0  z: 0.0,and    click.
3. Move    the cross-hair cursor to x: 0.0     y: - 10.0 and click.    TheZ-coordinatesbar    opens. 

Leave   all the same data for these walls as for the first three.  Notice   that you will only be required to 
click on the Nextbutton 3 times and then the Finish button   as Modeler software defaults all setting 
based on the last wall surface   you drew.

4. Click    the Save button to save your work.
 

To build the fifth wall in the L-shaped room:
1. Make    sureDraw    Wall Surfacetool is still selected.

This   is the fifth wall you will draw:

Fifth   wall
2. Move    the cross-hair cursor to x:     10.0  y: - 10.0  z: 0.0 and click.
3. Move    the cross-hair cursor to x: - 20.0y: 0.0 and    click. TheZ-coordinatesbar opens.

Leave   all the same data for these walls as for the first four. Notice that you   will only be required to click 
on the Next button three times and then the Finish button as Modeler software defaults all setting   
based on the last wall surface you drew.

4. Click    the Save button to save your work.
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To build   the sixth and final wall:
The sixth wall connects the   fifth wall with the first wall that you drew.
 

Sixth   wall
 

5. Use    theDraw    Wall Surfacetool to define the position    of the wall, then leave the same wall properties 
as the other walls.

6. When    you are finished, view the model in Rotate View. Try using the direct    key shortcut for theRotate 
Viewtool: press theDkey.
The   room will look like the following figure:

Model   with completed walls
 

Using   the Extrude Walls tool
In this section, you will   learn how to model the same structure using theExtrude Wallstool.   The process 
that you used in the previous section to build the floor and   walls of the L-shaped room is an important lesson 
in basic modeling. You   will now learn how to quickly and easily achieve the same results. Follow   these steps 
to build the walls and ceiling of the L-shaped room using   theExtrude   Wallstool:
1. Delete    the walls that you previously created: Select them in the Surfaces tab in the Detail window, 

then press the Delete key:
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Detail window Surfaces tab
 
After   deleting the walls, your model should only contain the floor surface.
 

2. Select    the floor surface by clicking on it in the Surfaces tab in theDetail    View. The surface is highlighted 
in blue    in the Modeling View, indicating that it is selected:

Floor   surface, selected
 

3. Select    the Extrude    Walls tool in the Extrusions toolbar.
 

Extrude Walls tool
 
The Extrude   Walls dialog box opens:

Extrude Walls dialog   box
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4. The Extrude Walls tool adds walls to the outer perimeter of    the selected surface, with the option to 
also add a ceiling. You can    specify how high you want the walls to be in the Height field    in the Extrude    
Walls dialog box. Because the L-shaped    room model has 3 meter walls, leave the default value of 3m 
in the Height field.

5. In    the Surface    Material drop-down menu, leave Brick - Bare as the surface    material for the walls. 
Leave the default Surface Type (Wall1).

6. To    add a ceiling, place a check mark next to Add    Ceiling.

Adding   a ceiling
 

7. Select Plaster on Lath    1" thick as the surface material,    and leave Ceiling1 as the surface type.
8. Click OK. 

The walls and ceiling are extruded from the    floor surface.
9. Use    the Rotate View tool to look at the model in perspective.

The finished room model looks   like this:

Finished   room model
 

10. Click    the Save button to save your work.
Note: When using the Extruded tool, the Reflection and Audience properties must be set manu-

ally by adjusting the properties of each surface in the Surface tab.

Close the model   by clicking on the X in the upper right-hand corner of the Modeling window. Close the pro-
ject by choosing File>Close   Project.
You are now familiar with   how to build a basic model, including setting preferences and assembling   a mater-
ial list using the Materials Database.
 

Advanced Modeling Concepts
This section goes beyond the basics and presents more   advanced modeling concepts. Using the First Street 
Church project, you   will be guided through the process of creating the last two missing surfaces   of a nearly 
complete model of the church. Then you will learn to set surface   colors and view the structure in Camera 
View.

Opening   a model
1. Follow these steps to open the nearly complete church   model:
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2. Click File > Open Project...
3. In the Look    in: drop-down menu, click on the desktop.
4. Open the Tutorial    folder, then open the First Street Church    folder.
5. Open the file named First Street Church.pjt
6. In the Project    View, double-click on the Design 3 model.
7. After the Design    3 model opens, close the Project    window.

The Design 3 model looks   like this:

Design 3 model
 
8. Use the Rotate    View tool on the View toolbar    to look at the model from different perspectives.

Rotate   View tool
 
Notice that there are two missing surfaces in the model   shown in the following figure; one wall section 
and the conical ceiling   surface over the rounded alcove at the end of the church. These are the   final two 
surfaces that you will create to complete the church model.

Missing surfaces   in the model
 

Creating   a missing surface
The Insert Face   tool can be used to create a surface by defining the outer boundaries   of the surface. Follow 
these steps to create the missing square wall section   using the Insert Face tool:
1. Rotate the view using the    Rotate View tool until it matches the    following figure. Define the shape of the 

new surface by clicking    on the vertices that outline the missing wall section. Notice that    a vertex will 
highlight in green when the crosshair cursor is moved    over it.
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Outlining the missing   surface with the Insert Face tool
 
2. Select the Insert    Face tool in the Draw toolbar.

Insert Face tool
 
When using the Insert   Face tool, the starting point is highlighted red after clicking,   and each subsequent 
click is highlighted with a black dot. The shape is   finished when you click on the red starting point.
Note: After three vertices   have been placed, additional vertices can only be created at loc-

ations   within the plane defined by the first three vertices.

Tip: If you make      a mistake while creating a shape, press Esc  (or Shift      + Esc) to cancel your work.
 
3. When you complete the shape,    the Insert Face properties    box opens. Here you define the material and 

surface type for the new    surface. Choose Brick - Bare    for the material, and Wall1    for the surface type. 
Leave Audience and Reflection as is.

Insert   Face properties box
 
4. Click OK.    The new surface is created in the model.
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New wall surface
 
5. Click    the Save button to save your work.
 

Creating   a conical ceiling surface
To finish the model, follow these steps to create the   conical ceiling surface:
1. Switch to Plan View by clicking    on the Plan View button in the View toolbar. You will be creating a ceiling    

surface on the larger rounded alcove of the church (in the positive    X direction).
2. Select the Draw    Conical Surfaces tool.

Draw Conical Surfaces   tool, with wing menu
 

3. Define the shape as follows:

Creating the conical   ceiling surface
 

A.  Click at x: 12.0      y: 0.0  z: 0.0.
B.  Move the cursor in the positive Y direction     until the radius is 6 m and     click.
C.  Rotate the cursor clockwise until the angle     is -180.0° and click.
D.  Move the cross-hair in towards your starting     point until the second radius is equal to 0 m     and click

4. When you finish the surface,    the Z-coordinates    bar appears at the top of the window. Enter the following 
properties    for this shape:
A.  Enter 4 m for     Elevation 1 (Z1), since the bottom     of this ceiling meets the rounded wall at Z1 = 4 

meters.

Z-coordinates bar   (Z1)
 

B.  Click Next     and set Elevation 2 (Z2) to 11 m to place the point of the conical     roof section just below 
the peak of the church ceiling.

Z-coordinates bar   (Z2)
 

C.  Click Finish.
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5. In the Surface Properties    window, make the following adjustments:

A.  Choose Mineral Board     5/8" ceiling tile as the surface material.
B.  Select Ceiling     2 as the surface type.
C.  Leave Unoccupied     and Specular as is.
D.  Click OK.    The conical ceiling is created over the church alcove.
 

Surface   Properties window
 
6. Click the Save    button to save your work.
 

Creating   a curved surface
Curved surfaces in Modeler software are simulated as   numerous flat surfaces joined together to form a 
curve. The Curved Surfaces Attributes allow   you to specify the angular increment that is used to draw the 
curve. At   each angular increment, a new surface is created, so the angular increment   dictates how many flat 
surfaces are used to approximate the curved surface.
Follow these steps to set the preferences for the curved   surface:
 
1. Click Edit    > Model Settings (or simply    click Ctrl+R).    The Model Settings dialog box opens with    the Draw-

ing/Saving tab selected by default.
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Drawing/Saving   tab
 
2. Under Curved    Surface Attributes (bottom-right corner), enter a value of    30° for the Angular    Increment.

Tip: Rather than going      to the Model Settings, simply click on the Wing Menu icon  next      to the Draw Con-
ical Surfaces tool, and enter a value of 30°.
The conical ceiling should   look like this:

New conical ceiling   surface
 
Examples   of different angular increments:
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A cylindrical wall   created with an angular increment of 30°

A similar cylindrical   wall created with an angular increment of 5°.
 
You now have completed the church structure. For an   in-depth workshop on creating this church model from 
the beginning, please   see Modeling Workshop.
 

Using   Camera View
The Camera View feature   in Modeler software allows you to view the model as though you are looking   
through a camera that can be placed anywhere inside or outside of the   model. 
Camera View   is useful for:
 l Gaining perspective of your model.
 l Delivering a presentations.
 l Ensuring that your model is closed and complete.

 
To activate, select the Camera   View tool in the View toolbar.

Camera   View tool
 
The Model   View changes to a view of the model through the camera inside the   church. The default camera 
position is at the origin (x: 0.0    y: 0.0  z: 0.0) facing in the positive Y direction,   at a height of Z = 1.5 m.
 
It is possible to move the camera into other positions   using the following methods:

Keyboard      + mouse 
scroll-wheel com-
mands:

If you have a mouse with a scroll-wheel,      you can use your keyboard 
and mouse to manipulate the camera.

The      Properties tab: Click the      Properties tab while in Camera View. Adjust the different prop-
erties      and notice the result in the Model      View.
Note: In the Properties Tab you can adjust the camera loc-
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ation, snap the camera to a listener, or add a listener 
at the camera location. You can also adjust the light-
ing and coloring.

Keyboard      arrow com-
mands:

Use the 4 arrows on      your keyboard to move the camera in the X - Y 
plane.

Select      tool: Exit      Camera View and select the camera with the Select tool      in the 
Model View. You can rotate and drag the camera to reposition      it, then re-
enter Camera View to view the model.

 
The following chart outlines how to control the camera   using a scroll-wheel mouse. You must place your 
mouse over the Modeling   window for these commands to work.

Move      forward or back-
ward:

Roll the scroll-wheel      on your mouse: Up moves forward, down moves 
backward.

Adjust      camera yaw 
(rotation):

Hold      Shift, then roll the scroll-wheel      on your mouse: Up rotates left, 
down rotates right.

Adjust      camera pitch: Press      Ctrl, then roll the scroll-wheel      on your mouse to adjust the cam-
era’s pitch: Up rotates the      camera upwards and down rotates the cam-
era downwards.

Adjust      lens focal 
length (zoom):

Press      Shift + Ctrl then roll the scroll-wheel      on your mouse to adjust 
the camera’s focal length: Up zooms      in, down zooms out.

Move      along the Z-axis: Left-click      on your mouse and hold: Roll the scroll-wheel forward to 
move      up, roll the scroll-wheel backward to move down.

 

Setting   surface colors
Modeler software provides the ability to add color to   the surfaces in your model in order to represent the 
actual colors of   the materials used in the room. The colors will then be displayed in the   camera view. Each 
surface type in Modeler software is assigned the color   white by default. You can assign a color to each mater-
ial type, and all   surfaces with that material type will display in the selected color in   Camera View.
Follow these steps to assign new colors to surfaces:
 
1. Select the Surfaces    tab in the Detail    View, then click on the Material    column header to sort by material 

name.

Surfaces   tab
 
2. Scroll to the right and double-click    a cell in the Color column for any of    the Brick - Bare surfaces. The 

Windows    Color Picker opens:
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Color dialog box
 
A.  Choose a shade of dark red and the selected    color appears in the Color window.
B.  Click OK and the    cells in the color column turn dark red along with all Brick    - Bare surfaces.

Note: If you know the Red/Green/Blue color number, simply enter them.

 
3. Repeat the same process for    each surface material, and assign the following colors:

Carpet      - heavy on concrete: Dark      gray

Concrete      Block - Painted: Black

Mineral      Board 5/8’ ceiling tile: Off white

Pews      - Wooden: Brown

 
4. Click the Save    button to save your work.
 
After setting surface colors,   the view from the camera in the positive X direction looks like the following   fig-
ure (color shades may look different on your monitor). 

Camera view with   colors
 

Working With Vertices
You may need to adjust the location or shape of a surface   after it has been created. Use the Select   tool to 
move an entire surface or to move a single vertex.
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Select   tool
 
This section covers the mechanisms that Modeler software   uses to help you work with a single vertex on a 
surface. These mechanisms   apply to moving vertices and snapping vertices to other objects, and creating   
and deleting vertices on a surface.

Vertex   proximity indicator
When using any of the drawing or extrusion tools, the   vertex indicator will turn green when the mouse is 
within the Snap to   Vertex distance.
This function only works when the room model is displayed   in an orthogonal view, or when the vertex has an 
elevation of zero.

Snapping Vertices
To move a vertex on a surface, select it with the Select tool until it highlights in bright red.   You can now drag 
this vertex with the cursor to change the shape of the   surface. You will only be able to drag the vertex within 
the selected   constraint plane, so choose a constraint plane that will allow you to   move the vertex to the 
desired location. For example, if the YZ constraint   plane is selected, you will only be able to move the vertex 
in the Y and   Z dimensions.

A selected vertex
 
Note: In a surface with more than three     vertices, all vertices must be in the same plane. You 

will not     be able to move a vertex out of the plane of the surface in this     situation. 

A     vertex that is unable to be moved
 
Modeler software has a Snap To Vertex feature to help   you line up surfaces in your model. This feature 
causes a vertex that   you are moving to snap to other vertices, edges and planes in the model,   just like two 
magnets might snap together.
 
Note: The Snap     To Vertex feature is enabled in the Drawing/Saving tab of the Model Settings     

dialog box.

When you drag a vertex, it will change to a different   color depending on what it snaps to:
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Color Snap to

Vertex     highlights green: The     vertex is snapped to another vertex.

Vertex     highlights blue: The     vertex is snapped to an edge.

Vertex     highlights yellow: The     vertex is snapped to the face of a plane.

Vertex     highlights purple: The     vertex is snapped to the intersection of two planes.*

*The intersection   of two planes refers to the point at which the edge of one plane passes   through another.
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Adding   and deleting vertices
You can add a vertex to a surface by holding down the   Ctrl key while clicking on a point on the   edge of the 
surface. The new vertex can then be dragged to change the   shape of the surface. This is useful, for example, 
when lining up and   matching surfaces to close a room model, or to join a flat edge to a curved   surface. 
To add a vertex:
1. Select the surface.

2. While holding down the Ctrl key, click on the edge of the surface.

3. Drag the new vertex to change the shape of the surface.
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You also can delete a vertex by holding down Ctrl   and clicking on the vertex. A surface must have a min-
imum of 3 vertices,   so you will not be able to delete a vertex if the shape only has three   vertices.
To add vertices to join a flat edge to a curved surface:
1. Select the surface.

2. Snap two corners to      the curved wall

3. Ctrl      + click to add a vertex, then snap it to a corner of the curved      wall

4. Repeat and continue      around the perimeter as desired.

- 151 -



Modeler®  Sound System Software 6.8 User's Guide

 

Working With Constraint Planes
This section covers constraint planes and how they are   used in Modeler software. The coordinate system in 
Modeler software is   a standard Cartesian coordinate system in three dimensions: X (red axis),   Y 
(green axis) and Z (blue axis).
 

Cartesian coordinate system
 
The three major axes and their respective colors are   also illustrated by the axis indicator in the lower left-
hand corner of   the Model View:

Axis indicator
 
You can use the axis indicator to orient yourself in   the three dimensions.
 
Tip:      If you cannot see the axis indicator, open the Model Settings     dialog box, by choosing Edit > Model Set-
tings, or by pressing     Ctrl+R. Click on the Display tab, and place a check mark next to     Axis Indicator 
under Drawing Aids (located on the bottom middle     area of the tab).
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Display tab in   Model Settings (Drawing Aids section)
 

XY, YZ and XZ   planes
There are three inherent planes in the Cartesian coordinate   system: the XY plane, the YZ plane and the XZ 
plane. The XY plane is defined   by the X and Y axes.  For example, the surface in the following figure   resides 
entirely within the XY plane. All points in this plane have the   same Z coordinate:

Example of a surface within the XY plane
 
The axis indicator can be used to help you visualize   the XY plane. Picture a surface that connects the X and Y 
pointers on   the axis indicator:
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Visualizing a surface in the XY plane
 
The YZ plane is defined by the Y and Z axes as illustrated   in the following example. All points in this surface 
have the same X coordinate:

Example of a surface within the YZ plane
 
The axis indicator can be used to help you visualize   the YZ plane: picture a surface that connects the Y and Z 
pointers on   the axis indicator:

Visualizing a surface in the YZ plane
 
The XZ plane is defined by the X and Z axes. All points   in this surface have the same Y coordinate: 
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Example of a surface within the XZ plane
 
The axis indicator can be used to help you visualize   the XZ plane: picture a surface that connects the X and Z 
pointers on   the axis indicator:

Visualizing a surface in the XZ plane
 
A surface that is in the XY, YZ or XZ plane does not   necessarily pass through the origin. These terms 
describe any plane that   is parallel to those shown in the previous figures. For example, both   of the selected 
surfaces in the following example can be described as   being in the XZ plane: 

Example of two surfaces in the XZ plane
 

Selecting   constraint planes
The Constraint Plane   buttons in the View toolbar allow   you to specify which of these planes you would like 
to work in:
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Constraint   Plane buttons
 
Use these buttons when you draw or move surfaces and   objects in Modeler software. When you select one of 
the constraint plane   buttons, your movement is constrained   to the chosen plane. For example, when you 
select the XY constraint plane   and create a rectangular surface, it will be drawn in the XY plane. Likewise,   
any surface that you move will only move in the X and Y dimensions.
 
Tip:  When you select a     constraint plane, the corresponding axis pointers are highlighted     in the axis indicator 
to help you visualize which plane you are     working in:

 
Constraint planes are most often used when viewing your   model at an angle, such as in an isometric view.
 
Tip:  When you are in Plan View, Elevation     View or Section View, the     constraint planes XY, YZ, and XZ 
(respectively) are selected by     default. Note that the constraint plane button is automatically     selected when 
you are in these views.
 

Creating   surfaces using constraint planes
Constraint planes allow you to specify the location   of a surface or object in two of the three dimensions (the 
two dimensions   that define the constraint plane). When you are drawing a new surface,   you can specify 
measurements in the third dimension using the Shape   Properties bar.
For example, when you create a floor surface in the   XY constraint plane, you first outline the shape of the 
polygon in the   X and Y dimensions using the Draw Polygonal Surface   tool and then specify the third dimen-
sion using the Shape   Properties bar:

Drawing a floor surface in the XY constraint   plane
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Notice that the outline of the surface is drawn at Z=0   by default. You will need to specify the location of the 
surface in the   third (Z) dimension. This is done in the Z-coordinates   bar, which opens when you complete the 
shape:
 

Specifying the Z coordinate in the Z-coordinates   bar
 
Enter the Z coordinate for each vertex to locate the   shape in the Z dimension. For example, you may want 
the floor surface   to exist at Z=8. Enter 8 for the Z coordinate at each vertex, and the   completed surface is 
located 8 meters in the positive Z direction:

The surface created at Z=8
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Although this example involved the XY constraint plane,   the same method is used when creating new rect-
angular and polygonal surfaces   in the YZ and XZ constraint planes:

Constraint plane Drawing dimensions Third dimension specified in Z coordinates bar

XY X and Y Z

YZ Y and Z X

XZ X and Z Y

 
For cylindrical, conical, and spherical surfaces you   must enter values for two measurements in the third 
dimension in the Z-coordinates bar: Z1   and Z2. These values adhere to the same principles regarding con-
straint   plane and the third dimension.
 
Tip:  The axis indicator     is useful in visualizing the relationship between constraint plane,     drawing dimensions 
and the third undefined dimension. When you     select a constraint plane, two axis pointers will highlight in     
color to show you the plane that you will draw the shape in. The     grayed out pointer indicates the third dimen-
sion that you define     in the Shape Properties bar:

 

Wall surfaces
Wall surfaces are created perpendicular to the constraint   plane in Modeler software. The same principles 
regarding constraint plane   and the third dimension apply to creating wall surfaces, although you   will almost 
always create walls in the XY constraint plane, in Plan   View. Modeler software is designed to treat walls as 
though they   extrude from the XY plane. Although you could create walls in a different   constraint plane, it is 
easier to use the Draw Rectangular   Surface tool in these cases.

A   method for creating surfaces using constraint planes
When you create a surface in Modeler software, you should   follow three general steps:
1. Determine the plane in which    to create the surface.
2. Create the surface.
3. Specify the location of the    surface in the third dimension.
 
These three steps correspond to the following actions   in Modeler software:
1. Determine the plane in which    the surface should be created:

View your model in perspective   and use the axis indicator to visualize which plane the new surface 
should   exist in. Select the corresponding constraint plane button.
OR
Use Plan   View, Elevation View, or Section   View which automatically selects a constraint plane.

2. Create the surface:
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Use the drawing tools such   as Draw Rectangular Surface or   Draw Cylindrical Surface, then   draw 
the surface in the Model View.

3. Specify the location of the    surface in the third dimension:
Once the surface is completed,   use the Z-coordinates   bar to indicate the surface location in the third 
dimension.

 

Bent   surfaces
A surface in Modeler software is defined by a minimum   of three vertices. For all surfaces, Modeler software 
requires that all   of its vertices lie in the same plane. If one vertex exists out of the   plane of the others, the 
result is a condition known as a bent plane.   Modeler software cannot draw bent planes, so it will un-bend the 
plane   and highlight the surface pink to indicate that it has been modified.
The bottom line is that   you will only see bent planes when you import a room model that has   bent planes.
For example, a Mac Modeler software file might have   selected bent surfaces before import. Modeler soft-
ware will un-bend these   surfaces upon import and highlight them pink to indicate that they have   been mod-
ified, as shown in the following figure:

Imported model with modified planes highlighted   in pink
 
To remove a modified surface, delete the surface and   then reinsert a new, non-bent surface. Often you will 
have to create two   or more triangular surfaces to replace the bent surface, as illustrated   in the following fig-
ures:

Deleting the bent surface
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Creating two new triangular surfaces
 

Finished surfaces
 
Tip:  Triangular surfaces     cannot be bent because three vertices always lie in the same plane.
 

Room Acoustic Predictions
All   of the predictions within the Modeler software are affected by certain   physical acoustic properties.  These 
properties are defined   within the Acoustics Tab.  It is recommended that you review   the settings within the 
Acoustics Tab before you take advantage of the   powerful acoustic simulation capabilities of Modeler soft-
ware.
This   section provides an overview of the functions within the Acoustics Tab   and their impact on the sound sys-
tem design.  The Acoustics   Tab, shown below, contains two primary sets of functions, acoustic prediction   
parameters, and system design parameters.

Acoustic Design Parameters
The properties   of Temperature, Humidity, Occupancy and RT60 directly affect the acoustic   characteristics of 
the model.  Ideally, these parameters are   based upon measurements made within the room, and used to 
match the acoustic   signature of the model to that of the real room.
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Acoustics   tab
 
Temperature - describes   the temperature used for all predictions.  If you are using   a  measured rever-
beration time this item should be set to the temperature   measured in the room at the time reverberation 
time measurements were   made.  Otherwise, set the temperature to a representative value   for the venue.
The   temperature value is correlated to the speed of sound in air.  See   the following chart for an illustration 
of how temperature affects the   speed of sound.

The   influence of temperature on the speed of sound
 
Humidity - describes   the relative humidity used for all predictions.  If you are   using a  measured rever-
beration time this item should be set to the relative   humidity measured in the room at the time rever-
beration time measurements   were made.  Otherwise, set the humidity to a representative   value for the 
venue.
The   humidity value directly affects the amount of high frequency air absorption   you can expect to see in 
predictions.  See the following chart   for an illustration of how the relative humidity affects the air absorption   
of high frequency energy.
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The   influence of humidity on the absorption of air
 
Occupancy - describes   the amount of people within the room, and is limited to those surfaces   identified as 
“Seating” or "Floor," and may be defined by either   entering a total quantity of audience members, or by 
using a calculation   to determine the percentage occupancy.
House Curve -   defines a target equalization curve, and can be used to speed   the process of system equal-
ization.
RT60 - is used to match the measured   and predicted reverberation times of the room model.  Select   the 
Match… function to launch the   RT60 matching Design Assistant.
Background   Noise - is used   to describe the level and spectrum of any background, or ambient, 
noise.  Background   Noise is displayed within the System SPL tab for reference, and directly   impacts the 
speech intelligibility of the system.

Acoustics   tab - Background Noise setting
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Matching Predicted   and Measured Reverberation Times
The reverberation   time of the room has a significant impact on predictions and on acoustic   performance in a 
real space. Because it is difficult to match the materials   of the surfaces in the model with those in the real 
construction, there   often can be discrepancies between the predicted reverberation times and   those meas-
ured in the room.
The RT60 matching   Design Assistant within the Modeler software helps match the measured   and predicted 
reverberation times by modifying the absorption coefficients   of materials, effectively extending the mater-
ials database as needed.
NOTE:  Before   beginning the RT60 matching process you should first make sure that the   RT60 source is 
placed within the model at the same location that was used   to excite the reverberant field when the RT60 
measurements were made.
TIP:  Before matching   the reverberation times, the following is recommended:
 l Save the    room model file.
 l Delete any    unused materials that are in the materials database.
 l Use the Save    As... function to create a new version of the room model file. This    will become your 
“matched” room model file.

 
1. Open the modified "Design 3.mdr" model (with closed openings) from the "Advanced Modeling Concepts" 

section.
2. Click on the Match    button in the RT60 section.

RT60 Match   button
 
The following window opens:
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RT60 Data   window
 

This graph shows the measured   and the predicted reverberation times. Currently the two are almost 
identical.

 
3. Enter the measured reverberation    times. Set the Bandwidth to    1 octave band and enter the    following 

values seen below: 
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Measured and Predicted   Reverberation times
 
Note: If the measured and predicted reverberation times differ by more than 0.5 seconds, or 

so, we recommend that you revisit the choices you made in material selections for the 
various room surfaces.

4. Click on Next.
The following window opens:

Material Data window
 
This window shows only the   materials currently used in this model. We are very confident that other cer-
tain materials   used in this model  are accurate. For example,   you may have included an absorber that 
has been measured by a reputable   laboratory and the real mounting is equivalent to the measurement.
The algorithm allows you   to prevent certain materials from being modified. We refer to this as   “locking” 
the material. You can lock either entire   materials or selected frequency bands.
In this example, we assume   that the absorption coefficients of Brick - Bare   are accurate because they 
have been measured by a laboratory.

5. Select the box to the    left of Brick - Bare.
The entire material is selected,   indicating that it will not be modified: 
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Selected material
 

6. Click Next.    
The program will automatically adjust absorption coefficients.

 
Note: The algorithm assumes that the reverberation is measured     with the room empty.     If you 

had specified a number of people in the model when entering     the wizard, Modeler would 
set it to 0 and post a warning.

 
Once the matching is completed,   the following window will appear:
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RT60 Match
 
The first tab shows the measured   and predicted reverberation times. In this case, you can see that the   
algorithm closely matched (to within +/- 0.05 s), measured with predicted   reverberation times.

 
Note: It may be that there still are differences between measured and predicted reverberation 

time. This tells you that the differences were initially too large to overcome without 
making unrealistically large changes to absorption coefficients. If this happens, please 
click the Cancel button and review you material selections.

 
7. Click on the second tab, and    the data will appear in tabular format:
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RT60 Match in tabular   format
 

8. Click on the Materials    tab for list of materials.
The following window will   appear:
 

RT60 Match, Materials   tab
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Here you will see the list   of materials and their associated absorption coefficients.

Note: Materials that have been modified appear with "adjusted(0)" appended to their names. 
Original materials are not deleted. If you go through the algorithm again and they are 
changed again, they will be appended with "adjusted(1)" and so on.

Right-click menu   on a material
 

9. Right-click in the window    and select Difference
The following window appears:
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Absorption coefficient   reductions and increases
 
This   window shows the changes that have been made for each of the materials.   Reductions are shown in 
red; increases are shown in blue.

Note: Brick-Bare is unchanged, as it was locked. Mineral Board had its absorption coefficient 
reduced by 0.02 (Red) in the 63 Hz band and increased by 0.01 (Blue) in the 8 kHz band.

 
Tip:      Click on Cancel to return to the acoustics tab and restore     the original materials. Or click on “Back” to 
change the material     locking settings.
 
10. Click on Next,    and you can do a more detailed analysis of the changes.

In this window, you can do   a more detailed analysis of the changes made to materials. This window   
shows the changes that have been made in terms of absolute change in absorption   coefficients, and in 
change in reflection strength.
 

11. Select the Alpha tab.
This graph shows the original   and adjusted absorption coefficients for the entire room or for each mater-
ial,   individually, you select the materials to the left. By highlighting selecting   the entire room, you will 
see the original and adjusted average absorption   coefficients for the entire room. 
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RT60 Results -   Alpha tab
 

12. Now click and select Mineral Board 5/8".
The following window will   appear: 

RT60 Results -   Mineral Board 5/8"
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This figure shows the Mineral   Board’s original absorption coefficients and the adjusted coefficients.   In 
this case, at 1000 Hz, the original material absorption coefficient   was 0.76, and the adjusted is 0.58, a 
reduction of 0.18.
 

13. Click on the Reflection    tab, the following window appears: 

RT60   Results, Reflection tab
 
This figure shows the change   in reflection strength of a ray hitting the adjusted material, compared   with 
the original material. In this case, the reflection at 1 kHz   is 2.2 dB stronger from the adjusted material 
than the original material.
The change is calculated   as:

 
Tip:      The maximum change in reflection strength allowed by the     algorithm is 3 dB.
 
14. Click Finish    to accept them, or click on Cancel    to reject the new absorption coefficients. You will be 

returned to    the Acoustics tab.
Note: When you click Finish you are committing to the new absorption coefficients, and there 

is no undo. If you change your mind you can close and reopen the model, but all changes 
made since the last time you saved will be lost.

For information on Matching RT60, see "Matching   the Measured and Predicted Reverberation Time."
 

Defining   Background Noise Levels
The background   noise level used within the Modeler software predictions may be one of   the standard noise 
levels provided in the Background Noise database, or   may be a custom background noise created spe-
cifically for the design.
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Click on the Background Noise Open   button.

Background Noise Open   button
 
The following window appears:

Background   Noise window
 
Note: Background noise can have a significant impact on predictors      such as speech intel-

ligibility and echoes.  Background      noise can reduce intelligibility, and it can help mask a 
late      strong reflection that may otherwise have appeared as an echo.

In this window, you can either use one of the predefined   noise curves, or if you have actual measurements 
from the space, simply   create your own noise files.
Click on a few of the different noise files to get familiar   with the format.  You can duplicate files, rename 
them, and delete   some of them.
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Note: The standard files (BNC - Balanced Noise Criteria and RC - Room Criteria) are pre-
defined and locked. They cannot be changed unless you duplicate them first. See Amer-
ican National Standard Criteria for Evaluation Room Noise ANSI S12.2-1995 (ASA 115-
1995)

 

Creating   your own Background Noise
For this example, we have measured the actual background   noise in a room. We will now create a custom 
noise file with this data:
 
1. Click on the New Noise Curve button (or select    New from the File menu).

New   Noise Curve button
 

2. Name the file Noise_Church,    then click on OK.

Adding a New Noise Curve
 

The file appears at the root of the acoustics data folder.
 

3. Select    the Noise_Church file by clicking    on it.
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New Noise Curve   file
 

Storing a Gain Offset for the Background Noise File

In some cases you may      need to increase or decrease the gain of a background noise      file. One possible 
way to do this is to create multiple copies      with different levels. Modeler provides an      easier way by using 
a Gain Offset function that allows you      to specify a gain offset per room model.
To access the Gain      Offset function, open the Background Noise Database, and preview      the background 
noise file using the steps described earlier.      While previewing the background noise file, you can use the      
Gain Offset function to increase or decrease the initial level      of the background noise.

A Gain Offset can be      defined for each room model where this particular background      noise file is used. 
The Gain Offset information is stored      with the room model, and is recalled the next time the room      model 
is opened.

 
4. Select 1 octave band for the    bandwidth.
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New Noise Curve   file with 1 Octave selected in Bandwidth
 

5. Enter the numbers as follows:
 

Added numbers for   New Noise Curve file
 
We have now entered the background noise.
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6. Click on OK.    You will then return to the Acoustic    tab. You will see the name Noise_Church    in the 
Background Noise section.
 

Noise_Church in   Background Noise field
 

Note: With the calculation engine enabled, just selecting a new noise file will   not update cal-
culations. Instead, clicking "Apply", "OK"   or adjusting the Noise Gain Offset slider will 
trigger a recalculation.

 
Tip:  To clear a previously      selected background noise file, simply replace it with another      background noise 
file. Note that there is a file “No Noise      (-30 dB)”. When this file is selected, the room model      is simulated with 
no background noise.
 

Defining   A House Curve
The House   Curve function is used by the Apply House Curve function within the right-click   menu of the EQ 
Tab.  One of the standard house curves provided   in the House Curves database may be used, or a new, cus-
tom House Curve   created specifically for the design may be created.

By setting the House Curve, you may quickly modify the   rooms average response to match your preferred 
shape (House Curve).
To set the House Curve.:
1. Click on the House Curve Open button.

 

House Curve, Open   button
 
The   following window appears:
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House Curve window
This window works similarly   to the Background Noise window. Click around to get familiar with the   func-
tionality.
 

2. Select the curve labelled Flat_w_4k_knee, which is flat to 4 kHz, and then rolls off by    3 dB per octave 
band.

House Curve
 

3. Click on OK,    and you will return to the Acoustics    tab. Notice that the House Curve name appears in the 
House Curve section.
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Acoustics tab,   showing House Curve name
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Creating a System Design
Introduction
Once the room model is created, a system design may   be implemented using the various loudspeaker and 
array tools within the   Modeler software.
 
See the following topics:
 l Placing    and Aiming Loudspeakers
 l Working    with Arrays
 l Working    with RoomMatch® Arrays

 

Placing and Aiming Loudspeakers
The Cluster toolbar contains tools for placing and viewing   loudspeakers.
 

Cluster toolbar
 
 l Place Loudspeaker    - Places a loudspeaker in your model.
 l Place Array    - Places an array in your model.
 l Place RoomMatch™ Array - Places a RoomMatch    array in your model.

 
When placing speakers within the room model using the   Place Loudspeaker tool you are   asked to specify 
the elevation, Roll, Pitch and Yaw of the loudspeaker.
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Entering elevation, Roll,   Pitch, and Yaw when placing a loudspeaker
 
The Roll, Pitch and Yaw you choose will determine how   the loudspeaker is aimed within the room model.  If 
you wish   you can just click the OK button and the loudspeaker will be placed using   the default settings.  You 
can then move the hit point directly   within the room model, or you can edit the Roll, Pitch and Yaw angles   in 
the loudspeaker spreadsheet.
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Elevation View
 

Section View
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Plan View
 

Working with Clusters
Once you have placed a loudspeaker in the room model   it is automatically assigned to a cluster.  Modeler 
uses a Zone.Cluster.Tier.Index   labeling system for all loudspeakers within the design.  This   is a hierarchical 
system that offers a great deal of flexibility for the   organization of loudspeakers.  Many systems, however 
only require   a Zone.Cluster organization.  It is possible to turn off the   display of Tier and Index settings in 
the Loudspeaker Tab when they are   not being used. In the Model Settings, you can adjust the appearance of   
the Cluster Identifier.
 

Loudspeaker labeling system
 

Cluster Origin
The cluster origin represents the point at which measurements   are made when arranging loudspeakers in 
Cluster View. It is displayed   in Modeler software as a blue cube, and is created when you place the   first loud-
speaker of a new cluster. Even if you only have one loudspeaker,   there will still be a cluster origin).
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Cluster Origin (blue cube)
 
It is (unless hidden within a loudspeaker) displayed   as a blue box, which then appears as a gray box.  When 
selected,   the cluster origin is red, unless it is hidden within a loudspeaker, which   then appears as a purple 
box).
 
The cluster origin is used as follows:
 l For moving the entire cluster (click and drag    the cluster origin).
 l As a point of reference for arranging loudspeakers    within the cluster.
 l For selecting and duplicating the cluster

 

Editing a Loudspeaker   Cluster
There are two ways that you can work with a cluster   within the Modeler program.  The first is to use the 
zoom tool   to “zoom in” on the cluster position from within the Room View.  Using   this method you can select, 
move or nudge individual elements within the   loudspeaker cluster.
The second method is to use the Cluster View.  The   Cluster View allows you to work within a single cluster, 
and provides   additional controls for orienting loudspeakers, and building arrays.
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Using the Zoom tool and   Cluster View to edit a Cluster
 
When working within the Cluster View you notice the   following changes:
 l The rulers along the edge of the model are relative    to the Cluster Origin.
 l The X, Y, Z coordinates in the Loudspeaker Tab    now adjust the loudspeakers position relative to the 
Cluster Origin.

 l The Cluster Snap grid will apply to any changes    you make.

 
When working within the Cluster View you have access   to three methods of arraying 
loudspeakers: Cartesian coordinates,   cylindrical coordinates or spherical coordinates.
 l Cartesian coordinates    is the default coordinate system when working in the Cluster View.  When    work-
ing in Cartesian coordinates loudspeakers snap to the nearest    X, Y, Z value when being selected and 
moved.
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Example   of Cartesian coordinates
 
 l Cylindrical coordinates    will allow you to array loudspeakers according to a radius.  For    each loud-
speaker a radius length, Yaw angle and Z offset value is    specified.  The Array Radius determines the dis-
tance from    the Cluster Origin to the geometric center of the loudspeaker.  The    Yaw determines the 
location of the loudspeaker along the edge of the    cylinder, and the Z value determines the location of the 
loudspeaker    along the height of the cylinder.

Example   of Cylindrical coordinates
 
 l Spherical coordinates    array the loudspeakers on the edge of a sphere.  In this    case you will specify an 
Array Radius, Pitch and Yaw.  The    Array Radius determines the distance from the Cluster Origin to the    geo-
metric center of the loudspeaker.  The Yaw determines    the location of the loudspeaker along the edge of 
the sphere, and    Pitch value determines the location of the loudspeaker along the height    of the sphere.
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Example   of Spherical coordinates
 
When you are working with Spherical and Cylindrical   arrays you will need to know the Spacing and Splay in 
order to calculate   the appropriate radius for the array.  Doing this will simplify   cluster layout, and will pre-
cisely position the loudspeakers.
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Calculating   the radius of an Array
 
Additionally, when working with multiple loudspeakers   in a cluster you can use the “Aim Selection” feature 
to stack, aim or   stack and aim the loudspeakers in the array. The Aim Selection tool   is available from the 
Right-Click menu of the Model View. This feature   is very useful for creating a stacked MA12 array.  To create
   a stacked MA12 array you simply select all of the MA12 loudspeakers in   the cluster, and using the Aim Selec-
tion feature specify the amount of   Yaw, Pitch and Roll, and select the “Stack Loudspeakers”
 

 
Note: The   Stack feature always stacks the loudspeakers on top of each other using   the top sur-

face of the loudspeaker.  If you use Roll + Stack   you will create a horizontal array with 
the loudspeakers “stacked” end   to end.
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Editing Loudspeaker   Placement and Aiming
The aiming of loudspeakers within the room model may   be modified using either the loudspeaker properties 
of the individual   loudspeaker, or the Loudspeaker Tab.
Within the Loudspeaker Tab all of the aiming properties   of the loudspeaker are shown.
 

Loudspeaker aiming properties
 
From this location you may change the loudspeaker’s   position within the model using the X,Y and Z prop-
erties, and its aiming   using the Roll, Pitch and Yaw items.
It is important to note that the X, Y and Z items are   view dependent.  When the room model is displayed the 
coordinates   refer to the loudspeaker’s position using the room model coordinates.  When   the Cluster View is 
displayed the X, Y and Z items are relative to the   0, 0, 0 point of the cluster.
Selecting a loudspeaker within the Model View, and displaying   the Properties Tab will display the properties 
for the selected loudspeaker.
 

Properties for the selected   loudspeaker
 
Like the Loudspeaker Tab the X, Y and Z items are view   dependent.  When the room model is displayed the 
coordinates   refer to the loudspeaker’s position using the room model coordinates.  When   the Cluster View is 
displayed the X, Y and Z items are relative to the   0, 0, 0 point of the cluster.
 

Loudspeakers with   multiple drivers
Multi-way loudspeakers use master properties for the   loudspeaker, and driver properties for control of indi-
vidual driver components.  This   functionality allows you to independently adjust parameters such as EQ   set-
tings, delay and gain for each driver in many multi-way loudspeakers.
Separate drivers are displayed individually in the Loudspeakers   and Properties tabs. For example, a 
biamped Bose Panaray® LT 9702® loudspeaker,   has two independently adjustable drivers: a high frequency 
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section and   a mid frequency section. The drivers are displayed as “child” rows (MF9702,   HF9702) under-
neath the “parent” entry (Bose LT 9702®-III Biamp) in the   Loudspeakers tab.
 

Multiple   drivers shown in Loudspeakers tab
 
A Bose Panaray® LT 9702® loudspeaker with independently   adjustable mid-frequency and high frequency 
drivers
Use the parent entry to delete the loudspeaker or change   its position. Use the child entry to adjust settings 
for the individual   drivers.  You may also use the parent entry to apply a master   gain or delay to the loud-
speaker which maintains the relative differences   applied to the individual drivers.
Loudspeakers with independently adjustable drivers are   displayed in a similar manner in the Properties tab:

A Bose Panaray® LT 9702® loudspeaker with independently   adjustable mid-frequency and high frequency 
drivers as seen in the Properties   tab
 

Working With Arrays
An array is a special collection of loudspeakers that   have been specifically arranged, oriented, and poten-
tially steered to   achieve a desired pattern of coverage across multiple frequency bands.   Like all speakers, 
they are assigned to a cluster.
The array is described by a set of rules. For example,   the arrangement is determined by specifying dimen-
sion and spacing. You   define what direction in space you want to steer the array, and the software   auto-
matically assigns to each of the loudspeakers a delay time that steers   it in the desired direction, and so on.
This chapter illustrates the process of designing with   arrays, starting with how to define them, following by a 
description of   array properties. It concludes with a survey of the most common array   types.

Creating an Array
A typical application for the Array tool is the creation   of bass arrays.  Because of this the remaining 
examples in this   section focus on the creation of four bass array types: broadside, endfire,   compound, and 
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ring arrays.
To place an array, select the Place Array tool, located   next to the Place Loudspeaker tool, and click within 
the room model at   the desired array location.  Doing so will cause the Place Array   window to be displayed:
 

Place Array window
 
1. Select the desired loudspeaker    to be used within the array.
2. Select the type of array    to be created:  Grid Array (broadside, endfire, or compound)    or Ring Array.
3. Define the physical location    of the array within the room model.
4. Define the quantity of    elements to be included within the array.
5. Once the array parameters    are defined select OK to place the array.
 

Broadside Arrays
A broadside array is the simplest of the array types.  In   this array the sources are equally spaced, and 
energy is radiated to the   sides of the array, and cancels at the ends of the array.  A   broadside array relies 
solely upon the spacing of the array elements to   create its radiation pattern, and does not employ any 
advanced signal   processing.
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Broadside array example
 
In this example, the array is stretched in the Z dimension   resulting in significant radiation pattern control.
 

Endfire Arrays
Endfire arrays are used to direct, or focus, the array’s   energy in a single direction.  In this array spaces are 
equally   spaced, but a linear signal delay is applied to the array in the direction   of the desired radiation. 
The steering of the energy is accomplished using the   Steering function in the Array properties.  The main 
beam of   the array may be steered between +/- 90 degrees, where 90 degrees corresponds   to the positive 
direction of the selected array dimension (and equivalent   to 'Full Endfire').
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Endfire array example
 
In this example, the energy of a broadside array is   now steered downward by 90 degrees to create an end-
fire array.
 

Array Spreading
The concept of spreading may be used in conjunction   with steering or by itself.  Spreading the array’s energy 
effectively   “softens” the edge of the array’s coverage pattern.   Spreading   applies a non-linearly increasing 
delay across the array with the 0 point   being the center of the array, and the signal delay time increasing 
along   the length of the array.

- 193 -



Modeler®  Sound System Software 6.8 User's Guide

Array spreading example
 
In the example above 90 degrees of spreading has been   applied to the array.  Notice that the coverage is not 
as “sharp”   in this application as compared to the standard broadside array.
 

Compound Arrays
Compound arrays employ multiple rows and/or columns   of loudspeakers.  Compound arrays incorporate 
more complex spacing,   but are capable of delivering a higher SPL at the listener.  Compound   arrays employ 
the same steering, spacing and spreading concepts as the   basic endfire and broadside arrays, but applied to 
two (or three) dimensions.   In compound arrays, steering and spreading may be independently adjusted   for 
each of the dimensions of the array.
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Compound array example
 

Ring Arrays
A ring array is a unique type of compound array which   uses spacing, steering and spreading to focus the 
array’s energy in a   single location.  Physically the array looks like an oval, or   circle depending on the 
amount of vertical pattern control that is required.

Ring array example
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In the above example the ring array is steering the   energy in the positive X direction while providing the 
desired vertical   pattern control of a broadside array, and low frequency directivity of   a compound array.
 
Note: The orientation   of the individual array elements may be adjusted by editing the aiming   

angles in the 'Speaker' section of the properties of the array.

 

Viewing the Anechoic   Array Performance
Once you have created an array, it is possible to view   its performance independent of the room model, and 
simultaneously modify   its properties to achieve the desired radiation pattern.  The   array's performance is 
viewed using the Map Cluster function within Modeler.
 
To view the array's performance, select the Map Cluster   tool within the Cluster toolbar:

Selecting the Map Cluster   tool
 
Once the map cluster is selected, the cluster’s anechoic   response is displayed upon a hemisphere:

Anechoic response example
 
The Simulation tab may be used to define how the coverage   of the array is mapped:

- 196 -



Modeler®  Sound System Software 6.8 User's Guide

Simulation tab - mapping array coverage
 
These additional mapping options are shown in the Mapping section of the Simulation   Tab:

Type   - Defines how to display the array performance; select from None, Hemisphere,   Full sphere, or 
Plane.
Radius   - Defines the radius of the sphere; select from 1 to 100 m.
Angle   Res - The angular resolution of the display; select between 2°,   5°, 10° and 20°. A higher res-
olution results in longer computation times.
Pitch   - Pitches the mapped surface.
Yaw   - Yaws the mapped surface.

 

Editing Array Placement   and Aiming
The aiming of loudspeakers within the room model may   be modified using either the loudspeaker properties 
of the individual   array, or the Loudspeaker tab.
Within the Loudspeaker tab, all of the aiming properties   arrays are indicated using a green header line which 
includes properties   that are common to the array, and the individual array elements underneath.

Loudspeaker tab - aiming   properties of arrays indicated by green header
 
Note: Some   of the array element properties are disabled within the loudspeaker tab.  These   

properties can be edited only from within the Array Properties.

 
To view an array’s properties, select the array within   the room model, and then select the Properties 
Tab.  From within   the array properties you may modify the array’s aiming, position within   the model, num-
ber of elements and steering.
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Viewing an array's properties
 

Unarray and Array   Tools
In some situations it may be necessary to “break apart”   an array into its component elements, or to create a 
new array consisting   of all the devices within a loudspeaker cluster.  To accomplish   this, use the Array and 
Unarray tools found in the Clusters Toolbar.

Clusters toolbar - Array/Unarray   tools
 

Unarray Tool
Using the Unarray tool will break the array into its   component elements.  Using this function will not change 
any   performance predictions, but will affect your ability to easily modify   the array’s configuration. 
Once an array is un-arrayed, all array properties are   lost. If the elements are re-arrayed, the following prop-
erties cannot   be adjusted:
 l Number of array elements
 l Spacing of array elements.

Array Tool
The Array tool is used to combine a number of individual   loudspeaker elements into a single group, or 
array.  This function   is useful when you wish to create a large cluster, and then aim the cluster   as a single 
element within the room model.  Once the items are   arrayed they appear in the Loudspeaker Tab as an 
array.
 

Working With RoomMatch®   Arrays
Within Modeler software the creation, editing and optimization of Bose RoomMatch® Arrays is greatly sim-
plified when using the RoomMatch Array tools. Each RoomMatch array is treated as a single entity within the 
room model. RoomMatch properties define the type and quantity of modules and subwoofers that comprise 
the array.
Arrays may be designed using the Auto Layout function, or manually by selecting individual module types.  
Metrics around the modules acoustic efficiency and the presence of audible seams is provided for both 
design methods.  Once the design is complete a single page rigging data sheet can be generated which 
describes the necessary hardware and installation details to realize the array.
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In this section we will review the steps necessary to create a RoomMatch array, and discuss the per-
formance metrics used in the creation of the RoomMatch array.

RoomMatch Design Interface
To support the design of RoomMatch arrays, a specific design interface has been created within the Modeler 
software.  The RoomMatch Design interface is automatically opened when a RoomMatch array is placed 
within the room model, and may be easily accessed whenever a RoomMatch array is selected.
The RoomMatch design interface is comprised of five components as shown below:
 

RoomMatch Design Interface
 

1 - Place RoomMatch Array Tool for placing a new RoomMatch array within the model.
2 - The Split View shows a Projection View from the array’s perspective next to the model view.  Both 
can be controlled and sized independently.
3 - The Projection View displays the interior wireframe of the room model to assist with aiming of the 
array.
4 - RoomMatch Array Properties control the type and configuration of the RoomMatch array.
5 - Isobar mapping displays the isobar contour of each module within the array.

RoomMatch Array Properties
The RoomMatch Array properties provide immediate access to the type, configuration, and aiming of the 
RoomMatch Array.
From within the properties display it is possible to:
 l Create a RoomMatch array using the manual or automated array layout tools
 l Define the array crossover to operate as a full range array, or with subwoofers
 l Define the aiming of the array within the room model
 l Access a detailed rigging report which describes what is required to implement the RoomMatch array

The RoomMatch array properties are shown and described below:
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RoomMatch Array properties   display
 
Aiming   describes the orientation of the array within the room model. All items in this section are dimen-
sioned relative to the topmost full range module within the array.  When subwoofers are added to the array, 
the height, pitch and yaw remain constant. Note that the subwoofers are added above the topmost module.

Height   defines the overall pitch of the array oriented around the topmost module of the array.
Pitch defines the overall pitch of the array oriented around the topmost module of the array.
Yaw   defines the yaw (left/right aiming) of the array.

Configuration defines the type of array being created within the RoomMatch array tool and includes the fol-
lowing options:

Configuration Selection defines the type of array that will be constructed.  A total of 38 unique con-
figurations are available.  Each includes an iconographic depiction of the array, and a short text descrip-
tion of the configuration.

RoomMatch Array Configuration Selection
Array configurations are available in the following categories:

Standard Configurations employ full range RoomMatch modules, or RoomMatch modules integrated 
with RoomMatch subwoofers.
Endfire + Array Configurations integrate an endfire array of two or more RoomMatch RMS215 sub-
woofers.
Endfire Arrays do not include any RoomMatch full range modules, but only RoomMatch RMS215 sub-
woofers.
RMS215 Configurations allow for the creation of RMS215 subwoofer arrays.
RMS218 Configurations allow for the creation of RMS218 subwoofer arrays.
Available selections include arrays consisting of RoomMatch modules only, arrays with modules and 
integrated subwoofers, and flown subwoofer only configurations.

Pullback Bracket, when selected, will include a pullback bracket on the bottom module of the array.  A 
pullback bracket is recommended for use when the desired array pitch cannot be achieved with the main 
grid frame mounting points.
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Crossover defines the high pass crossover point of the array. Available selections are 50 and 80 Hz.  
Based on the array crossover point the corresponding subwoofer low pass crossover settings are 
applied.

Auto   Layout contains the control necessary for generating a RoomMatch array solution based on user 
defined target coverage area.

Auto Layout Activation enables/disables the auto layout function.
Auto Layout Wing Menu displays the values which define the target coverage area.  While the target 
coverage area can be directly defined within the Projection View, values can be edited here for fine tun-
ing.
Type defines the type of modules to be used for the array – symmetric or asymmetric.
Modules defines the quantity of modules to be used in the array.  Based on the target coverage area 
definition the auto layout function will determine the best module choices based on the number of mod-
ules selected.

RoomMatch Array includes the modules within the array, and provides the ability to modify the modules to 
create a new RoomMatch array manually.

Speaker identifies each RoomMatch module within the array.  Each row in the table represents a module 
position within the array.  An array may have up to eight devices, subwoofer or speaker.  Use the drop 
down selection to choose the module type for that position in the array.
Solo activates the solo function for the selected module.
HF Gain allows adjustment of the high frequency gain for each module within the array.  All modules 
default to 0 dB of gain adjustment, but can accommodate +18.8 / -50 dB of gain adjustment.
Eff. (Efficiency) displays the calculated module efficiency for each RoomMatch module in the array. 
Efficiency is a key metric for determining if modules can be split or combined.  For example, two 20 
degree vertical modules operating at 30% efficiency can be combined to a single 40 degree vertical mod-
ule.
Match displays the quality of the match between two adjacent modules.  Modules that are well matched 
will exhibit seamless vertical coverage.  Modules that are not well matched will exhibit the presence of 
an audible seam between the two devices.

Rigging Data… displays the RoomMatch rigging data for the selected array.
 

Using the RoomMatch Array Auto Layout   Function
The automated layout function for a RoomMatch array creates a Progressive Directivity Array based on the 
target coverage area and module quantity requirements.
Once a RoomMatch array has been placed within the room model, the Auto Layout function is enabled by 
selecting the Auto Layout checkbox within the RoomMatch array properties

Once Auto Layout is enabled the following steps are recommended for creating a RoomMatch array:
1. Select the type of array you will create.
2. Define the target coverage area using auto array functions.
3. Evaluate the performance of different module quantities.
4.  Adjust horizontal coverage of modules as needed.
5.  Add bass reinforcement to the array.
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Step 1: Select the Array Type
Auto Layout supports the design of arrays using Symmetric or Asymmetric modules.  In most of the cases, 
your choice of array type determines the module type that will be used.  In some cases, however, an asym-
metric array will use a symmetric module when no asymmetric module is available to provide coverage to 
the target area.
The choice of array type is made using the Type drop down within the Auto Layout section.

Step 2: Define the Target Coverage Area
The target coverage area is only shown in the Projection View when the Auto Layout function is active as 
shown below:

Target Coverage Area
The target coverage area is used to define five key requirements for the creation of the RoomMatch array:  
Total Vertical Angle, Far Horizontal Angle, Near Horizontal Angle, Array Pitch, and Array Yaw.  The auto lay-
out uses this information, with the required module quantity to determine the set of modules that will com-
prise the RoomMatch array.  Each of these items are adjustable from directly within the Projection View, or 
may be accessed within the Auto Layout Wing Menu.
The following diagram describes the controls for both array types within the Project View:

- 202 -



Modeler®  Sound System Software 6.8 User's Guide

A – Adjust Horizontal/Vertical Coverage: Use the grab handles and move within the target coverage area 
to define the target coverage areas near and far horizontal coverage, and the total vertical coverage for 
the array.
Symmetric arrays provide two grab handles and the symmetric corner adjusts automatically, in asym-
metric arrays you may adjust each corner of the target coverage area.
B – Cluster Hit Point: Adjust Pitch and Yaw by moving the cluster’s hit point within the target coverage 
area.
C – Indication of the mechanical center line of modules, asymmetric arrays only.

Fine control of each of these parameters is also available within the Wing Menu of the Auto Layout section of 
the RoomMatch properties window.

Step 3: Select Module Quantity
RoomMatch Array modules are designed such that it is possible to scale the performance of the array in 
three areas of performance:  seamless coverage, SPL output, and vertical pattern control. These parameters 
are adjusted by ‘splitting’ or ‘combining’ modules for a given vertical angle.  For example, to increase the 
SPL a single 40˚ module can be split into two 20˚ modules – this also results in increasing the length of the 
array, and its vertical pattern control in the lower frequencies.  Likewise two modules can be combined to 
reduce the overall size and cost of the array, provided it still meets the SPL requirements for the project.  
The following image illustrates how it is possible to create four unique array configurations for a single ver-
tical coverage angle:
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All calculations within Modeler software are performed in real time allowing you to immediately evaluate the 
coverage for RoomMatch arrays of various sizes.  The Auto Layout function will automatically generate an 
array based on the target coverage area and the selected number of vertical modules. When mapping is 
enabled the coverage for the array is immediately available for viewing within the room model.

We recommend you evaluate several array configurations to determine the one which provides the best bal-
ance of the three array criteria for your project.  The following illustration compares three arrays for a given 
vertical coverage angle.  Each array provides the same coverage, but it can be seen that the seamless cov-
erage improves as the array size increases, as does the overall SPL output.

Step 4: Adjust Horizontal Coverage
The horizontal coverage of the array can be ‘fine-tuned’ within the RoomMatch Array section of the 
RoomMatch properties.  In the following example the coverage for the near throw modules could be 
increased to better cover the far edges of the seating area.
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Improving the coverage in this situation can be as easy as selecting module of the same vertical angle with a 
wider horizontal angle.  In this example a 90x40 (HxV) is proposed, but a 120x40 may perform slightly bet-
ter.
To accomplish this first turn off the Auto Layout function and then select the new module from within the 
Speaker column in the RoomMatch Array section of the properties window as shown below:

Once the adjustment is made the resulting coverage pattern is displayed in the model view, and it can be 
evaluated.
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In this example the change to wider horizontal coverage pattern provided two benefits.  First, the coverage 
has been extended to the edge of the seating area.  Secondly, because a wider coverage angle is used the 
total acoustic energy for this module is distributed across a wider area resulting in an improved level bal-
ance for the entire array.

Step 5: Add Bass Reinforcement
A variety of low frequency options are available for use with RoomMatch arrays.  In situations where the low 
frequency elements will be flown with the modules in a single array use the following steps:
1. Select the 50Hz high pass within the array configuration.  This will adjust the crossover of the full range 

modules for operation with low frequency devices.

2. Select the desired bass configuration from within the array configuration selection tool.  Once the new 
configuration is selected the bass devices are added to the topmost positions within the array.
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It is important to note that when adding bass devices to an array the following rules are enforced:

 l The maximum number of devices within an array is eight, which can be any combination of 
modules or bass loudspeakers.

 l The Aiming of the array does not change as a result of adding bass devices.

3. Verify that the bass devices are properly located within the room model.  Since the array height is ref-
erenced to the top module, it is possible that the bass is placed outside of the room model when added – 
if the array was in close proximity to the ceiling.

RoomMatch Bass Array Configurations
The RoomMatch product line supports a total of 8 unique bass array configurations that may be suspended as 
part of an array with RoomMatch modules, or in a stand-alone configuration.  When one of these con-
figurations is added to an array all of the necessary signal delay is automatically added to achieve the 
desired bass steering for the specific configuration.

RoomMatch Array Metrics
RoomMatch Array modules are designed such that it is possible to scale the performance of the array in 
three areas of performance:  seamless coverage, SPL output, and vertical pattern control. These parameters 
are adjusted by ‘splitting’ or ‘combining’ modules for a given vertical angle.  The decision to split or add mod-
ules is guided by two key metrics – Efficiency and the quality of Match between modules.

Efficiency
Ideally a RoomMatch array will have all modules operating at an equal gain level.  Traditional line arrays use 
the same coverage pattern for all modules within the array.  In this configuration the projection area of each 
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module is different which results in varying SPL levels across the vertical axis of the array – as shown in the 
following illustration.

The solution to this problem is typically to reduce the drive level to modules across the length of the array to 
balance the SPL level at the audience area.
RoomMatch systems achieve a consistent SPL balance across the seating area by adjusting the directivity 
index of modules within the array – achieving the same effect, by adjusting the acoustic gain of the modules 
within the array.  The result is that narrower, higher directivity index modules are used for the far throw, and 
wider, lower directivity index are used for the near throw. This results in a balanced SPL response, and 
keeps the coverage within the target coverage area – as illustrated below:

A properly designed RoomMatch array will have all modules operating at the same drive level, with little or 
no ‘gain shading’ applied.  The Efficiency metric indicates how well a given module’s acoustic output is being 
utilized – relative to other modules within the array.  Ideally all modules within the array are operating at 
100% efficiency.  To achieve this, the efficiency metric can be used – in conjunction with module gain to 
develop an insight into when modules should be split or joined to achieve 100% efficiency.
In the following example the energy from the bottom module in the array is 3-6 dB more than in the cov-
erage area of the upper two modules.
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To balance the energy across the array you can reduce the gain of the bottom module by 3 dB, but note that 
the efficiency for this module is now at 50%.  This provides a better level balance across the length of the 
array, but the Efficiency metric indicates that this particular module is only utilizing 50% of its capabilities.
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Efficiency is calculated by first calculating the efficiency of the individual module’s high frequency devices,  
(Actual Power Applied/Power Handling), which is then displayed.  In general when the module efficiency 
drops below 50% you should consider choosing a wider coverage angle.
In this example, changing to a module with wider horizontal coverage will not only improve the horizontal 
coverage of the array, but will also improve the overall array efficiency as all modules will be operating at 
100% efficiency.
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In some cases the opposite may occur, which can lead you to choose to split modules.  In this example too 
wide of a module was chosen for the near coverage, which led to reducing the gain of the two topmost mod-
ules in an attempt to balance the level across the array.
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In this situation you may choose to use a narrower module at the bottom of the array, or you may choose to 
split the wide module into two narrower modules with the equivalent vertical angle.  In this example we have 
chosen to split the bottom 120x60 module into two modules, a 90x20 and 120x40 module for example as 
they achieve the same vertical angle, but will better balance the energy level across the array.
As you continue to work with the Efficiency metric you will develop an intuitive sense of when to split, join or 
replace modules within an array based on the overall balance of level within the coverage area.
To balance the energy across the array you can reduce the gain of the bottom module by 3 dB, but note that 
the efficiency for this module is now at 50%.  This provides a better level balance across the length of the 
array, but the Efficiency metric indicates that this particular module is only utilizing 50% of its capabilities.

Module Match
RoomMatch arrays are comprised of multiple modules with varying horizontal and vertical coverage pat-
terns.  While the Continuous-Arc Diffraction-Slot (CADS) manifold technology enables a seamless vertical 
coverage for most all applications, it is possible to create an array which will exhibit less than ideal per-
formance in the vertical transition area between adjacent modules.  The Module Match metric is intended to 
help prevent this situation, by providing feedback during the design process of when two adjacent modules 
may deliver less than ideal seam performance.
The Module match metric compares the projected solid angle of two adjacent modules.  If the change in the 
projected solid angle is too great, there is a probability of an audible seam at the transition between the two 
modules.  This is represented within the RoomMatch array properties using a color, and numeric value.  The 
change between modules can be evaluated using the following scale:

In the following example two modules are used to achieve the required 70 vertical coverage angle.  However 
the Module Match metric indicates that it is a not recommended (NR) module pairing.
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To address this situation it is recommended that the module with the poor match indication be split into two 
modules which will provide a much better seam performance in the module transition area of the array.  In 
the following example the 120x60 module is replaced with a 70x20 and 120x40 modules.
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The following table shows the Module Match metric for all possible symmetric module pairings.

As you continue to work with the Module Match metric you will find that it is a very helpful guide in determ-
ining when it is necessary to ‘split’ a module into multiple vertical sections.
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RoomMatch Rigging Data
Information related to the rigging of RoomMatch arrays is now calculated and displayed directly within the 
Modeler software interface.  The information found in the original Excel based RoomMatch rigging calculator 
is provided, along with additional information specific to the type of RoomMatch array.
The RoomMatch rigging data is displayed on a cluster by cluster basis, and is accessed from within the 
RoomMatch array properties.
Click Rigging Data… within the RoomMatch Array Properties to view detailed rigging information:

Rigging Data Window
 
The calculated values information displayed within the RoomMatch Rigging Data is based upon configuration 
of the RoomMatch array, and whether a pull bracket has been included in the design.

Rigging Report - Summary Data

Array Within WLL displays either YES or NO based on calculated values.  All calculations are based on a 
10:1 Safety Factor (design factor) and cannot be changed by the user.
Pickup Point displays the estimated pickup position using the array frame numbering system for the Left 
and Right array frame rails.   The pickup point for array frames is always referenced to the shackle holes for 
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the left and right rails.   The center rail of the array frames is intended only for temporary attachment and has 
a different hole pattern as compared to the left and right rails.
Shackle holes on each rail have a top and bottom position.   However, the pickup point positions are 
numbered sequentially from 1 to 32 for the Large Frame and 1 to 33 for the Small Frame, without reference 
to the top or bottom positions.   Both left and right rails have a label that identifies the starting point of the 
pickup position numbering and direction of increment.    The label does not contain numbering for every single 
position.
Note: Do not use pickup point reference numbering for center rail!

The pickup point reference for the Extender Bars starts with 1 number greater than the last number of the 
Large Array Frame.  Thus, the first pickup point reference number for the Extender Bars is 33.

Frame Pitch displays the calculated array frame pitch, as referenced from the top of the array frame rel-
ative to the horizon.  Downward pitch is indicated by negative numbers while upward pitch is indicated by pos-
itive numbers.   This section contains two values – Target and Predicted.

Target Pitch displays the desired array pitch angle based on the aiming of the RoomMatch array within 
the RoomMatch properties.  The target pitch is the difference between the Pitch item and ½ the vertical 
angle of the topmost module in the array.
Predicted Pitch displays the predicted array pitch angle based on the proposed pickup point.  When the 
difference between the target and predicted frame pitch exceeds (xxx) a message is displayed recom-
mending the use of a pullback bracket.
It is recommended that you always compare the predicted frame pitch value to that of the target frame 
pitch value, to confirm you have not exceeded the pitch angle possible using the available pickup points 
of the array frame.
Note on Prediction Accuracy:   To confirm the accuracy of the predicted pitch angles, both the Small 
Array Frame and Large Array Frame were tested to compare actual constructed array pitch angles 
versus the predicted values.  The testing revealed an accuracy of 96% using a tolerance of 2.0 degrees 
from predicted value.    Many factors contribute to the variation including manufacturing tolerance    There-
fore, we always recommend confirming the array pitch during installation with an inclinometer, and mak-
ing adjustments in the predicted pickup point as required

Pull Bracket displays YES when pull bracket is incorporated into the array configuration and NA when a pull 
bracket is not used.
Extender Bar Is comprised of two sections – Type and Position.

Extension Bar Type displays the type – SHORT or LONG – of extender bar used to achieve the desired 
array configuration.  Extension bars are used for specific subwoofer/array configurations, and in cases if 
steeply pitched arrays which require a multi-point dead or gravity hang.
Extension Bar Position displays the position – IN or OUT – of the extension bars.  The position of the 
extension bars allows for the creation of different end-fire bass array configurations, and accommodated 
the mounting of RMS 215 subwoofers directly behind the RoomMatch array.
For information regarding the advantages for each of these options, please refer to the detailed instruc-
tions contained in the document “RoomMatch Array Rigging Frames and Accessories Installation and 
Safety Guidelines,” which is available for download at pro.Bose.com.
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Rigging Report - Calculated Values

Calculated Values are displayed in both kilograms (Metric) and pounds (US) and include the total weight of 
all modules and frame accessories as specified in the Array Parts List.  The information displayed here is spe-
cific to the selected RoomMatch array and its suspension method.

Total Array Weight is the total weight of all modules and frame accessories as specified in the Array 
Parts List.
Array Hang Height is the height of the array at the indicated pickup point on the array frame.  This 
hanging height is relative to the z=0 elevation within the room model.
Array Frame Load (per side) is the total loaded weight of each pickup point for a 2 point suspension.
RMPULL Load (per side) is the total loaded weight of each pickup point for the Pull Bracket.  This is 
only displayed when a pull bracket is included in the configuration.
Distance from Frame Pickup to RMPULL Load is the distance from the pickup point on the array 
frame to the Pull Bracket as shown in the illustration below.  This is only displayed when a pull bracket is 
included in the configuration.

Four Point Load (per side) is the total loaded weight of each pickup point for a 4 point suspension.  
This is only shown when a four point suspension is required.
When a four point suspension is required, red text is added to the top of the report:

Array Center of Gravity (X/Z-axis) is the distance from the forward most connection point to the 
array frame of the top module to the Array’s center of gravity.
The Center of Gravity dimensions are referenced to the side-plate forward-most fastener position of the 
topmost module of the array as shown below:
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Distance Frame Pickup to C.O.G. is the distance from the pickup point on the array frame to the 
array’s center of gravity as shown in the illustration below:

Rigging Report – Array Parts List
The array parts list includes all of the RoomMatch components – modules, subwoofers and rigging hardware 
necessary to realize the array as it is designed.

Rigging Report – Warnings
Legal disclaimer for rigging data:
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Rigging Report – Key Dimensions & Notes

Key Dimensions displays a reference diagram showing key dimensions for the array configuration.  Each 
item is indicated using a letter or number which corresponds to items within the Calculated Values section.
Notes displays additional notes related to the information contained within the rigging data report.

Printing the Rigging Report
The RoomMatch array rigging report may be printed using the right-click menu function.
 
To include all colors in the printed Rigging Data Report, take the following steps:  
1. Right mouse-click on the report.
2. Select Print Preview.
3. Select Page Setup, Enable the "Print Background and Images" check box.
4. Select OK.
5. Proceed to Print the report.
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Opening the Rigging Report in a Web Browser
Once a RoomMatch rigging report is created the original files are stored within a single directory, in the 
same directory as the room model file. The Rigging Report will only open correctly in Internet Explorer.  Moz-
illa Firefox, Google Chrome, Apple Safari, and Opera are unable to display the enhanced Windows metafile 
(.emf) that is generated by Modeler.
To open the rigging report, locate the room model directory.  Within the room model directory you will see a 
folder named for the room model, cluster name, and rigging report as shown below:
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Within the rigging report folder you will find the original HTML file, and image elements.
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Predicting System Performance
Introduction
Once the room model is created and a system design is   implemented its performance in the room may be 
evaluated.
See the following topics:
 l Coverage Maps
 l Defining     A Custom Mapping Area
 l Time Response
 l Frequency     Response
 l System SPL
 l Working With Listeners
 l Listener      Locations
 l Adding      Listeners
 l Setting      Listener Preferences
 l Listener      Properties
 l Using      Listeners and the Sample Tool
 l Using      Listeners to Reduce Calculation Time

 l Including     the Absorption of an Audience
 l Including     Background Noise

 

Coverage Maps
The Modeler program uses three primary coverage maps   to demonstrate the performance of the system 
design:  Direct   Field, Direct+Reverberant Field, and Speech Intelligibility.  Each   of these maps may be 
invoked from the D2RASTIc toolbar, or by using their   associated quick keys.

Direct Field Coverage
Direct Field coverage describes the direct path between   the listener and loudspeaker, and does not include 
the effects of reflections   or reverberation.
The default settings for Direct Field Coverage in the   Simulation Tab are shown below:

 

Things to remember when evaluating Direct Field Coverage:
 l Coverage is independent    of power - Changing the gain of the loudspeakers will not change    the cov-
erage, it will only increase the Direct Field Level.  Because    of this it is easier to look at your direct field 
coverage using a    Relative scale.
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 l Obstructing Planes    are included in the calculation.  If you have obstructing    planes you will see shad-
owed areas of coverage.

 l Increasing the    Resolution does not necessarily lead to a better analysis of the    coverage.  Increasing 
the resolution can lead to the wrong    decision.  If you are working in a fine resolution you may    see, and try 
to correct problems in your model that you cannot address    in the real world.

 l Likewise, it    is possible to have resolution that is too large - This can    also lead to the wrong 
decision as you may not see the effect of obstructing    surfaces.  We recommend using a Resolution of 3 
feet, 1    meter for most coverage maps.

The Direct Field coverage map will show you the areas   where you are providing sound (red to green), and 
those areas where there   is little or no coverage (blues and purples).  Using visual   representation of the dis-
tribution of sound throughout the coverage area,   you can easily see the areas where additional sound cov-
erage is needed. 
While the coverage map is an ideal visual tool for viewing   this information it does not provide a single num-
ber that describes the   overall coverage quality.  The Standard Deviation, however,   provides a single number 
to describe the quality of coverage.
The Statistics Tab provides a coverage histogram that   plots SPL along the horizontal axis, and normalized 
occurrence of each   SPL along the vertical axis.  You can think of the vertical   axis as the probability that a 
given sample in the coverage area will   have the corresponding SPL.

Direct+Reverberant   Field Coverage
The Direct+Reverberant field calculation includes the   effects of the direct sound, and reverberant field 
energy to predict the   total system SPL throughout the coverage area.  This calculation   is performed for the 
full audio spectrum from 31Hz to 16kHz.
The default settings for the Direct+Reverberant field   coverage map are shown below:
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Note: You   will want to change the scale to Absolute when using Direct+Reverberant   Field 

Coverage.

When working with the Direct+Reverberant Field map you   will want to finalize system gain settings, and the 
level balance between   mid high and bass devices.   When viewing the Direct+Reverberant   Field map you can 
view the average system response using the SPL Tab.  This   tab represents the average of all samples in the 
coverage map.

 

Speech Intelligibility,   (STI), Map
The STI field calculation incorporates all acoustic   and sound system performance attributes within the room 
model including,   direct field level, reverberant field level, background noise, and reflections. 
The default settings for the Speech Intelligibility   coverage map are shown below:

 
The STI method assumes that for the original modulation   of speech to be preserved it must pass unchanged 
through the sound system,   and acoustic environment.  Background noise, reverberation and   late arriving 
reflections all have the effect of reducing this modulation.  The   resulting reduction in modulation is what we 
use to predict the speech   intelligibility of the system.
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Seven octave-bands of noise between 125Hz and 8kHz are   used to predict the STI.  Each of the octave-bands 
is modulated   at fourteen different frequencies between 0.63Hz and 12.5Hz.  The   resulting modulation trans-
fer function, MTF, shows the reduction in the   octave-band due to background noise, reverberation and late 
arriving reflections.

 
Once the modulation transfer function has been calculated   for each of the seven octave-bands they are 
weighted and averaged to derive   a single Speech Transmission Index score.  The weighting factors   emphas-
ize the 2, 4 and 8kHz bands as these carry the important consonant   sounds for required for understanding 
speech. 
When predicting speech intelligibility the Modeler program   uses the Hybrid Energy Decay Curve™ to predict 
the impulse response of   the system, which is then used to calculate the STI score.  This   method has been 
shown to equivalent to directly calculating the reduction   in modulation for each amplitude-modulated 
octave-band noise test signal.
When the HEDC/STI calculation is invoked, this calculation   is performed for each sample point across the 
seating areas being mapped,   and is then displayed as a speech intelligibility coverage map.
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Using the STI map as a guide, you can identify areas   with reduced intelligibility for further analysis.  The 
Sample   Tool is used to select an individual listener position.  Once   you have selected a position is selected 
you can use the MTF graph to   identify the cause of the reduced intelligibility.
 

 
The MTF tab displays the modulation transfer function   for each of the seven octave-bands.  The octave-
bands are displayed   in a ROY G BIV color coded pattern.  Red corresponds to the   125Hz MTF, and Violet cor-
responds to the 8kHz MTF. 
When viewing the MTF graph the shape of the individual   octave-band MTF graphs reveals the nature of reduc-
tion in modulation.  The   shape of the MTF curve will be affected by one or more of the following:
Reverberation - affects   higher modulation frequencies more than lower modulation frequencies,   as a res-
ult you will see that the preserved modulation will decrease as   the modulation frequency increases.
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Background Noise -   affects all modulation frequencies equally, as a result background noise   will have the 
effect of reducing the overall MTF curve.
 

 
Late Arriving Reflections   - will produce a visible “notch” in the MTF curve.  It is important   to note that 
these late arriving reflections can be caused by a variety   of factors, improperly aimed loudspeakers, dis-
crete reflections from a   room surface, or even a group of reflections that have summed to produce   an aud-
ible reflection.
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Defining a Custom Mapping Area
If you do not want to map the entire audience area,   you can use the Custom Mapping Area tool to draw a vir-
tual surface on   the specific area within the room you wish to map. This surface has no   impact on the acous-
tics of the room, it is simply a surface for mapping.
To create a custom mapping area, click on the Draw Custom   Areas tool wing menu and select the surface 
types upon which the custom   area will be drawn. 

 
You can create a Custom Area that spans multiple surface   types. For example, you can create one that cov-
ers the seating area and   parts of a wall. Simply make sure that the surface types you want to include   are 
checked in the Custom Areas wing menu list.
To display a coverage map for a custom mapping area,   the following items need to be selected within the 
Simulation Tab:
 l Surfaces    - The surface types you are mapping (Floor, Seating1, etc.)
 l Mapping    - The Maps check box and the Custom Areas radio button.
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Time Response
Time arrival data for direct and reflected energy is   displayed within the Time Arrival tab.  Information dis-
played   within the Time Arrival tab is dependent on the active coverage map.
 l Direct Field Coverage – displays only direct    arrivals for the selected frequency band.
 l Direct+Reverberant Field Coverage – Time Response    tab is disabled.
 l Speech Intelligibility Coverage – displays direct    arrivals, first and second order reflections and the Rever-
berant Field    Envelope Function.

The information displayed is based on a single sample   or listener position.  To view the time response for a 
single   point the Sample Tool must be active, and a point within the room must   be selected, or a listener pos-
ition must be selected from within the Listeners   tab.
The following describes how to generate time-arrival   data in the Time Resp. tab and how to use the Time 
Resp. tab to set loudspeaker   delays.

Generating time-arrival data
Data in the Time Resp.   tab is location dependent, and therefore can only be seen when the Sample tool is 
placed in your coverage map.   The Sample tool allows you to   specify an exact location from which to gen-
erate acoustic prediction data.   Follow these steps to use the Sample   tool to generate time-arrival data:
1. Make sure that the D2R∆STIc    engine has been enabled, and that the Direct,    Direct + Reverberant, 

and Speech    Intelligibility coverage maps have been turned on.
2. Select the Sample    tool in the Draw toolbar.

Sample tool
3. Click in the Speech    Intelligibility coverage map to place the Sample    tool. Time-arrival data for that 

location will populate in the Time Resp. tab.
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Note: Time-arrival is only displayed for a single-frequency band. The Time Resp tab will be 
grayed out and a warning will be displayed in the graph indicating that you need to pick 
a single-frequency band from the Frequency drop-down menu.

 

Frequency band warning
The Time Resp.   tab displays elapsed time on the horizontal axis and dB SPL on the vertical   axis. Each pin in 
the graph represents an arrival of sound at the exact   location where you placed the Sample   tool. The colors 
of the pins have the following meanings:

Red      pins: Direct arrivals from the sound source.

Green      pins: First order      reflections. They have reflected off of one surface.

Blue      pins: Second order      reflections. They are arriving at the sample point after 
reflecting      off of two surfaces.

Yellow      line: Reverberant      Field Envelope Function (RFEF), which shows the build-
up and      decay of reverberant energy at the particular location.

 

Time Resp. tab
 
Note: In the HEDC™ Time Resp window, the direct arrival from each cluster is represented by 

a single pin. Its level is calculated using x-power sum on all individual arrivals from 
that cluster. Its time is set equal to the time of arrival of the first individual arrival 
time.

 
Click on a pin in the graph to generate the path from   the source to the listener location, which is viewed in 
the Modeling   window. You can scroll through the pins sequentially using the scroll   bar to the right of the 
Time Resp.   graph.

Time Resp. tab, first pin highlighted
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Setting loudspeaker delays
In a decentralized sound system, the signal to certain   loudspeakers can be delayed by a fraction of a second 
to ensure proper   signal localization. Follow these steps to use the Time   Resp. tab to set loudspeaker 
delays:
1. Select the Direct    tab in the Modeling window.
2. Place the Sample    tool in the model to the right of Cluster 2, as shown in the following    figure: 

Sample tool placed   behind Cluster 2 (with 1 kHz selected)
 
Loudspeaker delays are set   using direct arrival information.  When the Sample   tool is placed in the Dir-
ect Field coverage map, the Time   Resp. tab shows only the direct sound arrivals (red pins).
 

3. Scroll through the arrival    pins in the Time Resp. tab    and take note of which arrivals come from which 
cluster. 
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Matching arrivals   with clusters
 
As you can see, sound is   arriving at the Sample tool location   from Cluster 2 first (notice the selected pin 
and its corresponding trace   on the coverage map).
Humans localize sound based   on the first arrival that they hear.  Cluster 1 is closest to where   a talker or 
music presentation would be located, so the audience should   hear their first sound arrivals from Cluster 
1, not Cluster 2. Because   listeners in the back of the church are closer to Cluster 2, sound from   these 
loudspeakers would normally reach them first. To prevent this, a   signal delay should be set on the loud-
speakers in Cluster 2 so that all   listeners in the church receive sound from Cluster 1 first.
 

4. Click the Loudspeakers    tab in the Detail window and    scroll to the right until you can see the Delay    
column.

5. Enter a delay of 45    (ms) for the three loudspeakers in Cluster 2.
6. Notice that the time-arrivals    in the Time Resp. tab have    changed, and the first sound arriving at the 

Sample    tool location is now from Cluster 1.
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After a delay of   45 (ms) is set, sound arrives from Cluster 1 first
 

Frequency Response
The frequency response for a selected point within the   room model, or a specific listener position is dis-
played within the Frequency   Response tab.  Information displayed within the Frequency Response   tab is 
dependent on the active coverage map. 
 l Direct Field Coverage – displays the direct    field frequency response at the selected position.
 l Direct+Reverberant Field Coverage – displays    the Direct+Reverberant field frequency response at the 
selected position.

 l Speech Intelligibility Coverage – frequency    response tab is disabled.

The information displayed is based on a single sample   or listener position.  To view the frequency response 
for a   single point, the Sample Tool must be active, and a point within the room   must be selected, or a 
listener position must be selected from within   the Listeners Tab.
The Freq. Resp.   tab displays dB SPL on the vertical axis, and the frequency spectrum on   the horizontal axis. 
The frequency response at a specific location in   the coverage map can be displayed by placing the Sample   
tool at the desired location.
Follow these steps to display a frequency response:
1. Click the Freq.    Resp. tab.
2. Select the Sample tool in the Draw    toolbar.
3. Click inside the Speech Intelligibility    coverage map in the Model    view. Notice that data appears in the 

Freq.    Resp. tab.
4. Drag the Sample    tool around the model. Because frequency response is position-dependent,    the data 

changes as you change the location of the Sample    tool.
5. Drag the Sample    tool over each of the listener locations in the model. The Sample    tool snaps to the 

listener location when you drag the tool near a    listener. As you make changes to your sound system, 
these listener    locations allow you to return to a specific and consistent location    in the model to evaluate 
acoustic prediction.
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Freq. Resp. tab
 
Note: You can change the smoothing of the frequency response      curve by right-clicking in the 

Freq.      Resp. tab and choosing a different octave value. Lower      values produce finer res-
olution.

 

System SPL
The System SPL tab displays the average frequency response   for all samples within the selected coverage 
map.  Also included   is the total system SPL, based on a Pink Noise stimulus.
When viewing the System SPL tab the information displayed   is dependent on the active coverage map.
 l Direct Field Coverage – displays the average    direct field frequency response of all samples within the cov-
erage    map.

 l Direct+Reverberant Field Coverage – displays    the average Direct+Reverberant field frequency response 
of all samples    within the coverage map.

 l Speech Intelligibility Coverage – System SPL    tab is disabled.

When working with the System SPL tab additional SPL   weighting scales, (A, B, C, and Flat) are available.  In 
addition   a total SPL with program material display is available – which predicts   the total system SPL based 
upon an IEC shaped Pink Noise input source.
Note: All SPL predictions within the Modeler program assume an input noise source   with a 6 

dB Crest Factor.

 

Working with Listeners

Listener Locations
Modeler software provides the ability to specify persistent   reference points, or “Listener” locations, at which 
acoustic performance   is predicted. As you change the sound system design, these listeners make   it easy to 
compare prediction data.

Listeners vs. audience
It is important to note the difference between listeners   and surfaces occupied by an audience.
 l Listeners    are placed in a model as reference locations for generating acoustic    predictions.

Listeners are objects placed   within the model at precise locations. They provide points of reference   when 
using the Sample tool to view acoustic   predictions at different areas in the model.

 l Audience    is a surface attribute that causes Modeler software to simulate    the presence of an audience.

Audience refers to a specific   acoustic characteristic across a particular surface in the model. Surfaces   in 
Modeler software can be designated as occupied by an audience. When   you designate a surface as occu-
pied by an audience, Modeler software will   simulate the effect that an audience has on the acoustics on 
the surface.
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Adding Listeners
Modeler software enables you to establish listener positions   throughout your model using the Place Listener   
tool. Listeners provide reference points in your model from which to analyze   acoustic predictions.
Follow these steps to place a listener location in your   model:
 
1. Select the Place    Listener tool in the Draw toolbar

Place Listener   tool
 
Note: Listener locations can only be specified on Floor      and Seating surfaces.

 
2. Click at the desired location    in your model to place a listener.

The number in the green box   is the listener identifier. The arrow indicates the direction in which   the 
listener is facing (the yaw). By default, the listener faces in the   positive X direction.

A listener location
 
Note: The orientation of listeners have no impact on calculations      in Modeler, only in Modeler 

Plus.
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3. Adjust the direction the listener    is facing by dragging the blue yaw arrow in the listener circle. Click    near 
the tip of the arrow and drag it around the circle. The listener    should face in the direction that a listener 
would face in the venue.

Adjusting the yaw   of a listener
 
4. Move the listener location    by clicking and dragging the icon in the center of the circle.
5. Select the Listeners    tab in the Detail window and enter a    value in the Ear Height field to specify    that the 

listener’s ears are located off off the ground, or that they    are sitting down. The typical Ear Height default 
is at 1 m. If    the listeners were standing up, or sitting on the floor, you could    enter a higher or lower 
value for Ear    Height to best represent the height of the listeners.

Ear Height column   in Listeners tab
 
Note: Typical ear height: 3 ft (1m) Seated; 6 ft (2m) Standing.

 
6. Click the Save   button to save your work.
 
Note: Use the Place Listener wing menu to show/hide listener Identities and Wireframes.

 
Tip:      To deselect items such as listeners, use the Esc (or SHIFT+Esc)      command.
 

Copy and paste listeners
Listener locations can be copied and pasted between   different models. To do this, select the listeners you 
would like to copy   and choose Edit > Copy   (or press Ctrl + C).   Open or create the model that you would like 
to add these listener locations   to, and select Edit > Paste (or press Ctrl + V). The listener locations are 
added to the   model and appear in the same location relative to the origin.
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Note:       Listener locations that are copied and pasted will have      the same X and Y 
coordinates relative to the origin in both      the original and new models. This feature is 
most useful when      copying and pasting between two models with similar geometry      
and layout.

 

Placing listeners on overlapping surfaces
It may be helpful to place listeners in acoustically   challenging locations, such as underneath a balcony. If 
you try to place   a listener on a surface that overlaps another surface, Modeler software   will prompt you to 
choose which surface you would like the listener placed   on. For example, the theater in the following figure 
has an orchestra   seating area (Seating1) and a balcony seating   area (Seating2). 

A theater with two overlapping seating areas
 
When you place a listener in a region where surfaces   overlap, Modeler software will prompt you to choose 
which surface the   listener is sitting on. 

Placing a listener on two overlapping surfaces
 
Choose the desired surface type to place the listener   location.
 

Setting Listener Preferences
Follow these steps to change the way listeners are displayed   in Modeler software:
 
1. If Model Settings is not already displayed: Click Edit > Model Settings. The Model    Settings dialog 

box opens with the Display tab selected by default.
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Display tab
 

2. To hide the wireframe representation    of the listener, remove the checkmark from the Wireframes    box.
3. To hide the listener identifier    number, remove the checkmark from the Identifiers    box.
 
Tip:       You can click on the Listeners wing menu to check how      listeners are to be displayed in the model, as a 
wireframe      chair and/or identifier number.
 

Listener Properties
You can view and modify characteristics of the listeners   in your model using the Listeners   tab:

Listeners tab
 
See the table below for information on each column in   the Listeners tab.
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Ident.: The listener      identifier number is generated automatically when you place      a listener. 
After you place a new listener, or copy and paste      a listener, you can change this num-
ber using the Listeners      tab.

X: The      distance of the listener location from the origin along the      X Axis.

Y: The      distance of the listener location from the origin along the      Y Axis.

Ear      
Height:

The      height above the surface of a listener’s ears. This number      should be chosen 
based on whether the listeners are sitting      or standing. The default value is 1.0 m 
(3.3 ft)      above the ground. Ear height must be between 0 and 2.13 m      (7 ft).

Yaw: The      direction that the listener is facing. The default position      is 0° (positive X dir-
ection).

Notes: A      text field that can be used for notes about the listener location.      For example, you 
may want to note specific acoustic prediction      characteristics for a given listener loc-
ation.

Surface: The      identifier number of the surface that the listener location      is on. Use this number 
to easily locate the surface in the      Surfaces tab.

Type: Indicates      whether the listener location is on a Floor      or Seating surface.

 
You also can view the same information for a selected   listener in the Properties tab:

Properties tab for a selected listener
 

Using Listeners and the Sample Tool
The Sample tool   is used to measure acoustic predictions for a particular location in your   model.

Sample tool
 
For more information on the Sample tool, see the DRASTIC   Design Process.
The Sample tool   allows you to view the predictions at any location in the room model including   the pre-
defined listener locations. While listener locations are fixed   in space, the sample tool can be moved in real 
time and immediately provide   the data at the sample point.
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Note: When the tool is placed over a listener location, it      will “snap to” the listener, and gen-
erate data for this precise      location.

 

Snapping the Sample tool to a listener location   in a Direct Field coverage map
 
As you change the sound system design, the listener   locations  provide reference points from which you can 
measure the   effects of your design changes. Snap the Sample   tool to a listener location before and after a 
design change, to see how   it affects acoustic prediction data from the exact location.
 
Tip:     In order to de-select a sample in a map, click the wing menu of     the Sample Tool and click on the 'Clear' 
button.
 
 

Using Listeners to Reduce Calculation Time
You can greatly reduce calculation time by generating   acoustic prediction data exclusively at listener loc-
ations. The calculation   will be significantly faster because Modeler software will not calculate   an entire cov-
erage map. It is strongly recommended that you use this method   when working with complex sound system 
designs and/or large and complex   models. Follow these steps to generate acoustic prediction data exclus-
ively   at listener locations:
1. Open a model that contains    listener locations and loudspeakers.
2. With the D2R∆STIc engine off, click on the    Simulation tab in the Detail    window and uncheck Maps to turn 

off the coverage maps. Modeler software    will only draw the coverage map on the surface types that are 
checked    (with Maps checked and All selected).

Simulation tab settings
 
3. Enable the D2R∆STIc engine by clicking on the    Enable D2R∆STIc Engine button in the Map    toolbar:
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Enable D2RDSTIc   Engine button
 
4. Click the Direct    button on the Map toolbar.

Direct button
 
5. Select the Sample    tool and snap it to a listener location.

The Sample tool   snapped to a listener location
Although there is no coverage   map, Modeler software will generate acoustic prediction data at the 
listener   locations. The Sample tool cannot be placed   on other parts of the Seating1 surface, but   it can be 
snapped to a listener location to generate acoustic prediction   data.

 
6. Click on the Speech    Intelligibility button in the Map    toolbar to generate Speech Intelligibility data at the 

listener locations.

Speech Intelligibility   button
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7. Select the Sample    tool and snap it to a listener location in the model. Notice that    acoustic prediction data 
for the listener location is generated in    the Time Resp. and MTF    tab.

 

Including the Absorption of an Audience
Surfaces of the type Floor,   Seating, and Misc.   can be designated as occupied or unoccupied by an audience 
using the Surfaces tab.

Floor and Seating type surfaces in the Surfaces tab
 
When surfaces are occupied by an audience, Modeler software   will simulate the effect that an audience has 
on the acoustics in the   room.
 
Note: Remember, audience and listeners are two separate concepts      in Modeler software. 

Whether or not a surface is occupied      by an audience is unrelated to whether or not 
there are listener      locations on that surface.

 
The effect an audience has on the acoustics in a room   depends on the number of people in the audience. The 
size of the audience   can be set in the Acoustics tab.
 

Occupancy settings in the Acoustics tab
 
The audience size can be specified in either number   of People, or Percent   Full. Enter a value to specify a num-
ber of people or a percentage.   If you have not specified any surfaces as occupied, these fields will   be grayed 
out.
 
Note: Modeler software determines the maximum occupancy of      a room based on a density of 

1.8 persons per one square meter.      An easy way to view your room’s maximum occu-
pancy is to enter      100 in the Percent Full field      and then click the radio button next to 
People.      Modeler software will calculate the number of people that      can occupy your room 
model.

 

Including Background Noise
To assign a background noise profile to a model:
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1. Click on the Acoustics tab    in the Detail window.

Acoustics tab
 
2. Under Background Noise, click    on the “Open...” button. The    following screen appears:

Background noise   window
 
3. Select an existing noise curve    from the library on the left window frame, or create/duplicate/modify    

noise curves.
 
Note: You may create a new noise curve, or duplicate and rename     an existing noise curve. If 

you do so, there will be no corresponding     audio (.wav) file, and therefore no noise will 
be played for listeners     in models with this noise assigned.

 
There are three types of noise files: standard, custom,   and user created noise files. The audio (.wav) files 
associated with standard   noise files are locked binaural files of shaped white noise. Custom noise   files are 
recordings of real environments that have been processed for   playback on Auditioner®.   Unlike standard 
noise files, these files are unlocked and the level may   be adjusted as needed for a given model. A user cre-
ated noise file will   have no associated audio (.wav) file.
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When playing a listener in Auditioner®,   the selected background noise will be played (unless muted). When 
you   use the noise volume slider in the Playback tab to adjust the noise volume,   the STI map is recalculated 
and redrawn if visible. When changing listeners   the noise gain offset is set to 0, and the change is retained in 
the model.
 
Tip:  If     you mute the noise, the room level will be the same as the signal     level. If you mute the signal by 
pressing pause/stop in the Bose     Media Player, the room level will be the same as the noise level.
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Simulating System Performance (Plus only)
Getting Started
The Modeler Plus software provides an auralization function   for use with the Auditioner playback 
system.  When active, dry   audio, typically a music or speech .wav file,  is convolved   with the system’s pre-
dicted impulse response at a selected listener location.  The   audio reproduced on the Auditioner playback sys-
tem is an accurate reproduction   of the sound system’s performance in the room.
 
Note: For   the simulation to be accurate the room model must be both geometrically   and acous-

tically accurate.

 
Before you begin with the Auditioner technology you   should first make sure that the following has been per-
formed:
 l The Auditioner Playback System is connected    and powered on.
 l Source material is loaded and playing.

 
See   the following topics for simulating system performance using Modeler Plus   software:
 l Projects
 l Auditioner    Playback System Connection
 l Bose Media Player
 l The Playlist Tab
 l The Playback Tab
 l Relative    and Absolute Level Playback
 l Including    Background Noise in the Auralization
 l Recording    and Playing Auditioner Audio Output

 

Projects
The auralization functions within the Modeler Plus software   are only enabled when a Project file is 
open.  Much of the power   of this tool is derived from the ability to listen to and compare multiple   design vari-
ations in a single session. To facilitate this feature, the   Modeler software uses the concept of a Project which 
may contain one or   more Models that represent different design variations. The project object   contains 
many of the attributes and settings models used by the Modeler   Plus application. While the designer may 
open and interact with a model   outside of a project, the model must be in a project in order to activate   the 
Auditioner® features.
 
Before you begin working with the Auditioner features   within Modeler Plus make sure of the following:
 l A Modeler project file is open, and the project    file contains at least one room model.
 l The model to which you will listen contains    a sound system, composed of at least one loudspeaker.
 l At least one listener location within the model    is selected and enabled within the Playlist Tab.

 

Auditioner®   Playback System Connection
To enable the filter playback functions within the Modeler   Plus software, the Auditioner Playback System 
must be connected to your   PC through an active USB port, and the unit must be powered ON.
When a playback unit is not connected to the PC the   Playback Tab will be inactive, and the USB indicator in 
the output section   will be red, as shown below:
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Once the Auditioner playback system is connected to   the PC, and powered ON, the Playback tab will be act-
ive, and the USB indicator   will be green, as shown below:
 

 

Bose Media Player
Modeler Plus software includes a dedicated media player   to control the audio source program material dur-
ing listening sessions.   The Bose Media Player runs as a separate program (it shows up as a separate   item in 
the taskbar) but it opens and closes from within Modeler Plus   software.
The Bose Media Player automatically opens when a project   is open and the Auditioner® Playback System III 
is connected to your computer   and powered on. When the project is closed, or the Auditioner® Playback   Sys-
tem III is disconnected, the Bose Media Player is automatically closed.
 

 

Launching the Media   Player
The Bose Media Player will only launch if all the following   conditions are met:
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 l A project is open.
 l The Auditioner® Playback System III is connected    to your computer.
 l The Auditioner® Playback System III is powered    on.

 
The Bose Media Player will automatically close under   any of the following conditions:
 l The project is closed.
 l The Auditioner® Playback System III is disconnected.
 l The Auditioner® Playback System III is powered    down.

 
If you close the Bose Media Player by clicking on the   “X” in the upper right hand corner of the Bose Media 
Player window, it   can be re-launched from the Playback tab. Click on the Launch Player button   to launch the 
Bose Media Player:
 

Media Player launch button
 
Tip:  You   can also re-launch the Bose Media Player by pressing Shift + Ctrl + P.
 

Adding CD Audio
To add audio tracks from an audio CD, insert the CD   into a drive on your computer and click the Add Track 
button on the Bose   Media Player. Select tracks from the CD and click Add, or click Add All   to load all tracks 
from the CD.

 
If you eject the CD from your computer, the tracks are   automatically removed from the Bose Media Player.
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Adding Audio Files
To add audio files that are on your hard drive or on   an external drive, click the Add File button on the Bose 
Media Player.   Navigate to the location of the audio tracks and click Open:
 

 
If you move or delete an audio file from the hard drive,   it will not play in the Bose Media Player. When you 
close and reopen the   Bose Media Player, the file is removed.
 
Note: The   playlist you create is available every time the Bose Media Player opens;   it is not 

associated with the project.

 

Playing Audio Files
Use the following transport controls to control the   Bose Media Player:

Play/Pause Press     once to begin playing the selected track. Press while a 
track     is playing to pause the track.

Stop Press     to stop the track and rewind to the beginning.

Previous Play     the previous track if within 3 seconds of the beginning, oth-
erwise     go to the beginning of the current track.

Next Play     the next track.

Repeat Press     to repeat the current track. Press again to disable repeat. 
Repeat     is particularly useful when you are comparing listener 
positions     or presenting a design. With repeat on, the track will 
automatically     start over each time it reaches the end.

Play Next When     checked, the next track in the playlist is played when the 
current     track is finished. When unchecked, play is stopped when 
the current     track is finished.

Seek Drag     the slider to skip to a desired location in the track.
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Playlist Tab
A Playlist is a collection of listener positions from   one or more of the room models within the 
Project.  Multiple   playlists, called Sets, may be created within the project file, and the   various sets are used 
to organize comparisons and demonstrations.  For   example, a set comparing the same listener positions in 
an empty and full   occupancy condition.
The left hand side of the Playlist Tab contains all   of the Sets that have been created for the project.  The right
   hand side displays the listener positions, and their status, for the active   Set.  The default set, named “All”, 
contains all listener positions   within all open models.
 

 

Creating A New Set
You can create a set that contains a selected subset   of listeners. This is especially useful when comparing 
two models. 
The following steps describe how to create a new set   by clicking and dragging:
 
1. Select one or more listeners    from the playlist panel by clicking on the listener name (hold Shift    or Ctrl to 

select multiple listeners). Click once, and then drag the    selected listeners to a blank area in the Sets list 
on the left. A    new set is automatically created.

Selecting   and dragging listeners to create a new set
 

The new set appears in the   Sets panel and is named Untitled 1:
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The new   Untitled 1 Set
 
2. Rename the new set by double-clicking    on the name (Untitled 1) in the Sets panel:

Renamed   Set list
 
3. When you click on the new    set to select it, the Playlist panel displays the listeners that belong    to the set:

 
Follow these steps to create a new set using a different   method:
 
1. Open the Playlist wing menu    by clicking on the arrow in the upper-right corner of the tab:
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2. Choose New Set. A new set    is created in the Sets panel. You can rename the set by double-clicking    on it. 

To add a listener to the new set, simply click to select, then    click, drag and drop them into the new set.
 
To delete a set, select the set and choose Delete Set   from the Playlist wing menu. The deletion of a set 
cannot be undone.

 

Adding Listeners To An Existing Set
Listeners can be dragged into existing sets at any time.   For example, if you want to add another listener to 
the new set you created,   select the desired listener from the All list by clicking once. Click   again and drag 
the row into the new set.
 

Enabling Listener Positions for Simulation
While a playlist includes a number of listener positions   it is possible to exclude positions from the 
simulation.  To   include a position in the simulation, place an “x” in the Activate Listener   checkbox.
 

 

Playback Tab
The Playback tab allows you to control the playback   of the listener positions within the playback queue. The 
panel layout   is partitioned into five blocks: Input, Signal, Noise, Room, and Output.
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Input
The Input section indicates what listener positions   are being simulated, and contains controls to access the 
Bose Media Player   and determine the type of simulation to be performed, relative or absolute.

 
Launch   Player – selecting this item launches the Bose Media Player.
Level   Match – select this item to level match listener positions for relative   level playback.
Playback   Queue – Displays the previous, current and next listener position   to be simulated.  Items in the 
playback queue are loaded from   those enabled listener positions within the active Set in the Playlist   Tab. 
The first two columns display   the model name and listener position label for each listener. The third   column 
displays either the maximum system SPL for the listener position,   or, when level match is selected, the gain 
offset for the listener position.
Scroll through the listeners   using the arrows in the Controls group. You can also use the keyboard   shortcuts 
to scroll through listeners: Ctrl+f and Ctrl+g. Alternatively,   you can use Ctrl and the left and right arrow 
keys.
 

Signal
Conceptually, the signal gain slider allows you to control   the volume of your program material on a mixer. 
As the slider is adjusted,   the sound level changes accordingly. The signal gain field reflects the   current value 
of this adjustment.
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It is possible to raise the signal gain slider above   the level that the installed system is capable of repro-
ducing at a given   listener location. The system clip indicator (above the Signal slide control)   is used to indic-
ate this state.
The system clip indicator has three states: No signal   present (gray), signal present and not clipping (green), 
and signal present   and clipping (red). Only the sound system signal is used to set the state   of this indicator. 
In other words, the background noise cannot cause system   clipping.
 

Noise
The Noise control allows you to include background noise   in the simulation. Typically the simulation is per-
formed without background   noise, but including this in the simulation provides a more representative   demon-
stration of system performance, and can aid in judging the intelligibility   of the system.
Noise control is only active when a background noise   file has been specified from within the Acoustics 
Tab.  When   working with standard noise files, NCB or RC, a noise source with a spectrum   shaped to the selec-
ted curve is mixed into the simulation, and the Noise   Gain control is locked.
When working with a custom noise file, either one of   the provided files, or a custom binaural recording, the 
noise gain control   is enabled, and the noise level, in dB is calculated, and mixed into the   simulation. When 
the noise level is changed, the new value is used to   calculate STI. If the map is visible, it will be updated 
automatically.

 
Noise   Gain – displays the current amount of gain applied to the original   noise file.  Only available for cus-
tom noise files.
Mute   – mutes the background noise
Gain   Control – adjusts the background noise level
Noise   Level – the current background noise level in dB SPL.
Noise   Level Meter – displays the current noise level, relative to the level   scale.
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Room Level
The room level meter combines   both the signal and the noise in the room as predicted at the current   listen-
ing location. The room level is displayed in dB SPL on the meter   shown below. The room level field above the 
meter bar is updated every   1.25 seconds, while the meter bar is updated every 250 milliseconds.

 

Output
The output section displays the status of the playback   system, and provides a system mute and recording 
control.

 
Playback   Unit Status – The USB detection indicator is green when the Auditioner®   playback unit is detec-
ted. When the playback unit is not detected, or   gets disconnected, the indicator is red and no audio can be 
processed.
System   Mute - Use the System Mute button to mute the playback. When you press   the button again to 
unmute, there is a short ramp-up time before full   volume is restored. The ramp-up time cannot be adjusted.
Tip:  If   you have enabled Direct keys, you can use the direct key shortcut to mute   the sound: the M key. You 
can enable Direct keys in the General tab of   the Application Preferences dialog box. To mute the signal, 
press pause   in Media Player.
Record   Control – Processed audio can be recorded and saved to a (.wav) file   for future playback. When 
recording, the current recording duration is   displayed in the elapsed time field located below the record 
toggle button.   To stop recording, click on the toggle a second time.
 

Relative and Absolute Level Playback
The default playback mode for an Auditioner simulation   is absolute level.  In this mode the absolute level dif-
ferences   between listener positions are maintained; a filter with a maximum SPL   of 90 dB will be played 
back louder than a filter with a maximum SPL of   80 dB.  In some cases it is easier to make spectral com-
parisons   between listener locations if the playback levels are similar.  The   Level Match feature automatically 
adjusts the level of each listener by   the relative difference, or gain offset, for each filter as defined within   
the Playlist Tab.  In this mode a filter with +1 dB gain offiset   will only be 1 dB louder than a filter with 0 dB 
gain offset, even though   their absolute level differences may be much greater.
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Including Background Noise in Auralization
 
To assign a background noise profile to a model:
 
1. Click on the Acoustics tab    in the Detail window.

Acoustics tab
 
2. Under Background Noise, click    on the “Open...” button. The    following screen appears:
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Background noise   window
 
3. Select an existing noise curve    from the library on the left window frame, or create/duplicate/modify    

noise curves.
 
Note: You may create a new noise curve, or duplicate and rename     an existing noise curve. If 

you do so, there will be no corresponding     audio (.wav) file, and therefore no noise will 
be played for listeners     in models with this noise assigned.

 
There are three types of noise files: standard, custom,   and user created noise files. The audio (.wav) files 
associated with standard   noise files are locked binaural files of shaped white noise. Custom noise   files are 
recordings of real environments that have been processed for   playback on Auditioner®.   Unlike standard 
noise files, these files are unlocked and the level may   be adjusted as needed for a given model. A user cre-
ated noise file will   have no associated audio (.wav) file.
When playing a listener in Auditioner®,   the selected background noise will be played (unless muted). When 
you   use the noise volume slider in the Playback tab to adjust the noise volume,   the STI map is recalculated 
and redrawn if visible. When changing listeners   the noise gain offset is set to 0, and the change is retained in 
the model.
 
Tip:  If you mute     the noise, the room level will be the same as the signal level.     If you mute the signal by 
pressing pause/stop in the Bose Media     Player, the room level will be the same as the noise level.
 

Recording and Playing Auditioner® Audio Output

Recording audio output
The processed audio output from Auditioner can be recorded   to a (.wav) file. You can then burn the (.wav) 
file or files onto a CD   along with a calibration tone. This allows you to use the Auditioner Playback   System III 
to play pre-recorded audio from outside Modeler, which is helpful   in the following situations:
 l If a client or field engineer wants to listen    to a sound system without a computer.
 l If you want to create a copy of the audio files    to use as a backup for a demonstration.

 
Follow these steps to record processed audio output:
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1. During listener playback,    press the Record button in the Playback tab. When recording, the button will    
be displayed in a depressed mode and the display of elapsed time will    be shown:

Record button
 
2. While pressing the Record    button, Modeler Plus software records the output of any    listener  being 

played, including any volume changes. As you    record, the elapsed time is updated.
3. To stop recording, press the     Record button again.
4. The Save    As dialog box opens where you can name the file and specify    a location in which to save it.
5. When burning a CD of the (.wav)    file output, you should include the calibration tone for calibrating    the 

Auditioner®    Playback System III. The calibration tone can be found in the Extras folder on the Modeler 
Plus    software installation CD.

 

Calibrating   playback of Auditioner®   recordings
You can ensure that your recordings are played at the   intended level by taking the following steps to cal-
ibrate playback from   a CD or (.wav) file player:
 
1. Place the CD with the calibration    tone into a CD player, or load the calibration tone into a media player    

on your computer.
2. If you are using a media player    on your computer, make sure your system volume is set to maximum.

Setting system volume   to maximum
 
3. Connect the CD player to the    Auditioner® Playback    System III using the supplied cable, or use a USB 

cable to connect    the Auditioner®    Playback System III to your computer.
4. Toggle the Calibrate button    on the front of the Auditioner®    Playback System III to the up position to 

engage calibration mode.
5. Play the calibration tone.
6. The LED read-out on the front    of the Auditioner®    Playback System III provides the following inform-

ation:
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LED Color Status Meaning

Red Calibration High Incoming     signal is too high. Decrease the volume level on 
the CD player     or media player

Green Calibration Reference Unit is calibrated     within ±1 dB SPL.

Yellow Calibration Low Incoming signal     is too low. Increase the volume level on 
the CD player or media     player.

 
7. Adjust the volume level    on the CD player or media player until the calibrate LED is green.
8. After setting the volume    level on the CD player or media player, do not change the volume for    the dur-

ation of the playback session.
9. Toggle the Calibrate    button on the Auditioner®    Playback System III to the down position to engage the 

SPL meter.
 

Integrating   Auditioner® recordings   into Microsoft PowerPoint presentations
Recorded output can be used to make effective and dynamic   PowerPoint presentations.
1. Make a PowerPoint slide that    shows a coverage map by using the Copy/Paste functionality.
2. Insert a (.wav) file recorded    from the model into the PowerPoint slide.
3. Play the (.wav) file during    the presentation.
4. For more information on Copy/Paste functionality, see   Copying   and Pasting Data.
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Documenting System Performance
Summary of Functions
The Modeler software provides basic print functionality   for the creation of printed documentation.  In addi-
tion, all   windows within the application include a copy function so that charts,   graphs and model views may 
be copied/pasted into other applications, such   as Microsoft Word, for use in documentation and reports.
For instructions on using these functions, see:
 l Printing Documents
 l Copying    and Pasting Data
 l Copy/Print    Preferences

Printing Documents
 
To print directly from Modeler software:
 
1. Go to File    > Print. 

The Print   window opens:

Print window
 

2. Create a list of documents    to be printed by dragging items from the left window into the print    list on the 
right. 
You can open folders and   select items in the left window as you would in Windows Explorer.
You have the option to print:

 l The room model
 l Individual clusters
 l Surfaces, Listeners, and Loudspeakers spreadsheets
 l Coverage maps

The documents that are available to print depend on   the state of your model. For example, you will not have 
the option to   print coverage maps unless they have been generated in your model.
Keep the following things in mind when you create a   print list:
 l Folders cannot be dragged into the list, only    individual items.
 l To drag more than one item at a time, hold down    Ctrl to select multiple separate items    or Shift to select a 
range of items.

 l To delete an item from the print list select    the item and click the delete button:
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Delete button
 l You cannot re-arrange the order of documents    in the print list. Print them out and re-order the documents 
by hand.

 
The print window provides the ability to change the   format of your printout:

Fields in the print   list  
 l Add a Title to    your printout which appears in the heading bar with the Bose logo.
 l Change the Scale    of the model display in the printout.
 l Change the view (Rotation)    of the model display in your printout. Choosing Custom    allows the user to spe-
cify rotation about the X and Z axes. Choosing    Camera enables a view from one of the    listener positions.

 

Print   preview and print setup
Access the Print Setup   window from the Print window by clicking   on the Print Setup button:

Print   Setup button
 
Use the Print Setup to   change printing options such as printer selection, paper options, and   paper ori-
entation.
To preview what your printout will look like before   you print, click the Print Preview button:

Print Preview button
 

Print Preview window   toolbar
 
Use the following features in the Print   Preview toolbar:
 

Print...: Open      the print dialog box.

Next Page: Preview the next page in the printout.
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Prev Page: Go back one page in the printout.

Two Page/One Page: Switch between viewing one page at      a time, and two pages at a time.

Zoom In: Zoom in on the printout.

Zoom Out: Zoom out on the printout.

Close: Close the Print      Preview window.

 
When you are ready to print, click the Print   button from the Print Preview window, or   click the Print button 
in the   Print window:

Print button
 

Copying and Pasting Data
Graphs, charts, and data can be transferred from Modeler   software into a report or presentation using the 
Microsoft Windows copy/paste   functionality. You can copy graphs and information from the tabs in the   Data 
window and the Detail   window, and paste into Microsoft Word or Microsoft PowerPoint.
 
Note: The Copy/Paste functionality     in Modeler software was designed to work with Microsoft 

Word and     Microsoft PowerPoint. You may experience problems when attempting     to 
paste into other applications. You also can Copy Grid/Paste     into Microsoft Excel.

 
The following table outlines the copy/paste functionality   in the Modeler software interface:

Window Action Pasted Example

Modeling Window: Right-click     to Copy Graphic

Detail Window: Right-click     to Copy Grid

*Note - table shown after converting     text to 
table (see Copying and     pasting grids).
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Window Action Pasted Example

Data Window: Right-click     to Copy Graph

 
 

Copying and pasting graphics
Follow these steps to copy and paste a coverage map   from Modeler software into another program.
1. Open the program where you    wish to paste the graphic, in this case Microsoft Word.
2. Right-click in the Modeling    window and select Copy Graphic.

Right-click to   copy graphic
 

3. Switch to Microsoft Word,    and press Ctrl + V to paste the graphic    (or click Edit > Paste). The map is    pas-
ted into Word:
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Pasting into word
 
Note: To turn off the histogram when pasting, go to Edit >     Application Preferences and click 

on the Copy/Print tab. Under     Model/Map, turn Histogram to Off.

 

Copying   and pasting grids
When you copy and paste a grid from the Detail   window (except for the EQ tab),   the output is in spread-
sheet format. When you paste this output into Microsoft   Excel, you will find that the data is automatically pas-
ted into rows and   columns. When you paste into Microsoft Word, you will need to format the   data by putting 
it into a table. Follow these steps to copy and paste   data from the Detail window into   Microsoft Word. This 
example uses the Surfaces   tab:
 
1. Select the Surfaces    tab, right-click and choose Copy    Grid.

Copy grid
 
2. Paste into Microsoft Word.
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3. The data is pasted as text,    separated by tabs.

Grid data pasted   into Microsoft Word
 
To format the data you will   need to put it into a table. One way to do this is to select all the data   in the Word 
document that you just pasted, and choose Table   > Convert > Text   to Table....
The Text   to Table dialog box will open in Word, allowing you to specify   how the data is put into a table:

Text to Table dialog   box
 
4. Choose Tabs    under Separate text at. Click    OK.
5. The data is placed into columns    and rows, allowing you to more easily customize its appearance.
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Grid data after   being placed in a table
 

Copy/Print Preferences
The appearance of graphs and tables can be customized   when copying/pasting and printing. These options 
can be changed in the   Application Preferences dialog box.
To access the copy/print preferences:
1. Click on the Application    Preferences button in the Print    window toolbar:

Application Preferences   button
 
The ApplicationPreferences dialog box opens.
 

2. Click on the Copy/Print tab.
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Copy/Print preferences
 

Copy/Print Presets
You can create, save, and load customized Copy/Print   preferences using the Presets feature. Follow   these 
steps to create a new preset:
1. Set your desired Copy/Print    preferences.
2. Click the Presets...    button. 

The Presets dialog box opens:

Presets dialog   box
 
3. Click the Add...    button.
4. Name your new preset and click    OK. 

Your new preset is added to the list    of presets.
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Adding a new preset
 
5. Choose your new preset from    the Preset drop-down menu in the Copy/Print tab of the Application    Prefer-

ence dialog box to load your Copy/Print preferences.

Loading a customized   preset
 

Graph   Preferences
The Graph settings control   how graphs from the Data window are copied   and pasted. The following explains 
each function:

Width: The width of your graph when pasted into     another application, displayed in English or Met-
ric values depending     on which is selected in the Drawing/Saving tab in the Model Settings     
dialog box.

Height: The     height of your graph when pasted into another application, displayed     in English or Met-
ric values depending on which is selected in     the Drawing/Saving tab in the Model Settings 
dialog box.

Text: The     text color for your graph when pasted. Double-click to open the     color picker.

Font: The     font used for text in your pasted graph. Click the drop-down to     choose a font.

Axis 
Labels:

The     font size for your graph axis labels (numbers). Click the drop-down     to choose a font 
size.

Axis Titles: The     font size for your graph axis titles. To turn off axis titles,     select “None” from the drop-
down.

Graph Title: The     font size for your graph title. To turn off the graph title, select     “None” from the drop-
down.

Statistics     
Labels:

The     font size for the statistics text displayed below the graph. To     turn off statistics labels 
select “None” from the drop-down (Statistics,     MTF, and SPL tab only).

Back-
ground:

Background     color for the graph. Double-click to open the color picker.

Opaque: If     set to “Off”, the background color selected in the Background     will be displayed. If set to 
“on”, the background will be opaque,     with no color.

Major Divi- The     color of major division lines in the graph grid. Double-click     to open the color picker.
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sion:

Minor Divi-
sion:

The     color of the minor division lines in the graph grid. Double-click     to open the color picker. 
(Applies only to Freq. Resp. tab, RT60     tab, SPL tab and EQ tab).

Shading: The     color for the shaded area representing standard deviation. (Applies     only to the SPL tab 
and the Statistics tab).

 
Use the following figure for a reference to the graph   elements. 

Graph elements
 

Model/Map preferences
The Model/Map section controls   how models and coverage maps are copied, pasted, and printed. The fol-
lowing   explains the function of each field:

Width: The width of your model or coverage map     when pasted into another application or prin-
ted, displayed in     English or Metric values depending on which is selected in the     Draw-
ing/Saving tab in the Model Settings     dialog box.

Height: The     height of your model or coverage map when pasted into another     application or prin-
ted, displayed in English or Metric values     depending on which is selected in the Draw-
ing/Saving     tab in the Model Settings dialog box.

Scale (Copy): The     resolution of the image when copying a graphic. 1.0 is the lowest     resolution; 3.0 is 
the highest resolution. Only available for     Copy/Paste.

Font: The     type of font used for text in your graph.

Background     
(Copy):

The     background color of the map. Only available for Copy/Paste.

Border (Copy): Turning     “On” adds a border to the map. Only available for Copy/Paste.

Histogram: Turning     “On” adds the coverage histogram inset into the coverage map display.

Hist. Width     
(Copy):

The     width of the histogram inset in the coverage map display. Only     available for 
Copy/Paste.

Hist. Height     
(Copy):

The     height of the histogram inset in the coverage map display. Only     available for 
Copy/Paste.
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Modeler   for presentations
When giving presentations using a projector, or when   copying to a file, sometimes you may wish to change 
the background colors   of displays to make them clearer.
You can do this in the Display   tab:
1. Click on Edit,    and select Application Preferences    (or simply clickCtrl+E).
2. Click on the Display    tab.

Application Preferences,   Display tab
 

Map Background: Background color for the Model windows.

Graph Back-
ground:

Background     color for the Data window (when there is data displayed).

Graph Disabled: Background     color for the Data window (when there is no data displayed).

Graph Major     Line: Line     color for major increments in the Data window (e.g., 100 Hz,     1,000 Hz, 
10,000 Hz).

Graph Minor     Line: Line     color for minor increments in the Data window (e.g., 200 Hz,     300 Hz, 400 Hz).

 
3. Double-click on a color and    the following color dialog box will automatically appear:
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Color dialog box
 
4. After choosing a color, the    selected color appears in the Color window.
5. Click OK.
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Tutorials
Modeling Workshop

Before   you start
Before you start, create a new project and a new model   by following these steps:
1. Launch Modeler software.
2. Choose File > New Project.
3. Name the new project “Workshop”    and navigate to an appropriate folder to save the project in, or just    

choose the desktop. Click Save.
4. When the New    Project window opens, choose New    to create a new model.

The Model Settings window automatically opens by default:
 

Model Settings dialog box
 

Selecting   model settings for the workshop
You have the ability to specify how numerous features   in Modeler software will act based on the require-
ments of your project.
In the Model Settings   dialog box with the Drawing/Saving   tab selected by default, follow these steps to 
set the Model Settings   for the modeling workshop:
 
1. Make the following changes    in the Drawing/Saving tab:

A.  Under Room Attributes (in the top-right corner), place a check mark     next to Snap     to Vertex to 
enable and make     it 1.0 m.     The vertices of each surface will now be highlighted in the model.
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B.  Under Room Attributes (in the top-right corner), place a check mark     to enable Room     Snap Grid, 
make sure the sensitivity is set to 0.5     m. This means that all objects will snap to half-meter     sub-
divisions of the grid.

C.  Make sure there is a check mark in all the     check boxes under Selection.
D.  Under Curved Surface     Attributes, enter a value of 30°     for the Angular Increment. Curved     sur-

faces in Modeler software are simulated as numerous flat surfaces     joined together to form a curve. 
Under Curved     Surface Attributes you specify the angular increment that     is used to draw the curve. 
At each angular increment, a new surface     is created, so the angular increment dictates how many 
flat surfaces     are used to simulate the curved surface.

Tip: Wing menus are a convenient way to quickly change model settings as you work through a model.

In the case above, the Room View Grid wing menu can be used to set the Snap to 
Vertex and Room Snap Grid.

The Select tool wing menu can be used     to select the types of objects you want to 
select with the mouse.     In a complicated or cluttered model, you can remove the check 
mark     from types of objects that you do not want to select with the     mouse.

 
2. Click on Apply.
3. Select the Display    tab.
4. Under RT60 (located    in the middle of Display tab window), click the Size    drop-down menu and select 

Small. 
This reduces the display   size of the purple sphere representing the location of the RT60 source.
 
Note: The RT60 source represents     the location where sound comes from when measuring the 

reverberant     decay curve for the room.

 
5. Click on OK.

The Name   Model window will automatically appear.
 

6. Name your new model “Workshop Model.mdr” and click OK.

Name Model window
 
7. Before you start modeling,    set the acoustic parameters for the room and gain materials to be    used in the 

model: Select the Acoustics     tab in the Detail Window.
Here you can specify conditions   that affect the room acoustics. 
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Acoustics tab
A.  Enter 22 (°C)     in the Temperature field.
B.  Enter 60 (%)     in the Humidity field.
 

8. Click Open under Background    Noise and select NCB 40. 
This    selection represents minimal background noise.

Background Noise
 
9. Click    OK.
10. Leave    the Acoustics tab open, and proceed to    the next section.
 

Working   with the Material Database
Click the Material Database   button in the Database toolbar (or press   Ctrl + M):

Material Database   button
 
The MaterialDatabase window opens:
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Material Database   window
 
Using this window, create a list of materials that you   will use to build your model in the Material Database. 
You can select,   modify, add, and delete materials, and save your own materials list. Total Absorption and 
Total   Reflection simulation materials are displayed in the default Material   list. You should always create a 
list of materials that match the actual   room construction materials as closely as possible.
Each material file contains sound absorption coefficient   data for the different octave bands from 31 Hz -
 16 kHz.
Since most manufacturers only specify data from 125 Hz - 4 kHz.   Models automatically duplicate data to low 
and higher bands.

Creating a materials list
The list of folders on the left side of the Material Database window is   similar to Windows Explorer. To create 
a list of materials for your project,   drag the material from the  left pane to the Material list in   the right pane.
 
The material database files can be found on your hard drive     in: 
(YourLocal     Drive) > Program Files     > Bose > Bose Modeler     6.8 > data > material_data
 
Follow these steps to add new materials to the Material   list:
 
1. Click the plus (+) sign next    to the Ceilings Absorptive    folder and select Mineral Board 5/8" ceiling    tile 

and drag it into the right side of the window. The material    and all of its absorption coefficient inform-
ation is added to the    Material list.

 
Tip:      Materials are listed in alphabetical order inside each folder.
 
2. Add the following additional    materials to the Material list:

 l From the Floors     folder add Carpet - heavy on concrete.
 l From the Misc Materials     folder add Glass - large pane, heavy glass.
 l From the Walls Reflective     folder add Concrete Block - Painted     and Brick - Bare.

Finding a material
If you know the name or part of the name of a material,   but you are unsure what folder it is in, you can 
search for it.
Follow these steps to search for a material:
 
1. Click the Find Material button in the Material Database window.

The Find   dialog box opens:
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Find Material button
 

2. Type “Wood” in the Search field.
3. Click Find    and the first instance of Wood, Wood Roof Deck - tongue - in - groove, is highlighted in the 

left pane.
4. Click the Find    Next button in the Material Database    window until Pews - Wooden is highlighted in the 

left pane:

Find Next Material   button
 

5. Add Pews - Wooden    to your Material list.
Leave the Material Database   open and proceed to the next section.

Deleting a material
Deleting a material in the Material list only removes the material from the list. It is not permanently 
removed from the data base.
Follow these steps to delete a material from your list:
1. Select Glass - large    pane, heavy glass in your materials list.
2. Click the Delete Material button to remove it from the    Material list.

Delete Material   button
 
Your materials list should   look like this:

Materials list   for the workshop

Saving your materials list
After you compile your Material list, you can save it   in its own folder in the Material Database for easy future 
access.
Follow these steps to save your Material list:
1. Click the Save    Material List button in the Material    Database window and the Save As    dialog box opens.
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Save Material List   button
 

2. Type “Workshop    Materials” in the File name field.
3. Click Save.    

Notice that your new folder now appears in the folders list on the    left side of the window.
 
Tip:      When you start a new model, the Material list contains the     contents of the “default” folder (Total     Absorp-
tion and Total Reflection).     To change this to your own default list, add the desired materials     to the Materials 
list and save it as “default.mat”. When prompted     to replace the existing default.mat file, click yes. When you
     create a new model, the material database will now contain your     customized default list of materials.
 
4. Click OK    to close the Material Database.
 

Saving   your model
Now that you have set your preferences and compiled   a Material list you should save your project.
Click File > Save Project   to save the project, and click Yes when prompted   to save changes to the Work-
shop model.
 

Building   the Workshop Model
This section of the modeling workshop shows you how   to build the First Street Church model. When you are 
finished, you will   be familiar with many of Modeler software’s tools for modeling. The final   model will look 
like the following figure: 

Completed church model
 

Use the following as a reference to the names of areas   and surfaces in the church model. 
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Names of areas and surfaces in the church   model
 

Creating   a room model
One way to approach the creation of a model is as though   you are actually building a room from the ground 
up. It is also a good   idea to complete the basic structure of the room and then add more complex   shapes 
afterwards. In this workshop, you will begin by creating simple   floor surfaces. You will first build half of the 
church and then use the   mirror tool to create the other half. Finally, you will add more complex   architectural 
shapes to complete the model.

Constructing the nave floor
1. Close the Project window by clicking on the Project View button:

Project View button
 
2. Make sure that Plan    View is selected in the View toolbar.    This view enables you to look down at the 

model from a “bird’s-eye    view”.

Plan View button
 
3. Select the Draw    Rectangular Surface tool in the Draw    toolbar.
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Draw Rectangular   Surface tool
 
This is the surface you will   draw: 

Half of nave floor
 
Note: All values in this workshop are in meters. Units of measure are specified in the Draw-

ing/Saving tab in the Model Settings dialog box.

 
4. Move the drawing crosshairs    to x: - 12.0  y: 7.0  z: 0.0, then    click.
 
Note: To cancel unfinished surface drawings such as when you are using the Draw Rectangular 

Surface, use the Esc (or SHIFT + ESC) command.

Note: Before you click to begin drawing a surface, the coordinates at the cursor display its loc-
ation relative to the origin.

Before clicking:
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Once you click to start drawing a shape, the coordinates at the cursor reset to 0 (zero) 
and display distances relative to your last click. At each click, the coordinates reset to 
x:0.0 y:0.0 z:0.0.

After clicking:

 
5. Now move the cursor to x: 24.0  y:-7.0  z: 0.0, and click.

The Z Coordinate bar opens    at the top of the window.  This is where you assign the height    of the surface.
 

Z Coordinate bar
The Z Coordinate is the location of this     vertex in the Z axis (height). Leave this height at 0 meters for     
each vertex.(the seating area has a height of 0 meters). Click Next to proceed.

6. When you reach the fourth corner, click Finish.     
The Z Coordinate bar closes and the Surface Properties window opens:

 

Surface   Properties window
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This is where you assign properties to     the shape such as material type, and surface type:
A.  Click the Material     type drop-down and choose Pews - Wooden as the surface material.
B.  Click the surface Type     drop-down and choose Seating1.  This indicates that this     surface can be occu-

pied by an audience.
C.  Click the Audience     drop-down and choose Occupied to indicate that this surface will     be occupied by 

an audience.
D.  Click the Reflection     drop-down and select Scattering.
E.  Click OK     to closes the Surface Properties window and the new seating surface     is highlighted in blue 

in the modeling window.
 
Note: Only Seating, Floor, and Misc type surfaces can be occupied by an audience.

 
Tip:      If you want to go back and replace a value, you can click     Previous to return to the previous     vertex.
 
7. Click the Save    button to save your work.

Save button
 

Constructing the chancel floor
In this section, you will create half of the chancel   floor surface. This floor surface is 1 m higher than the nave 
surface   you created in the previous section. The chancel is where a presenter   would stand to address the 
audience, so think of the chancel as a stage   that is elevated 1 m higher than the seating area.
 
1. Select the Draw    Polygonal Surface tool in the Draw    toolbar.

Draw Polygonal   Surface tool
 

The Draw   Polygonal Surface tool is used to create a surface that is a non-rectangular   polygon.
This is the surface you will   be modeling: 
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Half of the chancel   floor
 

Tip:      Zoom in on the model to make drawing surfaces easier. Select     the Zoom tool and click on an area     
of your model to zoom in on it. To zoom out, hold down Ctrl     and then click. You can also use the key-
board shortcuts: [ (zoom out) and ] (zoom in). If     you have a scroll-wheel mouse, you can zoom in or out 
by holding     the Ctrl key and scrolling up and down.

Zoom tool
 
2. Move the cross-hair cursor    and click at the following locations to create your shape. 

You will    be starting at the upper right corner of the highlighted shape in    the previous figure of the 
chancel floor. Note that at each click,    the coordinates at the mouse pointer reset to x: 0.0     y: 0.0
  z: 0.0.
(red dot indicates the starting   point)
A.  Click at x: -12 y: 7.0
B.  Click at x: -3.0 y: 0.0
C.  Click at x: 0.0 y: -3.5
D.  Click at x: -3.0 y: 0.0
E.  Click at x: 0.0 y: -3.5
F.  Click at x: 6.0 y: 0.0
G.  Click at x: 0.0 y: 7.0
 
Tip:      If you make a mistake while creating a shape, press Esc     (or Shift + Esc) to cancel what you have 
done.

 
3. When you complete the shape,    the Z Coordinate bar opens at the top of the window.

Enter 1 m for the Z Coordinate and select     Next for each vertex. When you reach the fourth corner,     click 
Finish. The Z Coordinate bar closes and the Surface Properties     window opens.
 

Z Coordinate   bar
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Surface   Properties window
 

A.  Select the Material     drop-down list and choose Carpet - heavy on concrete as the surface     material.
B.  Select the Type     drop-down list and choose Floor as the surface type.
C.  Select the Audience     drop-down list and choose Unoccupied.
D.  Select the Reflection     drop-down list and choose Specular.
E.  Click OK     to complete the shape.

 
4. Press Ctrl    + S to save your work.

You have just drawn half   of the chancel floor.

Drawing the chancel floor riser
In this lesson, you will build the chancel floor riser,   which connects the two surfaces that you just drew. This 
is a vertical   surface, so you will use the Draw Wall Surface   tool.
 
1. Select the Draw Wall Surface tool in the Draw toolbar.
 

Draw Wall Surface   tool
 

This is the surface you will   draw:
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Chancel floor riser   half
 
2. Move the cross-hair cursor    to x: -12.0  y: 7.0  z: 0.0 and    click.
3. Move the cross-hair cursor    to x: 0.0 y: - 7.0 and click. 

The Wall Z Coordinate bar opens
 

Wall Z Coordinate   bar
 

4. Leave 0 m in the Bottom field    vertices and click Next.  The bottom of the wall meets the floor    at zero.
5. Enter 1 m in the Top field    vertices and click Finish.  The Surface Properties window opens.

 

Surface Properties   window
 
6. Enter    the following data for this surface:

A.  Select Concrete     Block-Painted as the surface material.
B.  Select Wall 2     as the surface type.
C.  Select Unoccupied     and Specular
D.  Select OK.      There will now be a riser between the two floor surfaces.
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Note: It is suggested that you designate the main surfaces of     a structure as “Wall1, Seating1, 
Ceiling1” etc.  While this     riser is a wall surface, it is not one of the primary walls of     the 
church, which is why it should be designated “Wall2”.

 
E.  Click Next     and leave the same values for the second bottom corner.
F.  Click Next,     then enter 1 m in the Top field and leave the other values the     same.
G.  Click Next,     leave the values the same, and click Finish.     There will now be a riser between the two 

floor surfaces.
 
7. Click the Save button to save    your work.  You have just drawn the riser between the two floor    surfaces.
8. To ensure that everything    lines up, look at the model from a different perspective. Click on    the Rotate 

View tool

Rotate View tool
 

9. Click and drag in the Modeling window to view your model from different    perspectives.
Your model should look like   this:

Model in rotate   view
 
To return to the Plan View, click on Plan   View in the View toolbar. You also   can switch to Plan View using the 
direct key shortcut: press the H key.

Drawing the nave side wall
Next, you will build the following nave side wall: 

Nave side wall
 

1. Select the Draw    Wall Surface tool.
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2. Move the cross-hair cursor    to x: - 12.0  y: 7.0  z: 0.0, and click.
3. Move the cross-hair cursor    to x: 24.0 y: 0.0 and click. The Wall Z Coordinate bar opens.
4. Enter the following Wall   Z Coordinates:

A.  Leave 0 m for the bottom field vertices.
B.  Enter 4 m for the Top field vertices and     click Finish.  This defines the wall as 4 meters high.

5. Enter the following data for    this surface:
A.  Select Brick - Bare as the surface material.
B.  Select Wall 1 for the surface type because     this is one of the main walls of the church.
C.  Select Unoccupied and Specular
D.  Select OK to create the wall.

6. Click the Save    button to save your work.
You have completed the nave   wall.

 

Drawing chancel wall #1
You will now use the Draw Polygonal   Surface tool to draw the first chancel wall. Note that you will   need to 
switch to a different view to draw this surface.
This is the surface you will draw:

Chancel wall #1
 
1. Click the Elevation    View button in the View toolbar.    This view displays the church as if you were standing 

on the ground    next to it.

Elevation View   button
 
2. Select the Draw    Polygonal Surface tool in the Draw    toolbar.
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Draw Polygonal   Surface tool
 
3. Click at the following locations    to create your shape:

A.  Click at x:  0.0  y: 3.5  z: 1.0.
B.  Click at y:  0.0  z:  7.0.
C.  Click at y:  3.5  z: - 4.0.
D.  Click at y:  0.0  z: - 3.0.
E.  Click at y:  -3.5  z:  0.0.

 
4. When you complete the shape,    the Wall X Coordinate bar opens. Enter the following X Coordinates:

A.  Enter - 15 m in the    X Coordinate field. This specifies the location of the shape in the    X dimension.
B.  Click Next    for each of the vertices of the surface, leaving the same values for    each one. Selecting 

Finish opens the Surface Properties window.
C.  Leave Brick - Bare    as the surface material.
D.  Select Wall 1 as    the surface type.
E.  Select Audience =    Unoccupied and Reflection = Specular
F.  Select OK    to create the wall.

 
5. Click the Save    button to save your work.

Your model should now look   like this:
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Chancel wall #1   in rotate view
 

Drawing chancel wall #2
Now, using the Draw Wall Surface   tool, you will draw the following second chancel wall:

Chancel wall #2
 
1. Switch to Plan    View (press the H key).
2. Select the Draw    Wall Surface tool in the Draw    toolbar. You can also select the Draw Wall Surface    tool by 

using the direct key shortcut: press the W    key.
3. Click at the following locations    to create your shape.

A.  Click at x: - 18.0      y: 3.5  z: 0.0
B.  Click at x: 3.0      y: 0.0

4. The wall Z Coordinate bar    opens. Enter the following:
A.  Enter 1 m in the Bottom field vertices,     click Next.
B.  Enter 8 m in the Top field vertices, Click     Finish. The surface properties window opens.  Select the     

following:

 l Brick - Bare Material type.
 l Wall 1 surface type.
 l Unoccupied and Specular.
 l Select OK to create the wall.

5. Click the Save button to save    your work.  Your model should now look like this:

- 287 -



Modeler®  Sound System Software 6.8 User's Guide

Chancel wall #2   in rotate view
 
Tip:      Use the Direct key shortcut to switch to Rotate View: Press     the D key. If this does not work, make sure 
the Direct Accelerator     key is turned on in the Application Preferences.
 

Drawing chancel wall #3
In this lesson, you will create chancel wall #3, which   joins chancel wall #1 with the nave wall.
This is the wall you will draw: 

Chancel wall #3
 
1. Switch to Plan    View (press the H key).
2. Select the Draw    Wall Surface tool in the Draw    toolbar (press the W key).
3. Click at the following locations    to create your shape.

A.  Click at x: - 15.0      y: 7.0  z: 0.0
B.  Click at x: 3.0 y: 0.0

4. The wall Z coordinate bar    opens.  Enter the following:
A.  Enter 1 m in the Bottom field vertices,     click Next.
B.  Enter 4 m in the Top field vertices, Click     Finish. The surface properties     window opens.  
C.  Select the following:

 l Brick - Bare Material type
 l Wall 1 surface type
 l Unoccupied and Specular

D.  Select OK to create the wall
5. Click the Save    button to save your work.
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Creating a ceiling surface
Next, using the Draw Polygonal   Surface tool, create the ceiling for the church.
This is the surface you will draw: 

Church ceiling   surface with vertex heights
 
1. Make sure you are in Plan View, then select the Draw    Polygonal Surface tool in the Draw    toolbar. You 

can also select the Draw Polygonal    Surfaces tool using the direct key shortcut: Press the Q key.
2. Move the cross-hair cursor    and click at the following locations to create your shape.
 

Tip:      You will follow the perimeter of the church as you create     your ceiling.
 

A.  Click at x:- 18.0  y:  0.0  z:  0.0.
B.  Click at x:  0.0  y:  3.5
C.  Click at x:  3.0  y:  0.0
D.  Click at x:  0.0  y:  3.5
E.  Click at x:  27.0  y:  0.0
F.  Click at x:  0.0  y:  -7.0
G.  Click at x: -30.0  y:  0.0

 
3. After you click the final    coordinate, the Surface Properties bar    opens. 

Enter the following properties for this shape (refer to the    previous figure for vertex heights):
A.  Enter 12 m     in the first field, which represents the height of the ceiling     at this corner.
B.  Select Mineral Board     5/8" ceiling tile for the surface material.
C.  Select Ceiling1 as the surface type because this     is the primary ceiling surface in the model.
D.  Click the Next     button, then enter 8 m     in the height field and leave the other values the same.
E.  Click Next     and leave the values the same.
F.  Click Next,     then enter 4 m in     the height field and leave the other values the same.
G.  Click Next     and leave the values the same.
H.  Click Next,     enter 12 m in the     height field, leave the other values the same, and click Finish.

 
4. Click the Save    button to save your work.

Your model should look like   this:
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Church ceiling   in rotate view
 

Creating   the other half of the church
At this point, you have drawn half of your church model.   Rather than creating all of these surfaces again on 
the opposite side,   you can take advantage of the symmetry of your model and duplicate the   existing sur-
faces to make the other half of the model.
This can be done using two different methods. 
 l Using the duplicate, group, and flip surface    functions
 l Using the Mirror    tool

Using   duplicate and group functions to create the other half of the church:
 
1. Switch to Plan    View, then click the Surfaces    tab in the Detail window.
 

Surfaces tab
 
This tab lists each of the   surfaces in your model and provides information about each surface. It   can also be 
used to easily select surfaces in the model.
 
2. Click the first surface in    the list, then drag your mouse down until all of the surfaces are    highlighted. 

Notice that all the surfaces in the model become highlighted.
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Selecting all surfaces   in the Surfaces tab
 
3. In the Edit    menu click Edit > Duplicate    (or press Ctrl + D). An identical    set of surfaces appear in the 

model slightly offset from the first,    highlighted in blue.
4. Click the Group    button in the Arrange toolbar. The new    duplicate surfaces are grouped together.

Group button

Duplicated, grouped   surfaces
 
5. In the Arrange    toolbar, click the Flip Vertical button    so that the new surfaces mirror the existing church 

half.

Flip   Vertical button
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6. If it is not already unlocked,    unlock the model by clicking on the Lock Model    button so you can move the 
duplicate half of the church.

Lock Model button   in locked state
 
Note: When the model is locked, you will not be able to move individual surfaces in the model 

by clicking and dragging them. Turning Lock Model off allows you to select and drag 
objects in the model independently.

7. Click on the Select    button in the Draw toolbar, then click    on and drag the highlighted surface group until 
you place it on the    negative side of the y-axis, opposite the original surfaces.

Make sure Surfaces   checkbox is checked in the wing menu (click on    to   the right of the selection 
arrow for the wing menu).

Select tool
 
The two halves of the church   should line up flush against each other:

Lining up the church   halves
 
8. Click Ungroup    to ungroup the surfaces.
 

Ungroup button
 

Your model should now appear   almost complete, except for the missing walls on both ends of the 
church:
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Church after duplicating
 

Using the Mirror tool   to create the other half of the church
Before using the Mirror tool, you first need to delete   the duplicate surfaces you just created. This can be 
accomplished in numerous   ways, three of which are listed below:
 
 l Surface    Deletion Method 1 - Click on the Undo    button several times until you reach a state before the 
duplicate    surfaces were created.

Undo button
 
 l Surface    Deletion Method 2 - Click the Undo List    button to open the Undo/Redo window.

Opening the Undo/Redo   window
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Double-click an item in the   Undo List to undo your actions to that point. In this example, double-click   on 
“duplicate” to remove the duplicate surfaces.
 

 l Surface Deletion Method    3 - Select the duplicate surfaces in the Surfaces    tab and press the Delete key.

After the duplicate surfaces   are removed, click the Lock Model button in the Arrange   toolbar to lock the 
model. It is recommended that you keep the model locked   to prevent against accidentally moving a surface.
 
To create   the other half of the church using the Mirror tool:
1. Make sure you are in Plan View, then click the Surfaces    tab in the Detail window.
2. Click the first surface in    the list, then drag your mouse down until all of the surfaces are    highlighted, or 

do Ctrl + A    to select all. Notice that all the surfaces in the model are highlighted    with a blue outline.
3. Select the Mirror    tool in the Draw toolbar.
 

Mirror tool
 
4. Make sure you are in PlanView. Click    once and trace the mirror axis along the bottom edge of the 

church.    Think of this as placing a mirror against the shape you want to duplicate.    Click again, and the 
selected surfaces are duplicated on the other    side of your mirror line.
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Tracing the mirror   axis along the bottom edge of the church
 
5. Click the Save    button to save your work.

Your model should look like   the following:

Church after mirroring
 

Drawing the cylindrical nave alcove (#1)
The following steps will show you how to place rounded   alcoves at either end of your church model.
This is the nave alcove surface you will create:
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Nave alcove (#1)
 
1. Make sure you are in PlanView, then    select the Draw Cylindrical Surfaces    tool:
 

Draw Cylindrical   Surfaces tool
 
2. Using the cross-hair cursor,    define the shape as follows:

A.  Click at x: 12.0      y: 0.0  z: 0.0
B.  Move the cursor in the positive Y direction     (up) until the radius is 6.0 m     and click.
C.  Rotate the cursor clockwise until the angle     measures - 180° and click.     Make sure that the angle is 

negative.
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Using the Draw   Cylindrical Surfaces tool
 
3. After you finish the surface,    the Z Coordinate bar opens at the top of the window. Enter the following:

A.  Leave 0 m for Elevation 1 (Z1) since the     bottom of this surface is at the same level as the nave 
floor.

B.  Click Next,     then enter 4 m for Elevation 2 (Z2), leaving the other values     the same, then click Fin-
ish.      The Surfaces Properties window opens.

C.  Select Brick - Bare as the surface material.
D.  Select Wall 1 as the surface type.
E.  Select Unoccupied and Specular.
F.  Select OK     to create the cylindrical wall surface.

 
4. Click the Save    button to save your work.

The finished alcove should   look like this:

Alcove #1 in rotate   view
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Note: Curved surfaces are simulated as numerous flat surfaces     joined together to form a curve. You spe-
cify the angular increment     that is used to draw the curve. At each angular increment, a new     sur-
face is created, so the angular increment dictates how many     flat surfaces are used to simulate the 
curved surface. In this     example 30°, making 6 surfaces.

 

Drawing the cylindrical chancel alcove (#2)
The following steps will show you how to draw the chancel   alcove (#2) in the church.  
This is the surface you will create:

Alcove #2
 
1. Switch to Plan    View.
2. Select the Draw    Cylindrical Surfaces tool (or press the C    key) and define the shape as follows:

A.  Click at x: - 18.0      y: 0.0  z: 0.0   
B.  Move the cursor in the positive Y direction     until the radius is 2.5 m and     click.
C.  Rotate the cursor counter clockwise until     the angle measures 180° and click.     (Make sure that the 

angle is positive).
3. After you finish the surface,    the Shape Properties bar opens at the top of the window. Enter the    following 

properties for this shape:
A.  Enter 1 m for Elevation 1 (Z1)
B.  Click Next,     then enter 8 m for Elevation 2 (Z2), then click Finish.     The Surfaces Properties window 

opens.
C.  Select Brick - Bare as the surface material.
D.  Select Walll 1 as the surface type.
E.  Select Unoccupied and Specular.
F.  Select OK     to create the cylindrical wall surface.

4. Click the Save    button to save your work.
The finished chancel alcove   (#2) should look like this:
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Alcove #2 in rotate   view
 

Drawing a conical surface
Next, you will place a conical roof section over the   nave alcove (#1) using the Draw Conical Surfaces   tool.
This is the surface you will create:

Conical roof over   alcove #1
 
1. In PlanView, select the Draw    Conical Surfaces tool:
 

- 299 -



Modeler®  Sound System Software 6.8 User's Guide

Draw Conical Surfaces   tool
 
2. Define the shape as follows:
 l Click at x: 12.0      y: 0.0  z: 0.0.
 l Move the cursor in the positive Y direction     until the radius is 6 m and     click.

 l Rotate the cursor clockwise until the angle     is - 180.0° and click.
 l Move the cross-hair in towards your starting     point until the second radius is equal to 0 m     and click.

3. When you finish the surface,    the Z Coordinate bar appears at the top of the window. Enter the following:
 l Enter 4 m for Elevation 1 (Z1).
 l Click Next     and set Elevation 2 (Z2) to 11 m, then click Finish.      The Surfaces Properties window opens.
 l Select Mineral Board 5/8" ceiling tile     as the surface material.
 l Select Ceiling 2 as the surface type because     this is not the main ceiling surface in the model.
 l Select Unoccupied and Specular.
 l Select OK     to create the conical ceiling surface.

4. Click the Save    button to save your work.
The conical ceiling over   the nave alcove should look like this:
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Conical ceiling   over nave alcove
 

Drawing a spherical surface
The following steps will show you how to place a spherical   ceiling over the chancel alcove (#2).
This is the surface you will create:

Spherical ceiling   over chancel alcove
 
1. In Plan View select the Draw Spherical Surfaces tool:
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Draw Spherical   Surfaces tool
 
2. The Draw    Spherical Surfaces tool is used in the same fashion as the    Draw Conical Surfaces tool. Define 

the    shape as follows:
A.  Click at x: - 18.0      y: 0.0  z: 0.0.
B.  Move the cursor in the positive Y direction,     radius is 2.5 m and click.
C.  Rotate counter-clockwise around the center     point of the sphere until the angle is 180.0°     and click.

3. When you finish the surface,    the Z Coordinate bar appears at the top of the window. Enter the following:
A.  Enter 8 m for Elevation 1 (Z1).
B.  Click Next,     then enter 10 m for Elevation 2 (Z2), then enter Finish.      The Surfaces Properties win-

dow opens.
C.  Select Mineral Board 5/8" ceiling tile     as the surface material.
D.  Select Ceiling 2 as the surface type because     this is not the main ceiling surface in the model.
E.  Select Unoccupied and Specular.
F.  Select OK     to create the conical ceiling surface.

4. Click the Save    button to save your work.
The completed chancel alcove   ceiling should look like this:
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Chancel alcove   ceiling in rotate view
 

Closing the room model
You have created all of the main surfaces of the model.   There are still a few open spaces that you will fill in 
with surfaces   in the following lessons. A model that has no open or missing surfaces   is called a closed 
model.
In order to close your room model, you first will create   the wall surfaces highlighted below. These are called 
adjoining walls.

Adjoining walls   to create before closing the model
 

Drawing the nave adjoining walls
The nave adjoining wall joins the nave alcove with the   nave. This surface can be created using the Insert   
Face tool. The Insert Face   tool allows you to create a surface by outlining the vertices that make   up the 
perimeter of the shape.
To create   the nave adjoining wall:
1. Select the Rotate    View tool (press the D key).
2. Rotate the model until the    view closely matches the following figure:
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You will click on the vertices   that outline the nave adjoining wall, so it is important that you can   see all 
the vertices. Zoom in using the Zoom   tool if you need to.

A good viewing   angle for creating the nave adjoining wall
 
3. Select the Insert    Face tool:

Insert Face tool
 
4. To define the nave adjoining    wall, click on the vertices that form its perimeter. Each vertex will    highlight 

in green when the cursor is moved over it. The surface is    completed when you click on the red dot indic-
ating the starting point.
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Outlining the nave   adjoining wall with the Insert Face tool
 
Note that this snapshot was   taken on step 5 as you can see the green highlighted vertex at the cursor.
 
5. When you click on the starting    point to finish the shape, the Insert    Face properties box opens. Here 

you define the material and    surface type for the new surface. Choose Brick    - Bare for the material, and 
Wall 1    for the surface type and click OK.

Insert Face properties   box
 

The new surface looks like   this:

Completed nave   adjoining wall
 
To create   the chancel adjoining wall:
1. Select the Rotate    View tool (press the D key).
2. Rotate the model until the    view closely matches the following figure:
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A good viewing   angle for creating the chancel adjoining wall
 

You will click on the vertices   that outline the chancel adjoining wall, so it is important that you can   see all 
the vertices in your view of the model.

 
3. Select the Insert    Face tool.
4. Define the chancel adjoining    wall by clicking on the vertices that form its perimeter, just as    you did for 

the nave adjoining wall. Make sure that each vertex highlights    in green before you click.
 
Tip:      If you have difficulty finding the vertex highlighted in     green, click ESC (or Shift + Esc) to cancel, then 
you can alter     your viewing angle and begin again.
 

Note: The object " "     is an RT60 source in the background     and not a vertex

 
The surface is completed   when you click on the red dot indicating your starting point. Use the   figure in 
the next step as a guide to the vertices that define the chancel   adjoining wall.

 
5. When you click on the starting    point to finish the shape, the Insert    Face properties box opens. Leave 

Brick - Bare as the material type, and Wall1 as the surface type, and click    OK.
The finished chancel adjoining   wall looks like this:
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Chancel adjoining   wall
 

Creating the chancel alcove floor surface
The last surfaces that you will create for the model   are the floor surfaces for the two alcoves. As with the 
adjoining walls,   these floor surfaces can be created using the Insert   Face tool. The first floor surface you 
will create is the chancel   alcove floor, which is highlighted in the following figure:
 

Chancel alcove floor surface
 
1. Use the Rotate    View tool so that you can more easily see the space where you    will create the floor sur-

face. Your view should look similar to the    following figure, which is looking down on the chancel alcove. 
You    may find it helpful to use the Pan    tool along with the Rotate View    tool.

 
Tip:      You can switch between these Pan and Rotate View tools quickly     by using their direct key shortcuts: 
SPACE BAR for the Pan tool,     and D for the Rotate View tool.
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A good viewing   angle for creating the chancel floor surface
 
2. Use the Insert    Face tool to outline the alcove floor surface, as you did with    the adjoining walls.

Creating the chancel   alcove floor surface using the Insert   Face tool
 
3. When you click on the starting    point to finish the shape, the Insert    Face properties box opens. Choose 

Carpet - heavy    on concrete for the material, and Floor    for the surface type and click OK.

Insert Face properties   box
 
The surface looks like this   when complete:
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Completed chancel   alcove floor surface
 

Creating the nave alcove floor surface
The nave alcove floor surface can be created with the   Insert Face tool in the same manner   as the chancel 
alcove floor surface.
 
1. Use the Rotate    View tool so that you can more easily see the space where you    will create the floor sur-

face. 
Your view should look similar   to the following, which is looking down on the nave alcove:

A good viewing   angle for creating the nave floor surface
 

Again, you may find it helpful   to use the Pan tool along with   the Rotate View tool. Remember,   you can 
switch between these tools quickly by using their direct key shortcuts:   SPACE BAR for the Pan   tool, and 
D for the Rotate   View tool.

 
2. Use the Insert    Face tool to outline the nave alcove floor surface, exactly    as you did with the chancel 

alcove floor surface. The surface is completed    when you click on the red dot indicating your starting 
point. Use    the figure in the next step as a guide to which vertices define the    nave alcove floor surface.

3. When you click on the starting    point to finish the shape, the Insert    Face properties box opens. Choose 
Carpet - heavy    on concrete for the material, and Floor    for the surface type and click OK.
The floor surface looks like   this when complete:
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Completed nave   alcove floor surface
 

Deleting Unused Material
1. Click    the Material    Database button in the Database toolbar (or pressCtrl    + M):

Material Database   button
 
TheMaterialDatabasewindow opens:

Material Database   Window
 

This figure shows materials   highlighted in blue that have been used in the model. Materials that are   not 
highlighted are unused.

 
2. Click on the Delete    Unused Materials tool.

Delete Unused Materials   tool
 

- 310 -



Modeler®  Sound System Software 6.8 User's Guide

The following Warning window   appears:

Modeler Warning   window
 

3. Click on OK.
The Materials Data list changes   to display only the highlighted used materials, deleting the unused auto-
matically.

Materials Data   list (used materials only)
 
4. Click the Save    Material tool.

Save Material tool
 
5. In the Save As dialog, select    the Workshop Materials.mat    file.
6. Click on the Save    button.
7. Click on the Yes    button to replace the existing Workshop. Materials.mat file.
8. Click on OK    to close.
 

Next steps
To add loudspeakers to your model, see:
 l Placing    and Aiming Loudspeakers
 l Working    With Arrays
 l Working    With RoomMatch Arrays

 
To add listeners to your model, see:

- 311 -



Modeler®  Sound System Software 6.8 User's Guide

 l Listener    Locations
 l Adding    Listeners
 l Setting    Listener Preferences
 l Listener    Properties
 l Using    Listeners and the Sample Tool
 l Using    Listeners to Reduce Calculation Time

 

Working With Projects
The features of the project structure provide an easy   way to create a logical and organized work envir-
onment. The following   covers the use of projects in Modeler software, and it will show you how   to manage 
projects and their associated models as well as how to use the   various features of the project structure. We 
recommend that you use projects   in your work whenever possible.

Opening   and creating projects
You can have only one project open at a time. If you   attempt to open or create a new project while another 
project is open,   you will be asked to close the current project.
To create a new project:
1. Launch Modeler software and    choose File > New    Project (or press Ctrl+N).
2. The Create    New Project dialog box opens and asks you to name the new project    and choose a location to 

save it.
3. Enter a name and choose a    location for the file, then click Save.
 
Note: When you create a project in Modeler software, a folder      is generated on your hard drive 

with the same name as the      project. The project (.pjt) and its model (.mdr) files are      
stored in this folder. Project names must be unique, you cannot      create two projects with 
the same name in the same folder.

 
4. You are then prompted to either    create a new model, open an existing model, import a model or cancel.

New: A      new model is created. You are asked to name it

Open: Open an existing model. You are prompted      to locate the model on your hard drive. The exist-
ing model      is copied and placed into your new project.

Import: Import a model that was not created      in Bose Modeler software. The model will be added to 
the currently      open project file. Choose to import a Macintosh Modeler software      file (.mac), a 
Modeler Transfer File (.mtf), and EASE faces      file (.xfc), or an EASE project file (.ppj). Note 
that the      file must have the appropriate file extension (.mac, .xfc,      .ppj, .dxf) to be imported 
into Bose Modeler software.
If a project is not open, the model      will be imported without being added to any project.

Cancel: The project is created, but contains      no models.

 
5. The new project is created    with the new, existing or imported model associated to it.
 
Note: Open the Project window      to view a project and its models by 

choosing View > Window      > Project.

To open an existing project:
1. Choose File    > Open Project...
2. You will be asked to locate    the desired project folder. Locate the folder and click Open (or double-click 

on the folder name).
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3. Click on the project file    within the project folder and click Open    (or double-click on the project file). Note 
that all project files    end in the file extension .pjt.

4. The new project opens, and    it can be viewed in the Project window.
 

Project   window
The project structure creates a “parent/child” relationship   between project and model files in Modeler soft-
ware. A project file can   be thought of as the “parent” file, with its associated models being “children”.   The 
Project window displays a project in   a hierarchical format, allowing you to see all models contained within   
the project.
 

A project and its associated models in the   Project window
 
The appearance of the model icon in the Project   window corresponds to the state of the model:

  Model   closed.

  Model   open, D2R∆STIc Engine off.

  Model   open, D2R∆STIc Engine on.
 
To open a model, double-click on the model icon in the   Project window. The model opens in the Modeling win-
dow. When you close a project,   the project file keeps track of which models are open or closed as well   as 
which models have the D2R∆STIc   Engine enabled. The next time   you open the project, the models will be in 
the same state.
Select a project or a model and right-click to perform   one of many commands such as opening a model, clos-
ing a model, and renaming   a model or project. For a full explanation of all commands, see File_menu_com-
mands.
Note: You can only have five models open in a project at any      time. If you try to open one more 

model, you will see a dialog      box asking you to close a model before opening another.

 

Comparing   multiple designs
You may want to create multiple versions of the same   model within a project. These versions might have a 
different loudspeaker   design, different acoustic material treatments or different room geometry.
To create multiple versions of a   model:
1. Open or create a project that    has at least one model.
2. In the Project    window, select the model.
3. Right-click on the model and    choose Duplicate Model.
4. Modeler software will prompt    you to enter a name for the duplicate model. Enter the desired name    and 

click OK.
You can now modify the duplicate model. For example,   you could add sound absorbing material to certain 
wall surfaces, or you   could create a version that uses different loudspeakers.
To save a version of the model you are working on:

1. Choose File    > Save Model As..., or right-click    on the model in the Project window and    choose Save 
Model As....
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2. Enter the name for the new    version of the model.
 
Note: After Save Model As, the newly saved model is open and      active, and the original model 

is closed and remains in the      state that it was last saved.

 

Viewing   multiple models
Create multiple versions of the same room model to allow   for an easy and quick comparison of the predicted 
sound quality for different   design options. For example, you could create three different designs   of the same 
auditorium using three different materials. Open the models   you wish to compare, and choose Window >   
Cascade, or Window   > Tile to view and switch between the   designs quickly. Acoustic prediction data is dis-
played in the Data   window as you view each model.

Cascade windows (three models shown)
 

Tile windows (2 models shown)
 

File menu commands
The following menu commands can be accessed in the File menu or by right-clicking in the Project window. 
Many of these commands are   only available when working with a project. We recommend that you use   pro-
jects whenever possible.
 

New      Project: Create a      new project file (.pjt) and project folder and specify its      location 
on the hard drive. You will be prompted to create      a new model, add an 
existing model or import a model into      the project. If a project is currently 
open, you will be prompted      to close it before creating a new project.
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Open      Project...: Open      an existing project by locating it on the hard drive and choosing      the 
.pjt file. If a project is currently open, you will be      prompted to close it 
before opening a new project.

Close      Project: Close      the project. You will be prompted to save changes to models      that you 
have modified, with the option to save all models      that have been modified.

Save      Project: Save      changes to the project. You will be prompted to save changes      to mod-
els that you have modified, with the option to save      all models that have 
been modified.

Save      Project As...: Create      a copy of the project and save it with a different name. All      models 
within the project will be copied. The new saved project      will remain open 
and the original project will be closed.

Rename      Project...: Change      the name of the project.

New      Model: Create      a new model. You will be prompted to name the new model.
If a project is not open, a new model      will be created without being added to 
a project. This model      is named “Untitled” by default and can be renamed at 
any time      by choosing Save Model.

Open      Model...: Add      an existing model to the project. A copy of the model will      be added to 
the project.
If no project is open, the model will      be opened without being added to a 
project.

Close      Model: Close      the model.

Save      Model: Save      changes to the selected model.

Save      Model As...: Create      a copy of the model and save it with a different name. Use      this 
option to save a version of the model you are currently      working on. The 
new saved model remains open and active, and      is added to the project. 
The original model is closed and      remains in the state that it was last saved.
If no project is open, you will be prompted      to choose a location in which to 
save the model.

Import      Model: Import      a model that was not created in Bose Modeler software. The      model 
will be added to the currently open project file. Choose      to import a Macin-
tosh Modeler software file (.mac), a Modeler      Transfer File (.mtf), and EASE 
faces file (.xfc), or an EASE      project file (.ppj). Note that the file must have 
the appropriate      file extension (.mac, .xfc, .ppj, .dxf) to be imported into      
Bose Modeler software.
If a project is not open, the model      will be imported without being added to 
any project.

Export      Model: Export loudspeaker data      to a text (.txt) file with tab delimited data for 
all loudspeakers      in the room model. Data includes loudspeaker properties 
and      equalization data for each device.
Export      a Modeler Transfer File (.mtf) which contains all the      room 
model data in a proprietary text format for use in other      modeling applic-
ations.
Modeler Data Exchange (.xml) contains all the room model data in 
Extensible Markup Language (.xml) format for use by ControlSpace® 
Designer software.

Duplicate      Model: Duplicate      the selected model in the project. To select which model to      duplic-
ate, click on the model name in the Project      window, or click in the Modeling
      window of the project you wish to duplicate. You will be prompted      to name 
the duplicate model. Modeler software will copy the      model and add it to the 
“parent” project. This option exists      only when the model is associated with 
a project.
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Rename      Model: Rename      the selected model in the project. This option exists only      when the 
model is associated with a project.

Remove      Model: Remove      the selected model from the project. You will be prompted      to 
remove the model from the disk.
Choose Yes      to delete the model from your hard drive.
Choose No      to remove the model from the project but not from the hard      
drive. It is saved in the project folder and can be added      back to the project 
or to another project at a later time.
This option exists only when working      with a model that is associated with a 
project.

 

Project   files
This following covers topics that are related to working   with project and model files in the file structure on 
your hard drive.

Project   folders
When you create a project, a project folder is created   in the chosen location and a project file (.pjt) is cre-
ated within the   project folder.
 
Note: When you enter the name of a project in the Create      New Project dialog box, the project 

folder takes on      the same name. Changing the project name using the Rename      Project 
function will also change the folder name.

 
The following figure shows a typical project folder   on the hard drive. The folder contains the “parent” project 
(.pjt) file   and the “child” model (.mdr) files. 
 

 
 

A project folder   and its contents
 
You should use Modeler software to manage projects and   models whenever possible. Moving, renaming and 
deleting project and model   files in the file structure on your hard drive is not recommended. For   example, to 
copy a model, use the “Duplicate Model”, or “Save Model As...”   functions in Modeler software rather than 
copying the model file on your   hard drive.

Renaming,   moving, and deleting model files
A project file (.pjt) must be located in the same folder   as its “children” models in order for Modeler software 
to recognize and   open the project. Actions carried out in the file structure may cause   the project to be “out of 
sync” in Modeler software. Moving, renaming,   or deleting “child” model files (.mdr) in the file structure of 
your hard   drive will cause an error message when opening the “parent” file in Modeler   software.

Renaming a file
If you rename a model file (that is associated with   a project) on your hard drive, Modeler software will be 
unable to find   the model when you open its “parent” project. You will be prompted to   locate, skip, or remove 
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the model file from the project. For example,   suppose you renamed the “Design 2” model in the previous fig-
ure to “Design   3”, as shown: 
 

Renaming the Design 2 model
 
When you open the “Small Theater” project in Modeler   software, you will receive the Project Error   message: 
 

Project Error message
 

Locate...: Will allow      you to search for the model file.

Skip: Will      open the project without the “Design 2” model. (If you select      skip, you 
will receive the same error message every time you      open the project until 
the model is either located or removed).

Remove: Will      remove the model from the project.

 

Moving a file
If you move a “child” model file from its project folder   and then try to open the “parent” project in Modeler 
software, the program   will be unable to locate the model file. You will receive a Project   Error message. Click-
ing Locate...   will allow you to find the file on the hard drive. Once located, the model   will be added to the pro-
ject.

Deleting a file
Deleting a model file from a project folder on the hard   drive will also cause the Project Error in   Modeler soft-
ware when you try to open the project. You will be prompted   to locate, skip, or remove the model from the 
project. If you select skip,   you will receive the same error message every time you open the project   until 
the model is either located or removed.

Renaming,   moving, and deleting project files
A project file (.pjt) must be located in the same folder   as its “children” models in order for Modeler software 
to recognize and   open the project properly.
 

Rename: You can rename a project file in the file structure,      but it is recommended that you rename 
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projects in Modeler      software. If you rename a project file in the file structure      of your hard 
drive, the project will still open properly and      all models will remain associated to it. 
However, the project      folder will not be renamed, and will retain the original project      name. 
This may cause confusion when working in Modeler software.

Move: If      you move the project file from its      folder to another location, and then open the project, 
Modeler      software will be unable to locate the “child” models because      they are no longer in 
the same folder as the “parent”. You      will receive an error prompting you to locate, skip, or 
remove      the missing model files. If you select skip, you will receive      the same error message 
every time you open the project until      the models are either located or removed.

Delete: If      you delete a project file, you      will be unable to open the project. You will need to cre-
ate      a new project and add to it all models previously associated      with the deleted pro-
ject.

 

Deleting a project
To permanently delete a project, locate the project   folder on your hard drive and delete the folder and its 
contents.

Opening   project and model files from the hard drive
You can open a project by double-clicking the project   file on the hard drive. If you are running Modeler soft-
ware and have a   project open, you will be asked to close the current project before opening   a new one.
You can open a model by double-clicking the model file   on the hard drive. If you have a project open in 
Modeler software, the   model will be added to the project. If you do not have a project open   or do not have 
Modeler software running, the model will open in Modeler   software without being associated with any pro-
ject.

Models   that are not part of a project
It is possible to work with models that are not associated   with any project, although the features of the pro-
ject structure will   be unavailable (such as duplicating the model) as will Auditioner® functions.   We recom-
mend that you use projects whenever possible.

Changing   model files outside of their project
Using the Open Model...   command, it is possible to open any model file on the hard drive, including   those 
that are already associated with a project. If you open a model   file that is located in a project folder (i.e. is 
associated with a project)   without opening the parent project and make changes to this model, the   changes 
will be permanently saved to the model. When you open the “parent”   project that contains this model, you 
will see the changes in this model.

Adding   models to projects
A model that has been created outside of a project can   be added to a project. To add a model to a project, 
open the project and   choose Open Model.... Locate the model on   your hard drive and click Open. The model   
will be added to the project. Note that simply placing a model file into   a project folder on your hard drive will 
not add the model to the project.   You must add the model in the Modeler software.
 

D2R∆STIc Design Process
Bose Professional Systems has developed a process for   designing sound systems that ensure good per-
formance in the following   five acoustic dimensions:
 

Consistent      tonal balance: Provide a      consistent balance of sound energy in all fre-
quencies throughout      the listening area.
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Satisfactory      loudness: Achieve      the overall loudness that is appropriate for the 
venue and      for the program material.

Proper      localization: Create      the perception that sound is originating from its 
actual source,      such as a presenter on stage.

No      objectionable sound 
arrivals:

Eliminate      late sound arrivals, such as echoes, that are det-
rimental      to sound quality.

Clear      speech: Provide      a system that produces clear and intelligible 
speech.

 
The process establishes measurable performance criteria   in these acoustic dimensions. The steps in this pro-
cess are represented   by an acronym: D2R∆STIc.   D2R∆STIc   stands for:

D Direct     Field Coverage (first D)

D+R Direct     plus Reverberant (second D, plus R)

∆ Time     Arrivals (Greek Delta or change in time)

STI Speech     Transmission Index

c Confirm     using Auditioner® (listen to the design using the 
Auditioner® Playback System III)

 
Each step in the D2R∆STIc process corresponds to one   of the following dimensions of high quality sound, as 
illustrated below:

To create con-
sistent tonal bal-
ance:  

Provide      even and consistent 
Direct      Field Coverage. D

To achieve sat-
isfactory loud-
ness:  

Optimize      the total SPL across 
listening area, by analyzing the 
Direct plus Reverberant      sound.

D + R

To eliminate 
undesirable 
sound      arrivals:

Predict and adjust time-arrivals 
(∆) at      all listener locations and 
set proper signal delays.

∆
 

AND

Establish proper 
localization:

To      provide clear 
speech:

 

Achieve      the highest possible 
Speech      Transmission Index. STI
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Overview   of D2R∆STIc   Steps
The D2R∆STIc   steps are meant to be followed in order. Each step is dependent upon the   previous step. If a 
design change causes you to return to a previous step,   continue through all steps sequentially.

 l Step    1 - Calculate the Direct Field coverage

The Direct Field is the sound   that reaches the listener’s ears directly from the loudspeakers; it does   not 
include any reflections. In this step, the sound system designer should   try to achieve even and con-
sistent tonal balance in the 1 - 4 kHz   frequency range.

 l Step    2 - Calculate the Direct plus Reverberant Field coverage

The Direct plus Reverberant   field represents all of the sound energy arriving to the listener, both   directly 
and after first and second order reflections. To determine the   loudness of the sound system, the sound 
system designer calculates the   Direct plus Reverberant field for the full frequency range from 31 Hz   to 
16 kHz.
NOTE: In this step the overall tonal balance of the system is set by applying EQ.

 l Step    3 - Predict Time-Arrivals

Time-arrivals describe how   and when sound reaches the listener. Arrivals that are later than 100 ms   of 
the direct arrival, and 10 dB or more above the reverberant field,   can be perceived as an echo.
Loudspeaker delays should   also be set to establish proper localization of sound.

 l Step    4 - Determine Speech Intelligibility

To determine whether the   sound system produces clear and intelligible speech, Modeler software   pre-
dicts the Speech Transmission Index (STI) using a proprietary algorithm   known as the Hybrid Energy 
Decay Curve™ (HEDC™).

 
The steps in the D2R∆STIc process can be used to create   a sound system that delivers high quality sound. 
Modeler software is designed   to facilitate the use of the D2R∆STIc process in your project.   Use the method 
outlined in this chapter as a guide to creating a successful   sound system installation.
The following information covers how to view sound prediction   data in Modeler software, with an emphasis 
on the steps of D2R∆STIc. For each step in D2R∆STIc,   this information covers:
 l How to generate the sound prediction data.
 l How to evaluate the sound prediction data.

If you are not already familiar with the basic interface   of Modeler software, please refer to the Modeler Soft-
ware Interface, to   become acquainted with the basic features of the program.

Opening   the Sample Model
The sample project, First Street Church.pjt, is used   for D2R∆STIc   examples.
Follow these steps to open this project and model:
 1.  Click File    > Open Project...
 2.  In the Look    in: drop-down, choose your desktop.
 3.  Open the Tutorial    folder, then open the First Street Church    folder.
 4.  Open the file named First Street Church.pjt

You will see this in the   Project window:

First Street Church   project in Project window
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NOTE: If you cannot see the Project window, go to View > Window > Project.
 
 5.  Double-click on the Design 1 model in the Project    window. The Design 1 model opens.
 6.  Close the Project    window.

 

Performing the D2R∆STIc Process

Step 1 - Calculate the Direct Field Coverage
 
 1.  Generate the Direct Field    coverage map:

 A.  Enable the D2R∆STIc engine by clicking on     the Enable D2RDSTIc Engine     button in the Map tool-
bar:

Enable D2R∆STIc   Engine button
 

 B.  Click the Direct     button on the Map toolbar.

Direct button
 

Modeler software calculates   the Direct Field coverage for the seating area and displays it in the   Model-
ing window.

 
 2.  Evaluate your coverage map:

For D2R∆STIc, the Direct Field coverage   should be evaluated using an average of the 1 - 4 kHz octave   
bands. 
To display the coverage map   for the 1 - 4 kHz average, choose 1 - 4 kHz   in the Frequency toolbar:

- 321 -



Modeler®  Sound System Software 6.8 User's Guide

Choosing 1 - 4   kHz in the Frequency drop-down menu
 

Direct Field coverage   map at 1 - 4 kHz
Tip:       The Direct Field coverage map for the 1 - 4 kHz      frequency range can be generated in a single step 
using the      Design menu. Go to Design > D2R∆STIc > Direct (1 - 4 kHz)      or press F5.

 
The Direct Field coverage map shows the sound pressure   levels as a spectrum of colors. The correlation 
between SPL levels and   color can be found in the map legend at the top of the window.
Inspect the coverage map   to gain insight into the regions of coverage for each loudspeaker in the   system. 
The coverage map also provides the visual feedback necessary to   re-aim loudspeakers, substitute loud-
speakers, or change the gain for various   loudspeakers.
 
 3.  Evaluate    the evenness of coverage:

The Statistics   tab histogram indicates the evenness of coverage in the coverage map.   The Statistics 
tab is a plot of the normalized   occurrence of a particular SPL (vertical axis) versus the SPL value (hori-
zontal   axis). This can be thought of as the likelihood that a given SPL is being   displayed in the map.
To evaluate the evenness   of the coverage, select the Statistics   tab in the Data window.
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Statistics tab
The Statistics tab   displays:

Green Line: Histogram      curve.

Middle Blue Line: Mean.

Outer Blue Lines: Standard deviation      from the mean.

Shaded Area: Values within standard      deviation.

 
The   mean SPL and standard deviation are displayed below the Statistics   tab in the Status Bar.
 

Status bar
Assuming you have established   fairly even coverage, the Statistics   tab shows a normal distribution of 
samples. This means that 95% of the   samples fall within the mean +/- two standard deviations. In this 
example,   as the mean is 69.9 dB and the std. deviations is 1.8 dB,   95% of the listening area is within 
the 66.3-73.5 dB SPL range.
The standard deviation is   a quantitative representation of the evenness of the direct coverage.   The fol-
lowing qualitative descriptors can be used in regard to the standard   deviation:
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Step   2 - Calculate the Direct plus Reverberant Field Coverage
Follow these steps to generate the Direct plus Reverberant   Field coverage map:
 1.  Generate the Direct + Reverberant    filed coverage map.

Make sure the     D2R∆STIc     engine is still on.
Click the Direct + Reverberant button on the Map Toolbar.

Direct + Reverberant button
 
The D2R∆STIc engine predicts the Direct   plus Reverberant Field coverage and displays it as a new 
tab in the Modeling window.

 
 2.  Evaluate your D+R coverage    map.

The D+R step in D2R∆STIc is used to equalize the   system to a desired response and to determine the 
sound pressure levels   produced by the system. The Direct plus Reverberant coverage should be   
examined for the full audio spectrum (31 Hz - 16 kHz   frequency range). 
To display the coverage map   for 31 Hz - 16 kHz:
 A.  Choose    31 Hz - 16 kHz in    the Frequency toolbar.

Choosing 31 Hz   - 16 kHz in the Frequency drop-down menu
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Direct plus Reverberant   coverage map at 31 Hz - 16 kHz
 

Tip:       The Direct plus Reverberant Field coverage map for the      31 Hz - 16 kHz frequency range can be gen-
erated      in a single step using the Design menu. Go to Design >      D2R∆STIc      > Direct+Reverberant (31 Hz -
 16 kHz)      or press F6.

 
 B.  Select the SPL     tab in the Data window to see room     SPL data across the full frequency range: 

 

SPL tab
 

The SPL   tab displays:

Green      Line: The mean      SPL at each frequency.

Shaded      Area Surrounding 
Green Line:

The      standard deviation from the mean.

Red      Line: The      background noise level.

Yellow      Line: The      house curve.
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The status bar below the   graph shows the mean SPL for the selected frequency range, and the 
standard   deviation for the selected frequency range. The right-hand average total   SPL for all fre-
quency-range.

 
 3.  Adjust    the equalization

The loudspeaker equalization   is adjusted through the EQ tab in the Detail window.
 A.  Select the EQ     tab in the Detail window.
 B.  To see the equalization     setting for a given loudspeaker or loudspeakers, right-click on     the graph 

and choose Select Speakers... (or press F3).     
To see the EQ setting for   all loudspeakers that are turned on, right-click on the graph and choose
   Select Active Speakers (or press F4).
The EQ curve for the selected   loudspeaker or loudspeakers is displayed on the EQ   tab.
 

EQ tab displaying   loudspeaker EQ curve
 

 C.  Adjust the EQ curve by     moving the gray boxes on the curve up or down. 
The effects of your change   can be seen directly on the SPL tab on the   Data window, which shows 
the room-response.

A change in the   loudspeaker EQ affecting the room equalization in the SPL tab
 

 D.  Right-click in the EQ     window and select Zero Equalizer     to undo the EQ’s.
 

EXAMPLE:     Equalizing the sound system to a House Curve
 1.  Go to Acoustics       and click on the Open       button in the House Curve section.
 2.  Select Flat_w_1k_knee.
 3.  Click OK,       you will see the House Curve update in the SPL window.
 4.  Go to the EQ window.
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 5.  Press F4       to select all active speakers (or right-click on the graph       and select 
Select Active       Speakers).

 6.  Right-click in       the EQ window and select Apply       House Curve. You will see the 
EQ’s being updated       and the room SPL data match the target curve.

Resulting     SPL graph via applying House Curve
 7.  Make sure D2R∆STIc       is turned on.

 
 4.  Predict the frequency response

You can view the frequency   response at a particular point in the model. 
To view frequency response,   use the Freq. Resp. tab in the Data   window:
 
 A.  Select the Sample     Tool from the Draw Toolbar.

Sample tool
 

 B.  Click at the point on     the coverage map where you would like to view the frequency response.
 C.  Select the Freq.     Resp. tab in the Data window     to see the frequency response at the selected loc-

ation in your     model. 
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Freq. Resp. tab   with 1/3 octave smoothing

Freq. Resp. tab   with 0 octave smoothing
A smoothing function is applied   to the frequency response curve at the selected bandwidth. 
Lower values   / wider bandwidths result in finer resolution, more smoothing. Select   0 Octave to 
turn smoothing off.
 

 5.  Calculate the maximum SPL    of the system
The last part of Step 2 in   the D2R∆STIc   process, is to calculate the maximum SPL of the sound system 
with program   material.
 
 A.  Go to SPL tab.
 B.  Right-click in the window     and select Program SPL.
 C.  A dialog box appears,     stating that the maximum SPL is 101.1 dB-SPL.

 
Note:       The Program SPL is calculated with the amps turned up      until the first speaker 
reaches its maximum power handling.

 

Step   3 - Predict Time-Arrivals
Time-arrival predictions in Modeler software are used   to establish proper localization and to eliminate any 
undesirable sound   arrivals. 
To establish proper localization, it may be necessary   to set loudspeaker delays. In a system with multiple 
loudspeakers, the   listener receives time-arrivals from many different loudspeakers located   in different parts 
of the room. It has been shown that listeners localize   sound to the source producing the first time-arrival.
In the following figure, sound waves from loudspeaker   #1 arrive at the listener first. It will appear to the 
listener that all   sound is coming from the direction of loudspeaker #1, even if loudspeaker   #2 is closer 
and/or slightly louder. In a decentralized or distributed   sound system, the designer must set loudspeaker 
delay times properly so   that the listener first receives sound from the loudspeakers nearest to   the actual 
sound source.
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A listener receiving time arrivals from two   speakers
 
Note:       For an array you will deal with two delays; one delay      to get the array to perform cor-
rectly and one for the cluster      to be assigned with other clusters in the room model as above.
 
The following describes how to establish proper localization   by setting loudspeaker delays, and then shows 
how to identify undesirable   sound arrivals.
 1.  Generate direct time-arrival    predictions for establishing proper localization:

 A.  Make sure the D2R∆STIc engine is still on.
 B.  Select the Time     Resp. tab in the Data window     to display time-arrival data.
 C.  Select the Direct     tab in the Modeling window to view     the Direct Field coverage map.
Note:       Time-arrival data cannot be displayed for a range of      frequencies, such as 1 -
 4 kHz, or 31 Hz - 16 kHz.      The Time Resp. tab will be grayed out and a warning will be      
displayed in the graph, indicating to pick a single frequency      band from the Frequency 
drop-down menu.

 
Tip:       Direct time-arrivals can be generated in a single step      using the Design menu. 
Go to Design > D2R∆STIc > Time (2 kHz)      or press F7.

 
 D.  Select the Sample     tool from the Draw toolbar.
 E.  Click anywhere in the     seating area to generate direct time-arrivals for that location.     Notice that 

placing the Sample tool     generates data in the Time Resp.     tab:
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Time Resp. tab   showing direct arrivals
The Time   Resp. tab displays elapsed time on the horizontal axis and SPL   on the vertical axis. The 
red pins represent direct sound arrivals at   the location of the sample tool. By clicking on a pin, 
or by using the   scroll bar to the right of the window, you can see which loudspeaker the   direct 
arrival is coming from in the Modeling   window.
For proper localization,   the first arrival at any location should be from the loudspeaker closest   to 
the actual sound source or presenter. In this example, Cluster 2 needs   to be delayed.

 
 F.  Set the necessary loudspeaker     delay times in the Loudspeakers     tab to achieve the appropriate 

localization for your room. When     complete, the loudspeaker tab should look like this:

Loudspeakers tab   showing Delay column
 

Note:  The example      below is a delayed cluster with an endfire array of 2xMB12      and 
2xLT6400. The cluster has been delayed by 50 ms to      provide proper localization. In addi-
tion the second MB12 has      a 2.32 ms delay to create the endfire bass array. In      the real 
implementation, the following delays would be applied:
 6400: 50 ms
 6400: 50 ms
 MB12:  50 ms
 MB12: 52.32 ms
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 3.  Generate all time-arrival    predictions

To identify and eliminate   objectionable time-arrivals, do the following to generate all direct,   first 
order, and second order time-arrivals:
 A.  Make sure the D2R∆STIc engine is still on.
 B.  Click the Speech     Intelligibility button on the Map     toolbar:

Speech Intelligibility   button
This enables the calculation   of the Hybrid Energy Decay Curve™ (HEDC™), which is required for 
predicting   first and second order reflections.

 C.  Select the Time     Resp. tab in the Data window     to display time-arrival data.
 D.  In the Simulation     tab, choose a single frequency in the Frequency     drop-down menu. 

Time-arrivals are not displayed   for a range of frequencies, such as 1 - 4 kHz, or 31 Hz - 16 kHz.
 C.  Select the Sample     tool from the Draw toolbar.
 D.  Click anywhere in the     seating area to generate time-arrival data for that location.     Placing the 

Sample tool generates     data in the Time Resp. tab:
 

- 331 -



Modeler®  Sound System Software 6.8 User's Guide

Time Resp. tab   showing all time-arrivals
The Time   Resp. tab displays all direct, first order, and second order time-arrivals:

Red pins: Direct arrivals from the sound source.

Green pins: First order      reflections. They have reflected off of one surface.

Blue pins: Second order      reflections. They are arriving at the sample point 
after reflecting      off of two surfaces.

Yellow line: Reverberant      Field Envelope Function (RFEF), which shows the 
build-up and      decay of reverberant energy in the room.

 
Click on a pin in the graph   to generate the path from the source to the listener location, which is   
viewed in the Modeling window.   You can scroll through the pins sequentially using the scroll bar to 
the   right of the Time Resp. graph.
Time-arrivals are potentially   objectionable if they arrive more later than approximately 100 ms   after 
the direct arrival, and 10 dB or more above the reverberant   field.
 

A late and strong   arrival
 

Note:       If multiple arrivals over a short interval aggregate      to a level of 10 dB more than 
the reverberant field,      an echo may result.

 

Step   4 - Generate Speech Intelligibility Data
 1.  Click the Speech    Intelligibility button to generate the Speech Intelligibility    (STI) coverage map. 

The Speech   Intelligibility button is located on the Map   toolbar.
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STI coverage map
 

Tip:       The Speech Intelligibility coverage map can be generated      in a single step using the Design 
menu. Go to Design >      D2R∆STIc      > Speech (STI) or press F8.

 
Note:       When pressing F8 or simply calculating Speech Intelligibility,      Modeler’s default 
algorithm is the STI adhering to the 1988      standard. You can use a different algorithm 
by changing the      algorithm drop-down field in the Simulation tab. For more information, 
see the      Simulation      Tab.

 
 2.  Evaluate the STI data.

The STI coverage map shows   the landscape of speech intelligibility for your model. The correlation   
between colors in the map and actual STI numbers is shown in the map legend   at the top of the win-
dow.

 3.  Select the Statistics tab
When displaying STI data,   the Statistics tab provides a quantitative   display of the level and uniformity 
of speech intelligibility in your   design.
 

Statistics tab   displaying STI data
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Use the following scale to   assign qualitative descriptors to the STI numbers in your model:

STI number
 
 4.  Place the Sample    tool in your coverage map and select the Modulation Transfer Function    (MTF):

 

The MTF tab display
 

The MTF   tab displays the normalized amount of modulation preserved (vertical axis)   versus modulation 
frequency in Hz (horizontal axis) at the location of   the Sample tool. The 7 lines in   the graph correspond 
with the 7 octave bands:

Red: 125Hz

Orange: 250Hz

Yellow: 500Hz

Green: 1kHz

Blue (light blue): 2kHz

Indigo (dark blue): 4kHz

Violet: 8kHz

 

Diagnosing   and correcting speech intelligibility problems
The shape of the MTF contains   information that can help to diagnose the cause of speech intelligibility   reduc-
tion. Use the following guidelines when diagnosing poor speech intelligibility:
Background      noise has the effect      of reducing the entire MTF, independent of modulation frequency.      The 
lines would both start and end lower on the graph.
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A reduced MTF due to background noise
 
Reverberation has the effect      of gradually decreasing the modulation as the modulation frequency      
increases. The MTF that results from high reverberation levels      will slope continuously downward. Higher 
reverberation times      cause the curve to decrease more rapidly.
 

A downward sloping MTF caused by reverberation
 
Late-arriving      reflections have the      effect of putting a notch in the MTF. The later the reflection,      the lower 
the modulation frequency at which the notch occurs.
 

A notched MTF caused by late reflections
 

Tip:       The notch is located at a frequency, f where                where   is the time difference between the      

two arrivals causing the echo.  If you see a dip at 5 Hz,      look at 2 arrivals spaced by roughly        or 
100 ms.
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Using Extrusion Tools
Modeler software includes five extrusion tools to assist   in the creation of room models and complex room 
features. Found on the   Extrusion Toolbar, the extrusion tools include:
 

Icon Tool Description

Extrude Walls Creates a complete     set of walls, capped by a 
ceiling plane based on a single floor     surface. 
The extrusion will always be along the Z-axis 
and to     the extent is specified by the user.
Typically used to either quickly create     a room 
model, or to create the starting point for room 
modeling     which can be edited to create the 
final model. Extrude Walls can     also be used to 
extrude “downwards” from the floor surface.

Extrude Sur-
face

Extrudes a set     of surfaces from a reference sur-
face within the room model. The     surfaces will 
terminate at the specified target surface.
Typically used to quickly complete a room     
model based on a set of two reference sur-
faces.

Extrude Rect-
angular     Sur-
face

Extrudes a set     of walls from a rectangular sur-
face.
Typically used to quickly create a room     model 
or a complex room feature.

Extrude Poly-
gonal     Surface

Extrudes a set     of walls from a polygonal floor 
surface.
Typically used to quickly create a room     model 
or a complex room feature.

Extrude Arc Extrudes an arc     or column from a reference 
surface.
Typically used to create a cylinder or column     
within the room model which is bounded by a 
floor and ceiling     surface.

 
When using the extrusion tools there are some terms   with which you will want to become familiar.
Extent – the   endpoint of the extruded surface. Some surfaces are extruded from a selected   surface, so one 
of the Extents is known, while the other must be specified.   In cases where two extents must be defined the 
minimum extent has the   lowest elevation in the model, and the maximum has the highest elevation   in the 
model.
Termination   – determines how the end of the extrusion will be handled. It can be left   open, closed, or no 
action can be specified.
Within Modeler® software extrusions fall into two categories:   
An EXISTING   surface is extruded in the direction of three axes: X, Y, Z or the normal   of the surface. A sur-
face normal to a flat surface is a vector which is   perpendicular to that surface. In this case, the existing sur-
face remains   unchanged. The Extrude Walls and Extrude Surface tool perform this operation.
A VIRTUAL EXTRUSION   SHAPE is drawn in the room model and extruded in the direction   of one of the 
three main axes: X, Y, Z. The virtual plane disappears once   the extrusion is completed, and the newly 
extruded surfaces terminate   at two other existing planes (donor planes).
In other words, the extruded shape is limited by features   in the room model that intersect with the extruded 
shape. 
The following are several examples of how these tools   can be used.
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Extrusion Basics
The extrusion tools are intended to help you quickly   create room models, and the two tools used most often 
for this purpose   are the Extrude Walls tool and the Extrude Surface tool.
The use of the Extrude Walls tool to create a basic   room geometry that can be edited is covered within the 
Introduction to   Modeler training.
The Extrude Surfaces tool creates a set of surfaces   between two surfaces. Using this tool it is possible to 
quickly create   room models from two wall surfaces. 
The following examples illustrate of how a model can   be quickly created using the extrusion tools.

Example #1 - Creating a model using the Extrude   Surface tool
 1.  Model the Ceiling.

In this model the ceiling   describes the overall shape of the room, and can be quickly modeled.

 2.  Using the ceiling shape as    a template to model the floor using the Polygonal Surface tool.

 
 2.  You are now ready to extrude    the remaining surfaces. After selecting the floor, Select the Extrude    Sur-

face tool.

- 337 -



Modeler®  Sound System Software 6.8 User's Guide

 
The floor is the one known   extent, and you must specify the Ceiling to be the other extent for all   
extruded surfaces. In this model, since   we already have a ceiling, the termination is defined as None.

 3.  Define the surface attributes    and click OK.
The basic model is created   and is ready for editing, or a basic design can be implemented.

Example #2 - Creating an auditorium model
This second example demonstrates how to create an auditorium   room model on a single surface.
 1.  In this example the side wall    of the auditorium is used to describe the articulated ceiling and    raked 

seating area. The shape of the side wall is drawn using the    draw Polygon tool in plan view, and then 
the wall is rotated so that    it lies in the X,Z plane.

 
 2.  Mirror the surface. You now    have two side walls.
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 3.  Use the Extrude Surface tool    to create the complete room model.

NOTE:   This surface must be extruded along the Y (red) axis.

When a surface is extruded   the new surfaces are created as a group:

 
 4.  Now that all of the surfaces    of the room model exist we will need to manually edit their individual    sur-

face properties. This is accomplished using the Surfaces Tab, and    stepping through each surface indi-
vidually.
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NOTE:   The selected surface is highlighted in blue.
 
The Extrude Rectangular Surface, Extrude Polygonal Surface   and Extrude Arc tools create a set of surfaces 
from a polygonal, rectangular   or arc shape. The new surfaces are extruded between two existing room   
model surfaces.

Example #3 - Adding a room feature using the Extrude   Polygonal tool
In this example the Extrude Polygon tool is used to   add an interior room feature.
 1.  Define the shape of the new    extrusion using the polygonal or rectangular extrusion tool.

Define the termination for   the extents of the new extrusion. In this case the bottom, (Minimum,)   
extent is open, and the top, (Maximum,) extent is not terminated.

 
 2.  View the results of the newly    extruded surfaces.
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When a new extrusion is created using an open termination,   Modeler® software will modify adjacent sur-
faces such that they properly   intersect the newly extruded surfaces, but do not create any bent planes.   In 
some cases this results in a large number of surfaces being created.

Example #4 - Using the Merge Surfaces tool
The Merge Surfaces tool is used to clean up the room   model once an extrusion with an open termination is 
created and after   a model or individual surfaces are mirrored. The following demonstrates   how the Merge 
Surfaces tool can be used to reduce the number of surfaces   used in this room model.
 1.  Select two or more adjacent    surfaces which are coplanar.

 
 2.  Select the Merge Surfaces     tool and the two surfaces are now merged into a single surface.

 
 3.  Repeat this process for all    the coplanar surfaces in the room model.

 
NOTE: Surfaces   containing holes are filled (holes eliminated) when they are included   in a 
Merge Surfaces selection set.
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Room Model Example
The tools provided within the Modeler® software can   greatly simplify the process of room model creation. 
This example shows   how to create a room model using a minimum of drawn surfaces, primarily   relying on 
using the extrusion tools to achieve the overall room geometry   and unique room features. This model is a 
basic cathedral which will look   like this:

 
 1.  This example starts by modeling    the front wall using the Polygonal Surface tool. This surface is con-

structed    in the Elevation view to eliminate unnecessary surface rotations.

 
 2.  In order to extrude this surface,    the rear wall needs to be created as a target surface. This is accom-

plished    by copying the front wall and pasting a duplicate surface into the    model. Unlock the model and 
move the newly pasted surface into position.
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 3.  Use the Extrude Surface tool    to create the basic shape of the nave.

The newly extruded surfaces   are created as a group. At this point it is recommended that you modify   
their Surface Types, Materials, and Reflection properties.

 
 4.  Now, the transepts are added.    To do this the end wall of the transept is created on either side    of the 

nave.

 
 5.  The transept end walls need    to be extruded to the side wall of the nave. In this case, the termination    is 

set to Open because the transept is open to the room. 
This process is repeated   for the opposite side.
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The completed extrusion action   yields several new surfaces shown here as highlighted objects.

 
 6.  Now that the basic shape of    the room model is created, the editing tools can be used to form the    apse.

To accomplish, adjust the   vertices of the front wall for a narrower width leaving gaps to fill using   the 
Insert Face tool.

 
Highlighted objects illustrate   new surfaces to add to fill in the gaps around the newly created apse   
using the Insert Face tool or by adding vertices to existing surfaces   and dragging them to their new 
destinations.
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 7.  The model is now nearly complete    and is ready for adding some interior details. Using the Extrude Arc    

tool the columns will added to the room model. An Open termination    is selected to avoid adding 
enclosed spaces to the room model. This    process should be repeated for all remaining columns.

 
 8.  Using the Add Doors/Windows    tool windows are added along the nave and transept walls.

 
After adding all remaining   windows, the model looks like this:
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 9.  It is possible to simplify    the view of this model using the Merge Surfaces tool to merge the    nave and 

transept ceilings into a single plane.

 
 10.  Additional room details such    as seating areas and doors can also be added at this time as indicated    by 

highlighted objects. 
The model is now complete   and ready for a sound system design.
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